
Administration

Administration
As a system administrator with an Administrator (Admin) role, on the QAD
Web UI, you have access to the Administration functions.

Some system administration tasks can require using the QAD .NET UI as
well as the QAD Web UI.
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Technical Overview
The QAD Web UI is based on a layered, services-oriented architecture,
with separate layers responsible for presentation, business logic,
data, and foundation services. This new architecture is called the QAD
Reference Architecture (QRA). Some administration tasks will require
familiarity with the concepts of QRA, including modules, business
components, and the framework for running the QAD Enterprise
Applications system.

QAD Reference Architecture (QRA)
The QAD Reference Architecture (QRA) is a layered, services-oriented
architecture, with separate layers responsible for presentation, business
logic, data, and foundation services:

• Presentation — the presentation layer includes the components that
implement the user interface.

• Business logic — the business logic layer consists of the application
business logic and exposes functionality through business service
APIs.

• Data — the data layer represents the data store of the application.

• Foundation — the foundation layer includes the functionality and
services that are common to the various architectural layers (such as
exception handling, logging, and so on).

QRA has a app-based modular architecture, and it is in the various apps
that each of the business areas of QAD's products is organized. Apps are
comprised of object-oriented business components.

Business Component (BC)
A business component (BC) brings together the business logic and
data necessary to represent a business activity within the application.
Users interact with business components through the user interface's
menu items. These menu items are hybrid views, which combine a
browse grid with a form where you create and interact with data based
on the business logic. Typically, a hybrid view is based on one business
component, but can use more than one business component. For
example, the Address Types hybrid view is based on one business
component, but the Sales Orders hybrid view is based on several related
business components.

Some administration tasks require a familiarity with the business
component (BC) concept. These tasks include configuring activity
tracking, setting security and permissions, and designing or modifying
forms.
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Your Application Builder (YAB)
QAD Enterprise Applications with QRA is installed and maintained using
a framework called Your Application Builder (YAB). YAB is a console
application that is used to create new QAD Enterprise Applications
instances and to update, start, stop, and query existing instances.
Further, a single installation of YAB can be used to manage multiple QAD
Enterprise Applications instances.
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Activity Tracking
On the Activity panel, you can see a history of transactions and follow the
things you care about most. You can comment on activity in a way similar
to how you use other kinds of collaborative media. The system can track
field changes, comments, and attachment uploads for the current record
(such as a field) and displays them on the Activity panel.

From a form, open the Activity panel on the right side of the page by
clicking the Activity icon along the right.

By default, not all field activity can be tracked. As an administrator, you
can specify which fields can be tracked using Activity Tracking. From the
Activity Tracking view, you can configure what users can track based
on a business component. Each business component is listed along
with a description, whether it is activity-tracked, and then the Business
Component URI is included for reference.

Note When you enable activity tracking for a business component, the
OS script is run automatically to compile and load the triggers into the
database. The OS script is as follows: activity_feed_update. The results for
the OS script are sent to your Inbox. If the OS script fails, you can see
a warning message at the top of the screen. In this case, you need to
execute the OS script manually. For more details, see OS Scripts on page
7024.

Main
Activity Tracking

Select to enable activity tracking for the selected business component.

Saved To

Indicates that all activity tracking data is saved as Configuration
Data. See Configuration Data Overview on page 7014 for detailed
information.

Fields
Under the Tracking column, select which fields can be tracked using
Activity Tracking. The grid shows all fields of the selected business
component.

Note that users will only receive notifications on fields they have chosen
to follow; these Activity Tracking administration settings only control which
fields users can follow.
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Dashboard Configuration
In addition to the action centers, the QAD Web UI includes the
dashboards available on the QAD .NET UI.

These dashboards are created and configured in the QAD .NET UI and
then displayed in both the QAD .NET UI and the QAD Web UI.

For information on configuring dashboards using the QAD .NET UI, see:
QAD .NET UI Administration Guide.
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Browse Count Configuration
You can disable the global browse record count and instead enable the
browse record count only for specified browses.

When a browse is run, the record count function retrieves and reports
the total number of records in the browse, in advance of returning and
displaying the actual records. Depending on the definition of the particular
browse, this record count function can consume system resources and
affect performance, delaying the display of the record data. With the
global browse record count, the record count function is applied to every
browse, which can affect overall system performance.

Previously, the browse record count was enabled or disabled globally,
where the setting would apply to all browses being run. Now, you can
enable it for only specified browses, tailoring it for use only with browse
definitions that require a record count.

To configure the browse record count on a per-browse basis, in the client-
session.xml configuration file, use the <recordcount> settings:

<!-- This section controls the record count done within browses -->

<recordcount>

<!-- Indicates if default is to skip record counts for browses -->

<defaultskip>false</defaultskip>

<!-- These browses will not be counted if default is to count -->

<!-- Format is csv list of browse ids, i.e. mg003,pp100,BCreditor.SelectCreditor
-->

<skip></skip>

<!-- These browses will be counted if default is to skip. Same format as skip list
-->

<count></count>

<!-- True will skip record count in all lookups. False will follow logic above -->

<lookupskip>true</lookupskip>

</recordcount>
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Browse Performance Controls
QAD Adaptive uses trusted queries to protect the system from long-
running queries, which can adversely affect server performance and
degrade the user experience for everyone in the system. Normal business
component browse queries time out after 30 seconds by default. Trusted
queries can be set to a longer period of time to ensure an individual
browse loads successfully. System administrators can update these
settings using the properties described on this page.

Update System Timeout for Normal BC Browses
To increase or decrease the timeout allowance for normal business
component browses:

1. Open the /build/config/configuration.properties file
2. Enter a value greater or less than 30000 milliseconds (30 seconds) for

the setting
qad-qracore.bcbrowse.acceptableQueryTimeMillis=

3. Run
yab reconfigure

Configure Timeout for an Individual BC Browse
The following property sets timeouts for individual BC browses:

qad-qracore.bcbrowse.timeouts=

The property is comprised of a comma-separated list of timeouts for
particular BC browses with the format:

browseURI[timeout]

where the timeout is specified in milliseconds.

Note Browse-specific timeouts override the default timeout. If you set this
property for an individual browse to a value less than the system default,
the browse will time out at the lower value regardless of the system
setting.

To increase the timeout value for a browse:

1. Open the /build/config/configuration.properties file
2. Define the timeout value for the browse using the

 qad-qracore.bcbrowse.timeouts
setting; or example, to increase the number of seconds the Safety
browse can load to 60 seconds, you would enter:
qad-
qracore.bcbrowse.timeouts=urn:browse:bebrowse:com.extensions.qadextensions.safety[60000]

3. Run
yab reconfigure
.
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Custom Browses and Drill Downs
Browse Naming
As an administrator, you can define custom browses using Browse
Maintenance in the QAD .NET UI. These browses are available in the
QAD Web UI when the qra-sync YAB command (yab qra-sync) is run.

When defining custom browses, the labels for menu items on the
QAD .NET UI are defined in Menu System Maintenance (in the Label
field), while the labels for menu items in the QAD Web UI are defined in
Browse Maintenance (in the Description Term field).

When defining a custom browse, be sure that the name of the browse
(the label) is unique to avoid user confusion. Also, note that the browse
naming convention on the QAD .NET UI is to have the name of the
browse end with "Browse", while on the QAD Web UI, the menu item type
is indicated by the menu type icon instead of including "Browse" at the
end of the name.

To assure consistency, be sure that the Menu System Maintenance's
Label field setting is consistent with Browse Maintenance's Description
Term field, except that we would omit the term "Browse" at the end for the
string in Browse Maintenance's Description Term field.

Drill-Down Link Definitions
As an administrator, you can define drill-down links on the .NET UI using
Drill-Down/Lookup Maintenance.

For the drill-down links to be included on a QAD Web UI hybrid view, you
will first need to identify the browse used by the hybrid view of interest. To
identify the browse used by a hybrid view, on Role Permission Maintain's
Secured Resources tab, locate the browse and get the browse identifier.
For example, the browse used with the Sales Orders hybrid view is
identified as "so803.p".

With the browse identifier, you can then define the drill-down links for it
using Drill-Down/Lookup Maintenance. Note that in Drill-Down/Lookup
Maintenance, in the Calling Procedure field, the browse identifier includes
"br". For example, for "so803.p", in the Calling Procedure field, you enter
"sobr803.p". You can then specify the Procedure to Execute.

Once the link has been defined in Drill-Down/Lookup Maintenance, the
change will be included on the QAD Web UI after an administrator runs
the following YAB commands:

• Update resource dependencies: yab qra-resource-dependency-
update

• Restart Tomcat: yab -tomcat stop start
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Lookup Definitions
A lookup gives users a way to select a value from a browse instead of
having to enter the value manually. On the user interface, a lookup can
be included on various input fields, indicated by a magnifying glass icon
located on the right side of the field.

With Lookup Definitions, you can define these lookups: you can view
lookup definitions, create new lookup definitions, and edit lookup
definitions.

As an administrator, you can configure lookups to apply to specified fields
under certain conditions. Further, you can have the lookup on a particular
field change depending on application conditions.

You can define lookups for a business component field or at the level of
a view field. Lookups defined for a business component field can then
be used by all the view fields that are based on the business component
field. Lookups defined for a view field can only be used by the field in that
particular view.

You can also configure a BC browse as a lookup for a QRF report filter
field. For the step-by-step instructions, see the QAD Enterprise Platform
Developer Guide.

Click New to create a new lookup or Edit to modify a lookup. Lookup
Definitions include Main, Browse, and Qualifiers panels. You can also
copy a lookup by using the Actions drop-down.

Main
A lookup definition is uniquely identified by Field URI, Reference, and App
URI values. The Main panel includes:

Field URI

Enter the URI value for a business component field, a view field, or a
browse search field.

A business component field takes the following
format:urn:field:<business component interface
namepace>:<TableName.FieldName

For example, for the Site Code field
in Sales Order Line business entity:
urn:field.qad.sales.salesorder.ISalesOrderLine:SalesOrderLine.SiteCode

Note The lookup on this field only provides a browse of business
component fields. View field URIs must be manually entered.

Field Label

Indicates the field label of the selected Field URI.
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Reference

This is a free-form text field that can be used to differentiate between
multiple lookup definitions for the same field value. For a single lookup
definition for a field, this value can be left blank.

App

Indicates the app name for the lookup definition. For this field, the
active app is selected automatically and cannot be changed.

App URI

The URI for the app that owns the lookup definition. For example, the
Sales app URI is: urn:app:com.qad.sales.

Namespace

Displays the value of the environment namespace.

Browse
On this panel, you can specify the configuration of the browse data for the
lookup definition.

Browse URI

The URI for the browse to be used for the lookup. This is in the format
urn:browse:<browse type>:<browse identifier>. For example, for standard
browses, enter urn:browse:mfg:gp072 and for Financials browses, enter
urn:browse:fin:BGL.SelectGL.

Browse Label

Indicates the browse label of the selected Browse URI.

Result Field

Specifies the result field in the browse whose value will be assigned to
the field from which the lookup is launched.

For standard browses, the lookup result field is specified in the format
<table.field>. For example: pt_mstr.pt_part. If this value is left blank,
then the default from the browse definition is used.

For Financials browses, the lookup result field must be specified and in
the format <field>. For example: tcGLCode.
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Search Field

If there is a value in the field from which the lookup is launched, a
browse search condition will be created for the specified search field
and the value.

For standard browses, the lookup search field is specified in the format
<table.field>. For example: pt_mstr.pt_part. If this value is left blank,
then the default from the browse definition is used.

For Financials browses, the lookup search field must be specified and
in the format <table-name>.<field-name>. For example: tGL.GLCode.

Search Field Operator

Indicates the operator to be used when the lookup is launched with a
value in the field. The list of available operators depends on the data
type of the Search Field.

Search Conditions

This panel allows the configuration of search conditions for the browse.
Enter search conditions for the browse, including:

◦ Field Name — the name of the search field to which the search
condition applies.

◦ Operator — the operator to apply for this search condition.

◦ Value — the field value to use in the search condition. If Type is
set to Field and the lookup is on a grid field, then the referenced
field should be in the format jsonTableName[0].jsonFieldName (for
example: items[0].unitOfMeasure).

◦ Type — set to Literal, Field, or Search variable. A type of Literal
means the actual value will be used. A type of Field means the
value of the business component field referenced by Value will
be used. A type of Search variable means the values such as
Today or Current User can be used. The Search variable type
is available for the Integer/Integer (64-bit), Character, and Date
(date, datetime, datetime-tz) fields.

Additional Result Fields

This panel allows the configuration of additional result fields to populate
with values from the selected browse record.

◦ Field — the name of the browse display field.

For standard browses, the field is specified in the format
<table.field>. For example: pt_mstr.pt_part.
For Financials browses, the field must be specified and in the
format <field>. For example: tGL.GLCode.

◦ Target — the identifier of the target field on the view. This is the
value in the id attribute for that element in the document model.
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This can be found in Chrome by clicking the field and choosing
Inspect.

Qualifiers
The Qualifiers panel specifies any conditions that could determine
whether to apply the lookup.

Qualifiers can be used to define conditional lookups. They are used
to limit the set of lookups that can be used with a field and to select a
particular lookup when there are multiples available. Each qualifier has a
type, name and value.

The Qualifier types include Field and View.

Field

A Field qualifier prevents a lookup from being used for a field unless
another field in the view has a particular value. The Name identifies a
field in the view and Value specifies the value that the field should hold
in order for the lookup to be used.

View

A View qualifier limits the use of a lookup to within a specific view. For a
View qualifier the value is a view URI. The Name is not used. The view
URI is typically the URI of the view containing the field from which the
lookup will be launched.

Note Multiple Qualifier records are combined together using a logical
AND. For example if there are qualifiers (Type=Field,Name=X,Value=2),
(Type=Field, Name=X,Value=3), (Type=Field, Name=Y, Value=4) this is
evaluated as (X=2) AND (X=3) AND (Y=4). In a future release, qualifiers
with the same Name will be combined using logical OR.
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Import Templates
With the Import Templates view, you can access all import templates
for all business components in the system. You can manage the Active
setting for all templates, update a limited set of fields, and delete
templates as needed. Creating templates and adjusting the template
fields can only be done from the Export on page 261 screen.

The Import Templates view accessed from the Export screen is filtered
by the related business component and according to the user role
permissions:

• If you have access to Maintain at System Level and Maintain at
User Level, you can see all system-wide import templates and your
personal import templates for the related business component.

• If you only have access to Maintain at User Level, you can only see
your personal import templates for the related business component.

• If you only have access to Maintain at System Level, you can only see
the system import templates for the related business component.

You can access Import Templates in the following two ways:

• Activity folder > Import Templates

• More > Export screen > Export with Import Format type > Template
menu > Save As/Manage Templates > Import Templates

Template
From the Import Templates view, you can only edit the Label, Description,
and Active fields. The Import Templates view looks similar to the view
from the Export screen, so the descriptions below apply to both views with
a few minor differences.

Template

Specify the template name.

Label

Specify the template label.

Display Label

Specify the template display label.

Business Component

Shows the business component related to the import template.

View

Shows the view of the business component related to the import
template.
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View URI

Shows the view URI of the business component related to the import
template.

Description

Specify a description of the template for informational purposes.

Active

Specify whether the template is active. Inactive templates are hidden
from the Template menu on the Export screen.

Save For

Specify whether the template is system-wide or your personal.

Save To

Templates are always saved as configuration data. See Configuration
Data Overview on page 7014 for detailed information.

App

The template's app (disabled).

App URI

The template's app URI (disabled).

Last Modified By

The name of a person who last edited the record (disabled).

Last Modified Date

The date the record was last edited (disabled).

Fields
You can view the Fields tree for a business component or business
document displaying the configuration for the template (Disabled).
Adjusting the template fields can only be done from the Export on page
261 screen.
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Design Layout
A form organizes everything a user needs for some business task. In a
form, a user can create, view, edit, and delete data. In a hybrid browse,
which initially displays the full browse, the form opens when the user
double-clicks a row (that is, a record) in the browse. A form includes a
summary panel, navigation bar, a main panel, and then various detail
panels and sub-panels.

As an administrator, you can design the layout of a form using the Design
Layout feature located under More (on the toolbar).

The layouts are based on templates. The Default template is provided by
QAD and cannot be changed.

For the Browse Only views, you can only configure drill downs in the
Design Layout. The following panels are available for the Browse Only
views: Set Layout Properties and Configure Drill Downs. The Design
Layout is not displayed for the Browse Only views in the following cases:

• For browses without a view.

• For the views where the EntityURI or PrimarySecureURI is not
specified.

• For the views that use the mfg or fin browse.

New Layout
In the Select a Design Layout pop-up window, click New Layout to create
a new Design Layout.

Name

Enter the name of the layout.

Description

Enter a short description of the layout.

Layout Context

Choose to apply the layout system-wide, to a domain, an entity, or a
site:

◦ System Wide — Apply the layout across all domains (system-
wide).

◦ Domain — Apply the layout to a specific domain. When you select
this option, the lookup appears to select a domain.

◦ Entity — Apply the layout to an entity. When you select this option,
the lookup appears to select an entity. This option is only available
if the business component has the Entity scope.
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◦ Site — Apply the layout to a site. When you select this option, the
lookup appears to select a site. This option is only available if the
business component has the Site scope.

You can create layouts according to the business component scope.
See the table below.

Business Component Scope Design Layout Contexts
Supported

System System Wide, Domain

Shared Set System Wide, Domain

Domain System Wide, Domain

Entity System Wide, Domain, Entity

Site System Wide, Domain, Site

Saved To

Choose to save your data to App Data or Configuration Data:

◦ App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

◦ Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

See Configuration Data Overview on page 7014 for detailed
information.

App

Indicates the app for the layout.

App URI

Indicates the uniform resource identifier (URI) for the app.

Select Existing Template

Select a template to use for creating a new layout. For example, you
can create a new layout from the Default.

Manage Active Layouts
In the Select a Design Layout pop-up window, click Manage Active
Layouts to select which layout is active for the form. Initially, the Default
layout is active, but you can change that to any of the layouts that are
defined.

This option provides quick access to Manage Active Layouts so that you
do not need to open a Design Layout to make it active.
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Design Layout
In the Design Layout, you can design the form. You can drag-and-drop
fields to the Summary panel area, and drag-and-drop user interface
components, including panels, groups, and fields, to the form area. Along
the right-hand side, you can view and change properties for each element
in the Design Layout.

The "inherit" placeholder is provided instead of the blank label property to
help determine where the label comes from. Design Layout fields inherit
from the business component, the form, or the business component
overrides. Design Layout panels inherit from the Form Builder. If you add
a new panel in the Design Layout, it will not inherit.

When non-default Design Layout is active, the custom tab order is
ignored and the default tab order is applied. The default tab order: The
order of tabbing goes from top down, and then left to right by each panel.

Set Layout Properties
Name

The name of the layout.

Description

A short description of the layout.

Active

Indicates whether the layout is active (Yes or No).

Manage Active Layouts

Click to select which layout is active for the form. Initially, the Default
layout is active, but you can change that to any of the layouts that are
defined.

Layout Context

Indicates whether the Design Layout is applied system-wide, to a
domain, an entity, or a site.

App

Indicates the app for this layout.

App URI

Indicates the uniform resource identifier (URI) for the app.

Include Summary Panel

Specifies whether to include the Summary Panel in the layout. This
option is available only if the Include Summary Panel checkbox is
selected in the Form Builder.
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Configure Drill Downs
To access the Configure Drill Downs panel, click the link icon located on
the left side of the Set Layout Properties panel.

You can create and override drill downs for the Browse (Browse Only
views), Browse & Form, and every grid on the form. From the drop-down,
you can select an element currently in the Design Layout and view its
drill downs, which are displayed below the drop-down option. Some grids
have a Linked View defined as part of the grid definition. For these grids,
open the Linked View to configure drill downs. If such grids with a Linked
View are not menu eligible, close the Design Layout, open the grid Details
form, and configure drill downs on the Linked View Design Layout.

Note To add a new drill down, click the plus sign on the Configure Drill
Downs panel.

With the Configure Drill Downs panel, you can identify the drill downs
that do not appear for linked grids and actions and re-define those drill
downs. The warning icon appears next to the drill downs that are not
visible. These are the browse-based drill downs: .NET UI - Browse Based
and User Added - Browse Based. You can view the drill down details
by clicking the pencil icon next to the drill down. The drill down type is
available on the Summary Panel in the Drill Downs detail pop-up window.
For more information about drill down types, see Business Components -
Drill Downs on page 7008.

You can also see a warning icon next to the drill downs that cannot be
found in the current environment. To resolve this warning, delete the drill
down or import a missing resource. You can use the copy icon to copy the
entire label of the missing resource to your clipboard for troubleshooting.
Not found drill downs are hidden at runtime.

Configure Insights
To access the Configure Insights panel, click the light bulb icon located
on the left side of the Set Layout Properties panel. With the Configure
Insights panel, you can configure or add additional KPI links and change
the Insights panel content. This includes turning on/off insights coming
from the Views > Insights and adding custom insights. To add a new
insight, click the plus sign on the Configure Insights panel.

You can view the insight details by clicking the pencil icon next to the
insight. Note that you can edit all insight details, except for the KPI Visual
selection. You can also delete the insights that you added. For more
information about insights, see Business Components - Insights on page
7011.
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You can see a warning icon next to the insights that cannot be found in
the current environment. To resolve this warning, delete the insight or
import a missing KPI visual. You can use the copy icon to copy the entire
label of the missing resource to your clipboard for troubleshooting. Not
found insights are hidden at runtime.

Select drop-down
From the drop-down (initially named <select>), you can select an element
currently on the form and view its details, which are displayed in a box
below the drop-down option.

Panels
Element Name

Specifies the identifier for the panel (disabled).

Panel Label

Specifies the label for the panel's name. Use the lookup to open the
Labels pop-up window and select an existing label.

Columns

Indicates the number of field columns in the panel (disabled).

Buttons
Element Name

Specifies the identifier for the button (disabled).

Button Label

Specifies the display label for the button. Use the lookup to select an
existing label from the Labels pop-up window.

Width

Specifies the width of the button in pixels.

Alignment

Specifies the alignment for a button within a cell. The following options
are available:

◦ Left — Left aligns a button in a cell.

◦ Right — Right aligns a button in a cell.

◦ Center — Center aligns a button in a cell.

Margin Left

Specifies the margin area on the left side of a button.

Margin Right

Specifies the margin area on the right side of a button.
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State

Specifies whether the button is enabled or disabled.

Column Span

Specifies the number of columns that contain the button.

Row Span

Specifies the number of rows that contain the button.

Labels
Element Name

Specifies the identifier for the label (disabled).

Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Width

Specifies the width of the label in pixels.

Alignment

Specifies the alignment for a label within a cell. The following options
are available:

◦ Left — Left aligns a label in a cell.

◦ Right — Right aligns a label in a cell.

◦ Center — Center aligns a label in a cell.

Margin Left

Specifies the margin area on the left side of a label.

Margin Right

Specifies the margin area on the right side of a label.

Column Span

Specifies the number of columns that contain the label.

Row Span

Specifies the number of rows that contain the label. Select from 1 to 50.

Grids
Detail Table

Specifies the detail (data) table for the grid.

Element Name

Specifies the identifier for the grid.
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Grid Columns
In the Design Layout, when you click a grid column header, the column's
properties are listed on the right-hand panel.

Similar to the properties for fields, the column properties are organized
into the Business Component Properties and the Form Layout Properties.
The Business Component Properties for a given column are the same
as the properties for fields because the columns consist of business
component fields, but displayed in columns. The Form Layout Properties
are also similar to the properties for fields.

In the Design Layout, you can do the following:

• Add and remove grid columns

• Change grid column order

• Update a column state for enabled fields only

To add or remove columns, click the grid panel and notice the Add &
Remove Grid Columns link appears. Click the link to open the Add
& Remove Grid Columns pop-up window. It shows all columns that
exist in the grid. If you want to remove columns from the grid, clear
the checkbox for each corresponding field. To add additional columns
from related business components, click the +Select button to select
fields from relationships. When you click the +Select button, the Select
Relationship pop-up window opens. Click the greater than sign to
expand the relationship. You can select the relationship you need, click
Continue, and then in the Select Fields dialog, add columns/fields from
this relationship. The Select Fields browse shows only fields that are not
added to the grid. By default, no fields are selected. You can scroll or use
the search to find the fields you want to add to the grid. The fields are
added to the far right of the grid.

Note The fields that have the Hidden from UI option selected under
Business Component > Fields are not available in the Select Fields
dialog. All fields used in the business component relationship Field
Mapping are also hidden.

To change the grid column order, you can drag and drop columns in
the grid. This is especially needed when new columns are added to the
grid. You can place the new columns in the grid according to data entry
importance or to be near other related data in the grid. Once the column
order is changed in the Design Layout and the layout is active, you can
see the changes.

Note The column position changes made in Design Layout might not be
applied at runtime if there is a stored view. The stored view is applied on
top of Design Layout overrides, and the column position will appear as
defined in the stored view. In such cases, you can use the stored view
to change the column position (only the first level of the grid in case of
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hierarchical grids). For more information about stored views, see Stored
Views on page 276.

Business Component Properties

Business component properties apply everywhere the field is used.

Field

Indicates the identifier for the field.

Display Label

Specifies the display label.

Business Component

Indicates the field's business component.

Detail Table

Indicates the detail table for the field.

Physical Field

Indicates the physical field identifier, based on the detail table and
identifier for the field. This is useful for distinguishing between fields
that might have similar identifiers and labels.

Max Characters

Indicates the maximum number of characters allowed for the field's
data.

Format

Indicates the data format for the field. For example, a checkbox has the
Yes/No format, while a field of up to 80 characters has the x(80) format.

Default Value

Specifies the default value for the field.

Required

Specifies whether the field is required.

Form Layout Properties

Form layout properties apply to the selected layout only and take
precedence over any other settings.

Element Name

Indicates the element identifier for the field.

Control Type

Specifies the control the field uses for accepting and displaying data.
For example, a checkbox field has the CheckBox control type, and a
text string field has the TextEditor control type.
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Field Label

Specifies the display label for the column field. The field label override
logic is as follows:

◦ The original Business Component Label is applied.

◦ If Form Builder Display Property overrides exist for the label, then
Form Builder Display Property overrides are applied.

◦ If Business Component Field Overrides exist for the label, then
Business Component Field Overrides are applied.

◦ If Design Layout Display Property overrides exist for the label,
then Design Layout Display Property overrides are applied.

Required

Specifies whether the field is required without a default value. You can
set a field as required without a default value when you want users to
enter a value. This functionality is not available for checkboxes. The
following options are available:

◦ Yes — Makes a field required without any default value. When you
select Yes, the State field is set to Enabled and you cannot edit it.

◦ Inherit — The "inherit" placeholder is provided instead of the blank
label property to help determine where the label comes from.
Design Layout fields inherit from the business component, the
form, or the business component overrides.

State

Specifies whether the field is Enabled, Disabled, or Read Only. For
enabled fields only, you can change the column state:

◦ State options for checkboxes are Enabled or Disabled.

◦ State options for all other field types are Enabled or Read Only.

Treelist Grids
A treelist grid allows you to display form grid data as a tree, a grid, or a
combination of both and update the tree.

Detail Table

Specifies the detail (data) table for the treelist grid.

Element Name

Specifies the identifier for the treelist grid.

Groups
Note that these settings pertain to a group of fields organized in a grid-
like display within a panel. The term "grid" can sometimes be used in
this context, but here it refers to the grid-like layout of the group of fields,
rather than form data grids, which offer a browse-like display of data.
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Element Name

Specifies the identifier for the field grid.

Columns

Specifies the number of columns in the group. From the drop-down,
choose from 1 to 9.

Click the gear icon to configure the columns. In the Configure Columns
pop-up window, specify the number of columns from the Columns drop-
down (from 1 to 9), and then the Column Width Type and Value for
each column. The Column Width Type can be one of the following:
Auto size, Percentage, or Pixel; the Value is then set accordingly for
the selected type.

Note Pixel column widths can be overridden by fields that require
more width to display content.

Rows

Specifies the number of rows in the group.

Column Span

Specifies the number of columns spanned by the group.

Row Span

Specifies the number of rows spanned by the field grid (group). Select
from 1 to 50.

Custom
Element Name

Specifies the identifier for the custom element (disabled).

Display Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Column Span

Specifies the number of columns spanned by the custom element.

Row Span

Specifies the number of rows spanned by the custom element. Select
from 1 to 50.

Fields
Business Component Properties

Business component properties apply everywhere the field is used.

Field

The field name.
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Display Label

The field label.

Business Component

The business component for the field.

Detail Table

The detail table for the field.

Physical Field

The physical field table identifier.

Max Characters

The maximum number of characters allowed for the field's data.

Format

The format for the field. For example, a field whose value is twenty
characters is indicated by x(20).

Default Value

The default value for the field.

Required

Indicates whether the field is required.

System Overrides

Indicates whether system overrides exist for the business component
field.

Domain Overrides

Indicates whether domain overrides exist for the business component
field.

Manage Overrides

Click Manage Overrides to view the business component field
properties and manage overrides. Changes to these properties affect
all layouts for this business component. If there are any override
values, they appear directly on the Business Component Properties
panel in the Design Layout. For more information about overrides, see
Field Overrides on page 6946.

The Main and Properties panels are always disabled. You can
change these field properties directly in the business component in a
development environment.

Overrides for the 1-N embedded business components are not
supported in the Design Layout. You can manage these overrides from
the Business Components screen.

Form Layout Properties
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Form layout properties apply to the selected layout only and take
precedence over any other settings.

Element Name

Indicates the element identifier for the field (disabled).

Control Type

Specifies the control the field uses for accepting and displaying data.
For example, a checkbox field has the CheckBox control type.

Field Label

Specifies the display label for the field. The field label override logic is
as follows:

◦ The original Business Component Label is applied.

◦ If Form Builder Display Property overrides exist for the label, then
Form Builder Display Property overrides are applied.

◦ If Business Component Field Overrides exist for the label, then
Business Component Field Overrides are applied.

◦ If Design Layout Display Property overrides exist for the label,
then Design Layout Display Property overrides are applied.

Required

Indicates whether the field is required without a default value. You can
set a field as required without a default value when you want users to
enter a value. This functionality is not available for checkboxes. The
following options are available:

◦ Yes — Makes a field required without any default value. When you
select Yes, the State field is set to Enabled and you cannot edit it.

◦ Inherit — The "inherit" placeholder is provided instead of the blank
label property to help determine where the label comes from.
Design Layout fields inherit from the business component, the
form, or the business component overrides.

Input Width

Indicates the width available for the field's data input.

Input Height

Indicates the height available for the field's data input.

Label Visibility

Indicates whether the label is Visible, Hidden, or None.

◦ Visible — When selected, the label displays as usual.

◦ Hidden — When selected, the label is hidden but the label width is
still accounted for.
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◦ None — When selected, the label is removed and the label width
is no longer accounted for. The Label Width field is hidden when
this option is selected.

Label Width

Indicates the width available for the field's display label. This field is
hidden when the None option under Label Visibility is selected.

State

Specifies whether the field is Enabled, Disabled, or Read Only. The
options vary according to the field state in the Form Builder.

Lookup Visibility

Specifies whether the field lookup is Visible or Hidden. This property
does not impact the browse search.

Column Span

Specifies how many columns the field occupies (1 or 2).

Row Span

Specifies the number of rows the field occupies (from 1 to 50).

Add to Layout
From the Add to Layout panel, you can choose user interface elements to
add to the form you are building.

Select Show Unused Only to have the Add to Layout panel only show
elements that are not currently used on the form. While you are building
a form, this option can help to make the panel easier to navigate and can
prevent you from inadvertently adding the same element (such as a field)
more than once on the same form.

Select from UI Elements or Fields to add elements to the form. The listed
fields are organized by field groups, including User Defined Fields, which
are listed last.

UI Elements include Panels and Groups. Under UI Elements, you can
select an element and then drag it to the form area, placing it where you
would like the element on the form.

Fields include all the fields available, organized by panel. Under Fields,
you can select a field and then drag it to the form area, placing it where
you would like it on the form. Fields must be located within a panel. Fields
listed with a checkmark are already included on the form. Fields listed
with a plus (+) sign are not currently included on the form. Fields with a
yellow horizontal indicator are required fields.
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Exporting and Importing Design Layout Data
The following describes how data created using the Design Layout
tool can be exported from one environment and imported into another
environment.

The export and import process depends on whether you saved your
Design Layout data to App Data or Configuration Data.

• For Configuration Data, see Configuration Data Export and Import on
page 7018.

• For App Data, see Package an app and load it in other environment in
the QAD Enterprise Platform Developer Guide.
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Global Distribution
Global Order Management Distribution Processing enables Available-
To-Promise / Enterprise Materials Transfer (ATP/EMT) Visibility and EMT
Tracking across domains of multiple instances of QAD where you have a
central instance that can have visibility into all the others.

Please contact QAD Services to implement this capability in your system.
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Alerts
Alerts provide the capability to notify users when certain conditions are
met.

For example, you can create an alert so that if a purchase order's revision
number changes, a notification is automatically sent to a user's Inbox or
email address.

Alerts can be created by users and by administrators, who can define
alerts for users.

Before you can set alerts about fields on a hybrid view form, you must
enable activity tracking for those fields on that hybrid view's business
component. Activity tracking must be enabled so that the system is
following the activity of the fields of interest.

For more information about activity tracking, see Activity Tracking on
page 6826.

Users can create their own alerts for hybrid view field activity if activity
tracking is enabled for that view's business component. A bell icon in the
upper right corner of the form is displayed if activity tracking is enabled
for the business component. A user can click on the bell icon to open the
Alerts pop-up window for creating alerts.

Users can choose how they receive alert notifications from their user
profile settings. Notifications can be sent to the QAD Inbox and the user's
email address.

Users can also choose to bundle the notifications for an alert into a single
daily or weekly consolidated notification. This facility helps ensure that
your Inbox or external email is not flooded with alerts and notifications.
See Consolidated Alerts on page 6861.

In addition, an Alerts view is available for administrators. Administrators
can access the Alerts view to create, modify, or delete alerts, and to add
users for specific alerts. In this way, administrators can help users have
the alerts they need. For more information on the Alerts view, see Alerts
on page 6862.

The Alerts pop-up window for users is identical to the Alerts view for
administrators, except the Alerts view includes additional settings to
select users for alerts.

On Alerts pop-up windows, users can see both the alerts that they
have defined, and the alerts defined for them by an administrator. Note
that alerts defined by an administrator can only be changed by an
administrator.

Managing Alerts
• Creating Alerts on page 6854

• Choosing to Send Alerts about Changes to Fields on page 6856

6852



Administration

• Choosing to Send Alerts When Conditions Are Met on page 6857

• Defining Periodical Reminders of Alerts on page 6859

• Defining Consolidated Alerts on page 6860

Additional Material
Consolidated Alerts on page 6861
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Creating Alerts
Before you can set alerts about fields on a hybrid view form, you must
enable activity tracking for those fields on that hybrid view's business
component.

For example, on Purchase Orders, to have alerts about changes to the
Revision field, activity tracking must be enabled so that the system is
following the activity of the Purchase Order Header business component's
Revision field.

For more information about activity tracking, see Activity Tracking on
page 6826.

As an administrator, to create an alert:

1. Open the Alerts view.

For more information about the Alerts view, see Alerts on page 6862.

Note Users can define alerts by clicking the bell icon located on a
hybrid view form whose business component has activity tracking
enabled.

2. Click New.
3. On the Main panel, in the Alert field, enter a description of the alert

that you want to create.
4. In the Business Component field, select the business component for

which you want to define this alert.

Note The Saved To field indicates that all alert data is saved as
Configuration Data. See Configuration Data Overview on page 7014
for detailed information.

5. In the Conditions grid, set up the conditions that trigger the alert.

If you do not set up the conditions, whenever the tracked field is
changed, the system delivers an alert notification to users.

To add a condition, click New. To delete an existing condition, choose
the record and then click Delete.

When setting up a condition, you can click the toggle button to enable
field comparison in alert condition definition. When field comparison
functionality is on, the Value 1 field is offered with field options. You
can choose a field as the value. For example, for the Item entity, you
can define: Description contains Item Type.

The rules for combinations of conditions are standard. Conditions
with different Conditions Fields are joined with the AND operation.
Conditions with the same Conditions Fields are joined with the OR
operation.

6. Define the alert type.
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◦ You can choose to send alerts about changes to fields. See
Choosing to Send Alerts about Changes to Fields on page 6856.

◦ Optionally, you can choose to send alerts when conditions are
met. See Choosing to Send Alerts When Conditions Are Met on
page 6857.

7. On the Users panel, add users to subscribe them to the alert.

To add a user, click New.

◦ Literal user ID. In the User / Field column, choose a user ID, and
then click OK. The system displays its user name.

◦ Non-literal user. Click the toggle icon, the Users lookup switches
to the Fields lookup. In the User / Field column, choose a business
component field where the user is specified, and then click OK.
When a non-literal user is selected, the User Name column is
blank. Note that the system supports users, emails, and employee
IDs. You can also add multiple items separated with a colon/
semicolon/comma and spaces.

To delete an existing user, choose the record and then click Delete.
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Choosing to Send Alerts about Changes to Fields
If you want the system to send alerts when changes are made to specific
fields, choose the Send alerts about changes to fields option under the
Conditions grid. When conditions are met, the system sends alerts that
notify users of the changes to the tracked fields.

1. Choose the Send alerts about changes to fields option.

The system displays the Field Changes panel.

2. On the Field Changes panel, select the fields that you want to track.
3. Optionally, on the Notification Options panel, select the Consolidate

Alerts checkbox to bundle multiple instances of the same alert
into one notification, and provide a label for the consolidated alert
notifications. You can also specify how often to send the notification
in Days, Hours, and Minutes. For consolidated alerts, the timer starts
when the first alert is triggered. Alerts are delayed by consolidation
time, for example, if you request a 12-hour consolidation, you receive
the first notification 12 hours after the first alert is triggered.

For more information about the Alerts view, see Alerts on page 6862.
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Choosing to Send Alerts When Conditions Are Met
If you want the system to send alerts when the conditions to trigger the
alert are met, choose the Send alert when conditions are met option
under the Conditions grid.

1. Choose the Send alert when conditions are met option.

The system displays the Message panel and the Notification Options
panel.

2. In the Message box, define the alert message. You can click Include
Field to include fields in the alert message.

The added fields are automatically added to the end of the text. You
can adjust the positions of the added fields manually.

3. On the Notification Options panel, configure the Delivery setting.

◦ Immediate (when conditions are first met): Let the system deliver
alert messages when conditions are first met.

When you choose this delivery option, the first time the conditions
are met, the system sends the defined alert message to users.
Take price, for example: if the condition is that price is greater
than 1,000 and the price value is changed to 1,100 first and then
to 1,200, users will only receive one alert about the first change.
Under the same condition, if the price is changed to 800 first and
then to 1,200, users will also only receive one alert. But this time
the alert is to notify users of the price change to 1,200, because
the price change to 1,200 is the first time the condition is met.

◦ Delayed (after conditions are still true): Let the system deliver alert
messages only when the defined delay time has passed.

If you choose this delivery option, you are required to specify a
time delay in days, hours, and minutes.
In this way, you let the system deliver alert messages when the
delay time has passed, as long as the business event remains in a
triggered state.
If the alert conditions are not true any more during the delay
period, the system does not send the alert message in the end.

◦ Relative (before or after a variable date): Let the system deliver
alert messages at a defined time relative to a variable date.

If you choose this delivery option, you are required to specify the
relative conditions.

4. Optionally, on the Notification Options panel, define periodical
reminders of alerts to let the system send alert notifications
periodically. See Defining Periodical Reminders of Alerts on page
6859.

5. Optionally, on the Notification Options panel, select the Consolidate
Alerts checkbox to bundle multiple instances of the same alert
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into one notification, and provide a label for the consolidated alert
notifications. You can also specify how often to send the notification
in Days, Hours, and Minutes. For consolidated alerts, the timer starts
when the first alert is triggered. Alerts are delayed by consolidation
time, for example, if you request a 12-hour consolidation, you receive
the first notification 12 hours after the first alert is triggered. Note
that consolidated alerts are disabled for Notification Delivery type:
Delayed.

For more information about the Alerts view, see Alerts on page 6862.
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Defining Periodical Reminders of Alerts
When you choose to send alerts when the conditions to trigger the alert
are first met, you can define periodical reminders of alerts at the same
time.

On the Notification Options panel, specify the Repeat for every days,
hours, and minutes as the repetition interval. The system sends alert
notifications at specified intervals about the most recent event that
happens during each interval, as long as the conditions are satisfied.

For example, you set to trigger the alert when item price is over 1,000
and repeat notifications every two weeks. Now you change the price from
900 to 1,100. The system sends a notification about the price change to
1,100. Then within two weeks, you change the price from 1,100 first to
1,200 and then to 1,400. The system sends a second notification about
the price change to 1,400 two weeks after the first notification. If you
do not change the price later, every two weeks, the system sends the
reminder of the same notification as the second one.

For more information about the Alerts view, see Alerts on page 6862.
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Defining Consolidated Alerts
When you choose to send alerts when the conditions to trigger the alert
are first met, you can define alert consolidation at the same time.

On the Notification Options panel, click the Consolidate Alerts check box.
The Days, Hours, and Minutes fields become visible and active.

Using the Days, Hours, and Minutes fields; specify how often you want to
receive consolidated notifications for the relevant alert.

Important Alerts are delayed by consolidation time. For example, if you
request a 12-hour consolidation, you receive the first notification 12 hours
after the first alert was triggered.

See Consolidated Alerts on page 6861.
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Consolidated Alerts
When you receive multiple instances of the same alert in a given period
of time, you can use Consolidated Alerts to bundle these alerts into
a single notification that goes to both the mini and extended Inboxes.
You can then review the consolidated alerts in the Extended Inbox. For
consolidated alerts, the timer starts when the first alert is triggered.

Important Alerts are delayed by consolidation time. For example, if you
request a 12-hour consolidation, you receive the first notification 12 hours
after the first alert was triggered.

The Extended Inbox shows all consolidation alert messages in a grid
format, with Open buttons that open the record in a popup window.

Consolidated Alerts Versus Consolidated Organizations in
QAD Supplier Portal
The QAD Supplier Portal product has a similarly-named feature called
Consolidated Organizations. The Consolidate Alerts notification option
bears no relation to Consolidated Organizations in QAD Supplier Portal.
When alerts are consolidated, only the notifications for the single alert
definition are consolidated. Since alerts can only be set up within a
single customer or supplier account in QAD Supplier Portal, the alert
notification consolidation also only occurs within a single customer or
supplier account.
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Alerts
The Alerts view is available for administrators. Administrators can access
the Alerts view to create, modify, or delete alerts, and to add users for
specific alerts. In this way, administrators can help users have the alerts
they need.

Main
Alert

Enter a brief description for the alert.

Business Component

Select the business component for which you want to define an alert.
Only business components with activity tracking enabled are listed.

Saved To

Indicates that all alert data is saved as Configuration Data. See
Configuration Data Overview on page 7014 for detailed information.

Conditions

You can have alerts about changes to fields, and alerts for when
specific conditions are met. On the Conditions panel, define the
conditions to use for getting alerts when conditions are met.

Click New to define a condition.

Field: select a field from the business component.

Operator: select from the following: equals, does not equal, contains,
not contains, range, greater than, greater or equal to, less than, less or
equal to, in list, not in list, starts with, ends with, is null, is not null. For
operators that require one value, use the Value1 field. For operators
that require two values, use the Value1 and Value2 fields.

Value1: Select from available values or click the toggle icon to select
available fields.

Value2: For operators that require two values, select from available
values or click the toggle icon to select available fields.

Send alerts about changes to fields

From the drop-down, select Send alerts about changes to fields
to get notifications about any changes to field values. On the Field
Changes panel, select the fields for which you want notifications. On
the Notification Options panel, define the delivery options.

Send alert when conditions are met

From the drop-down, select Send alert when conditions are met
to define a message and notification delivery options for when the
specified conditions are met. On the Message and Notification Options
panels, define the message content and delivery options.
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Field Changes
This panel is displayed if Send alerts about changes to fields is selected.

In the grid, select the fields for which you want alerts for field value
changes. Note that only fields that are enabled for activity tracking are
available for alerts.

Message
This panel is displayed if Send alert when conditions are met is selected.

Enter the message text. To include field values, click Include Field and
select from the business component fields. The field is included in the text
in the ${field_name} format, indicating that the field value will be included
in the text.

Notification Options
The Delivery and Repeat options are not available for the Send alerts
about changes to fields option.

Delivery

Select Immediate (when conditions are first met) to have the
notification sent as soon as conditions are met. Select Repeat to repeat
sending the notification while the conditions are met for the specified
Days, Hours, and Minutes.

Select Delayed (after conditions are still true) to have the message
sent after a time delay (in Days, Hours, and Minutes). Select Repeat to
repeat sending the notification while the conditions are still true for the
specified Days, Hours, and Minutes.

Select Relative (before or after a variable date) to have the notification
sent within a specified time (in Days, Hours, and Minutes) before or
after a date provided by selected date field. Select Repeat to repeat
sending the notification for the specified Days, Hours, and Minutes.

Repeat

Depending on the Delivery option selected, specify how often to repeat
the notification in Days, Hours, and Minutes.

Consolidate Alerts

Click the check box if you want to bundle the notifications for this alert
into a single daily or weekly consolidated notification. This facility helps
ensure that your Inbox or external email is not flooded with alerts and
notifications.
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Note The Consolidate Alerts check box is unavailable for delayed
alerts.

When you click the Consolidate Alerts check box; the Days, Hours, and
Minutes fields become visible and active for you to specify how often
you want to receive consolidated notifications for the relevant alert.

See Consolidated Alerts on page 6861 and Defining Consolidated
Alerts on page 6860.

Days, Hours, Minutes

Specify how often you want to receive consolidated notifications for the
relevant alert. These fields are hidden until you click the Consolidate
Alerts check box.

Important Alerts are delayed by consolidation time. For example, if
you request a 12-hour consolidation, you receive the first notification
12 hours after the first alert was triggered.

Label

Enter a label for the consolidated alert notifications.

Users
An administrator can select which users will receive the notifications for
this alert.

Once selected to receive alerts by an administrator, a regular user must
contact an administrator if they do not want to receive the notifications.

Note This panel is included on the Alerts view for use by administrators,
but is not included on the Alerts pop-up window for regular users.

You can add a literal user ID or a non-literal user, coming from a business
component field, such as the Requester or Entered by field.

Click New to select active users who will receive this alert.

User / Field

Select a user or a field from the lookup.

Toggle

Click the toggle icon to switch between a literal user ID (with the Users
lookup) and a non-literal user (with the Fields lookup).

User Name

Displays the name of the user who will receive alerts. When a non-
literal user is selected, the User Name column is blank.
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Notification Templates
With notification templates, you can define notification messages for email
and QAD Inbox for different actions and workflow processes. Notification
templates support multiple languages. The templates defined are used
with the Web UI notification services. This way you can define your own
system messages that will be generated for certain events and sent to
users according to their notification settings as defined in their user profile
or by you in the Users screen. Notification templates can also be defined
to be used for external email communications.

Note that although using a notification template is not mandatory for
notification service, if a template is defined in the system, one version of
the template has to be used by the notification.

As an administrator, you can open Notification Templates from the
Activity folder > Notification Templates. This screen shows all notification
templates in the system (cross-domain/workspaces). You can click Edit to
open one notification template.

The template has a warning message at the top of the form when it
belongs to an app that is not active for development. You cannot delete
or update notification templates or messages belonging to a namespace
that is not your active namespace. Instead of modifying existing template
versions, you can only:

• Change the Active message version.

• Copy the selected message version and modify it (create, edit, or
delete messages in this version).

This gives you the flexibility to have your own version of the template.

Main
Template

Enter the name for this template.

Description

Enter a brief description of the template.

Business Component

From the lookup, select the business component whose fields you
want to use in this template. The description below this field contains
the business component URI, which is the only unique identifier for a
business component.

Saved To

Choose to save your notification template to App Data or Configuration
Data:
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◦ App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

◦ Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

See Configuration Data Overview on page 7014 for detailed
information.

App

The template's app (disabled).

App URI

The template's app URI (disabled).

Messages
New

Define a new message version.

Add Child

Create a new language record for the selected version. This way you
can add multiple languages. It is enabled only for versions.

Delete

Delete an existing version or language. It is enabled only when the
version or language belongs to your namespace.

Details

This opens the Messages form for viewing further details on the
selected language. It is enabled only for languages.

Copy Version

Create a copy of the selected message version with all languages from
the copied version. It is enabled only for versions.

Versions
The Versions row includes the following fields.

Version

If saved to App Data, the message version is based on the app name
where it belongs and a number (disabled).

If saved to Configuration Data, enter the message version.

Description

Enter a brief description of the message version.
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Active

Indicates whether this message version is the one used by notification
service. A new version is not active by default.

Saved To

Choose to save your notification template message to App Data or
Configuration Data:

◦ App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

◦ Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

If the notification template is saved to Configuration Data, the
notification template message can only be saved as Configuration
Data.

See Configuration Data Overview on page 7014 for detailed
information.

App

The message's app (disabled).

App URI

The message's app URI (disabled).

Namespace

Indicates the default namespace (disabled).

Last Modified By

The name of a person who last edited the record (disabled). If a record
does not belong to your namespace, it is blank.

Last Modified Date

The date the record was last edited (disabled).

Languages
The Languages row is read-only and includes the following fields.

Language

The abbreviation of a message language (locale).

Language Description

The full language description.

Default

Indicates the default language for the message version.
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Email

Indicates whether there is message content defined for the email.

Inbox

Indicates whether there is message content defined for the QAD Inbox.

Message Details
You can only create and update records from this Messages form since
this is where you can specify the message content for the different
notification types (email and QAD Inbox).

Main
Language

From the lookup, select the language for your message.

Default

Indicate the default language for the message. If the system cannot
find the corresponding message using the recipient's locale, then the
default message is used. Note that the version can have only one
default language.

Email
Subject

Enter the subject of the email message.

Email Message

Enter your email message.

Inbox
Inbox Message

Enter your Inbox message.

Include
For the Subject and Email/Inbox Messages, you can insert the following
parameters.

Field

Opens the Fields lookup where you can select a field of the
business component (set in the Notification Template). Extended
fields are also available in the list. The inserted value looks like
{salesOrderHeaderConfs.salesOrderNumber} and is replaced with
the field value of the business component when the notification is
delivered.
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String

Opens the Labels lookup where you can select a label. The inserted
value looks like {label:SALES_QUOTE} and is replaced with the label
text in the corresponding locale when the notification is delivered.

Record Link

Only available for Email Messages. Opens the Include Record Link
dialog where you can select Default or Custom:

◦ Default option is read-only and shows how the link text will look
like in the email.

◦ Custom option provides a text box where you can manually enter
a value to display for the link text.
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Managing Approvals
As an administrator, you can configure and manage approvals using the
following functions:

• Approval Configuration

• Approval Routes

• Approval Monitor

• Approval Log
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Approval Configuration
The Approval Configuration function allows administrators to view and
update the configuration of approval processes.

Note   
The initial configuration is loaded during deployment of an application
module.

Using Approval Configuration, you can:

• Enable or disable an approval process

• Configure how approvers and stakeholders get email notifications

• View predefined read-only data of an approval process

Navigate to Approval > Approval Configuration to open the Approval
Configuration menu.

The Approval Configuration menu lists all types of approvals with details
displayed in columns. The types of approval processes include:

• Asset Work Orders

• Purchase Order

• Requisition Approval

• Supplier Invoice

Note   
You can use Browse Configuration to display or hide desired columns.

Approval Configuration and Role Permissions
For notifications of approvals, please be aware of the following:

1. On the Approval Configuration screen, for Requisition Approvals,
make sure the Enabled checkbox is selected. (This is not selected by
default.).

2. For a role that users who should get the notifications (for example,
indicators on the Inbox icon) have membership, such as the webu_ui
role, go to the Role Permissions screen, and for the role (for
example, web_ui) go to Requisition Approval (System > Requisition
> Requisition Approval) set the permissions to Allow for all (Approve,
Create, Delete, Read, Write).

Editing Approval Configuration
You can edit the details in the Approval Configuration Form to configure
the approval process. To edit the approval configuration:

1. Double-click the record listed in the browse to open the Approval
Configuration Form.

2. On the Main panel, configure the basic data.
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3. On the Approvers panel, configure whether and how approvers
receive email notifications about an approval process.

4. On the Stakeholders panel, configure whether and how stakeholders
receive email notifications about an approval process.

Approval Configuration Form
The Approval Configuration Form includes the following panels:

• Main

• Approvers

• Stakeholders

• Mass Approvals

• Approval Updates

• Task

The business component name and business component URI are
displayed at the top of the Approval Configuration Form.

Main
Approval Label

Enter the label that describes this approval process.

Description

Specify the description of an approval.

Enabled

Indicate whether this approval functionality is enabled in Generic
Approval. Take Requisition Approval, for example: a requisition can
be approved either through requisition functions or through Generic
Approval functions. If Enabled is not set to Yes for the Requisition
Approval type, requisition approvals can still be done in requisition
functions.

Refresh Interval

Specify the amount of time in minutes before the business component
is refreshed with the back-end.

Maximum Detail Lines

Specify the maximum detail lines that are displayed on the Approval
Details screen. When the record number exceeds the maximum detail
lines, the browse is incomplete and a link is displayed for you to view
all the records.

For example, if a purchase order has 100 lines but Maximum Detail
Lines is set to 20, in the approval screen, the system only shows 20
lines. If the approver wants to view all other lines, the approver can
click the link.
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Document ID

Choose the field name that determines the document ID of an
approval.

Approval Currency

Choose the name of the field that holds the currency code in the
business component. It indicates that the business component
supports multi-currency.

View

Choose the URI of the View Meta.

Require Authentication

If this field is set to Yes, approvers are required to provide credentials
when clicking an action in the approval screen. If No, no authentication
is required when choosing an action.

Validate Fields

If this field is set to Yes, validations are enforced against the fields of
the business component under approval. If by default, this field is set
to No, then the validation is not implemented for this approval process
and there is no need to turn it on.

Early Approval

This field is not available when Combine Routes is set to Yes.

If this field is set to Yes, early approvals are allowed in the business
component. You can skip approvers before you in the sequence to
take action on an approval request using Future Approvals. If No, early
approvals are not allowed.

Combine Routes

If you set this field to Yes, when an approval request meets the
conditions of multiple routes, the system combines these routes. All
approvers from those routes are required to approve this approval
request. If an approver is set for multiple routes, this approver only
needs to approve once. Early Approval is not available when Combine
Route is set to Yes.

If No, the system chooses the first route that matches the request.

Allow No Route

If you set this field to Yes, when there is no route that matches the
request, the system automatically approves the approval request.

If you set this field to No, when there is no route that matches the
request, the system marks the approval process with the Error status.
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Allow Submitter As Approver

If you set this field to Yes, the Submitted By user can also be an
approver.

If you set this field to No, the system will prevent approval creators from
approving their own approvals. This will prevent the scenario where
a single person can submit and approve documents without anyone
else's knowledge. In addition, if Allow No Route is also set to No and
the Submitted By user is the only approver in the approval route, there
is an error. To resolve the error, define an alternate approver or add a
second approver and resume the approval.

Uses Approval Routes

If you set this field to Yes, the system automatically approves the
approval request.

Approvers
Approver Email Subject

Enter the subject of the notification email that is sent to an approver.
You can include key fields as tokens. You can find some of the key
fields from the Approval Fields and Task Fields panels.

Approver Email Body

Enter the body of the notification email that is sent to an approver. You
can include key fields as tokens. You can find some of the key fields
from the Approval Fields and Task Fields panels.

Here is an example:

For notifications about Supplier Payment Selection Approvals, in the
approver email body, include the following:

Payment selection for ${paySelCode} with a total amount of
${paySelTotalAmtBC}

During run time, Token ${paySelCode} and Token ${paySelTotalAmtBC}
are replaced with real values.

Note   
If you leave both the Approver Email Subject field and the Approver Email
Body field blank, the system does not send emails to any approver.

Stakeholders
Stakeholder Email Subject

Enter the subject of the notification email that is sent to a stakeholder.
You can include key fields as tokens.
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Stakeholder Email Body

Enter the body of the notification email that is sent to a stakeholder.
You can include key fields as tokens.

Note   
If you leave both the Stakeholder Email Subject field and the Stakeholder
Email Body field blank, the system does not send emails to any
stakeholder.

Mass Approvals
The Mass Approvals panel displays the fields to show in the Inbox mass
approval dialog for this approval process.

Mass Approval Label

Enter the label that describes the mass approval process.

Approval Updates
The Approval Updates panel displays all the fields that are used in the
Approve, Deny, and More pop-up windows as extra fields to collect data
input.

Task
The Task panel displays all the fields that are used in Extended Inbox left
panel to display the key information of an approval task.

Task Icon

Choose the icon that is used for Inbox tasks related to this approval
process.

Task Color

Choose the color band that is used for Inbox tasks related to this
approval process.
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Approval Routes
With the Approval Routes function, you, as an administrator, can
configure routes for an approval process. In other words, you can
configure the chain of approvers who need to approve a request, based
on the approval request data.

Navigate to Approval > Approval Routes to open the Approval Routes
menu.

The Approval Routes menu lists all the routes with details displayed in
columns. You can use Browse Configuration to display or hide desired
columns.

You can create, modify, or delete routes.

• To create a route, click New.

• To modify a route, choose its record in the Approval Routes browse
and click Edit. Or, double-click the record.

• To delete a route, double-click its record to open the Approval Routes
Form and then click Delete.

Approval Routes Form
There are three panels in the Approval Routes:

• Main

• Conditions

• Approvers

When you create a route, on the Main panel, enter the name, entity, and
description of the route.

If the Currency Code Field in Approval Configuration has a value, the
Currency Code field is editable and you can specify a currency for the
current route. This field determines the currency of the amounts in both
route conditions and approver conditions. When the currency of the
value in the entity is different from the currency specified in the route,
the system first converts the values of the entity before evaluating the
conditions.

After an approval request is submitted, the system first determines the
route to use based on the route conditions set up on the Conditions panel.
Then the system determines the specific approver based on the approver
conditions set up on the Approvers panel.

Configuring Route Conditions
On the Conditions panel, you can set up route conditions. The route
conditions determine which route the system uses when an approval is
submitted. The system chooses the first route where conditions match the
request data.
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Route conditions are a list of conditions with Field, Operator, and Values.
When setting up the conditions, you can click the lookup browse button to
choose a field from the object being approved.

For example, in the following figure, only when payment selection total
amount is greater than 20,000 dollars, the system uses the route SP-
Test02.

The rules for combination of conditions are standard. Conditions with
different Conditions Fields are joined with the AND operation. Conditions
with the same Conditions Fields are joined with the OR operation.

Fields from both the top-level table and the second-level table of the
entity are listed in the lookup browse. Conditions on child fields can
be used with conditions on parent fields in one route. If a child field is
used in a route condition, this route condition is regarded as a filter for
child records. If no child record satisfies the condition, this route does
not match the approval request. Also, only child records that match the
condition participate in approver condition evaluation.

Here is an example. In the following figure, Purchase Order Line Item
Code is a child field from the second-level table Purchase Order Line
Details. The route conditions are:

• Supplier Code equals 10-300, and

• Any of the purchase order lines has Item Code being 01010.

When an approval request meets these two conditions at the same time,
the system chooses this route.
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You can modify or delete an existing Conditions record.

• If you modify a Route Conditions record, the system saves the new
record as a new version of the route in the back-end database. The
existing active approval processes follow the old route version, but
new approval processes follow the new route version.

• If there is an active approval process that follows an existing Route
Conditions record, you cannot delete this Route Conditions record.

Configuring Approvers
On the Approvers panel, you define the approvers in the current route.
For each approver, you define the user, its sequence, duration, and other
data.

Click Details to open the Configuration Details window. On the Conditions
panel of this screen, you can configure specific conditions related to
specific approvers. Fields from both the top-level table and the second-
level table of the entity are listed in the lookup browse. The rules for
combination of approver conditions are the following:

• Conditions with different Conditions Fields are joined with the AND
operation.

• Conditions with the same Conditions Fields are joined with the OR
operation.

• Conditions of a second-level table field are iteratively evaluated on
the second-level table record collection. If one record satisfies the
condition, then the system returns true. If there is no second-level
table record, or none of the records satisfy the condition, then the
system returns false.
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You can use aggregate calculation in setting up approver conditions.
Define the field for which you want to calculate an aggregate amount, and
set Aggregate to Yes. Then set up the condition based on the aggregate
amount of this specified field.

Note   
The Aggregate field can only be set to Yes when the value is integer or
decimal.

In the following figure, when the aggregate extended cost of all the child
records is greater than 500, the system routes the approval to the qad
user.

The system first determines the route to follow based on route conditions.
If approver conditions are also configured, the system then determines
the specific approver based on approver conditions.

For example, in the following figure, if an approval request meets these
two conditions at the same time, the system chooses Route PO-Test01.

• Supplier Code equals 10-300, and

• Any of the purchase order lines has Item Code being 01010.
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Then the system routes the approval request to different approvers in the
following sequence:

1. The approval request is first routed to the demo user.
2. Then, if the aggregate extended cost of all lines with Item Code

01010 is greater than 500, the approval request is routed to the qad
user. In this case, the qad user becomes the second approver in the
sequence.

3. Then, if any of the purchase order lines with Item Code 01010 has an
extended cost greater than 1,000, the approval request is routed to
the qmi user. In this case, the qmi user becomes the third approver
following the demo user and the qad user successively.

If a route is selected, but no approver is selected, the system behavior
depends on the Allow No Route setting in the Approval Configuration
form.

• If Yes, the system automatically approves the approval request.

• If No, the system marks the approval process with the Error status.

If you modify an Approver Conditions record, the system saves the new
record as a new version of the route in the back-end database. The
existing active approval processes follow the old route version, but new
approval processes follow the new route version.

Sequence Number

Indicate the sequence of the approvers in which the approval process
goes through all the approvers. More than one approver can have the
same sequence number. Parallel approvers are assigned tasks at the
same time and any of them can approve or deny approval requests
without waiting for others. If any of the parallel approvers deny the
request, the approval process is closed with a Denied status. Only
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when all parallel approvers approve the approval request, can the
approval request move to the next approver.

Description

Enter a short description of this approver sequence.

User

Specify the user who you define as the approver.

Is Literal

If you set it to Yes, you can only enter a constant in the User field. If
you set it to No, you can only enter a field name in the User field and
this field holds the user ID of the approver.

Duration

Specify the number of duration units as the time limit for the validness.

Duration Unit

Choose Days, Hours, or Weeks as the unit of measure for the duration.

Configuring Alternate Approvers
For each approver, you can define alternate approvers. Alternate
approvers can be assigned tasks and take action when the task for the
main approver becomes overdue. This functionality prevents an approval
process from being stuck for a long time.

Define alternate approvers on the Alternate Approvers panel. For each
alternate approver, enter the user ID, set the duration in hours, days, or
weeks, and enter a description.

User

Enter a user ID as an alternate approver.

User Name

The system displays the user name according to the specified user ID.

Duration

Specify the number of the duration units as the time limit for the
approval to take place.

Duration Unit

Choose Days, Hours, or Weeks as the unit of measure for the duration.

Description

Enter a brief description.

When the approval task for the main approver is overdue, the system
creates a second task and sends it to the first alternate approver. Either
the main approver or the alternate approver can approve or deny the
approval. When the waiting time exceeds the duration set for the first
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alternate approver and still no one has responded to it, this task becomes
overdue. The system creates a third approval task and assign it to the
second alternate approver.

You can view all the created approval tasks in Approval Monitor and
Approval Log.

If there is no alternate approver and Early Approval is defined for the
approval process, the system creates a notification for the next approver.
The next approver can take action in the Future Approvals menu.

Exporting and Importing Approval Routes
You can export approval routes from one system, and then import them
into another system.

Exporting Approval Routes
To export data, from the Approval Routes > More drop-down menu,
choose Export. The Export screen opens, where you can export the data.

Criteria

Shows any browse search criteria that you have applied (disabled).

Records Returned

Shows the number of records returned according to the search criteria
(disabled).

File Name

Enter the export file name.

Type

Select one of the following export types:

◦ Export Browse Columns

◦ Export with Import Format

Include in Export

(Only for Export Browse Columns) Export the current stored view
columns (disabled).

Format for Record Delete

(Only for Export with Import Format) Select to export data and specify
the records to delete upon import of the spreadsheet. This will add an
additional column to the spreadsheet so you can specify which records
are to be deleted.

Generate Blank Template

(Only for Export with Import Format) Generate a resulting Excel import
template without any data populated.
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File Type

For Export with Import Format, the file type is Excel (.xlsx).

For Export Browse Columns, select the file type. You can export
browse data to a variety file formats, including:

◦ Excel (.xlsx)

◦ Comma-separated values (.csv)

◦ Tab-separated values (.tsv)

◦ Tab-delimited values (.txt)

◦ Portable Document Format (PDF) (.pdf)

Export File

When you click Export, the system will start to export data to the file,
running in the background. You will receive a notification in the Inbox
when the export is completed, and you can then click the link in the
notification to download the file. The export process may take some
time when there is a large amount of data. Please do not sign out
when the export is running; instead, just close the web browser page if
necessary. If you do sign out of the Web UI, the export will fail and you
will not receive the notification.

Excel Import Template
To import data, export the data to Excel or generate a blank template,
make changes, and then re-import data from Excel.

You can only import data that is in a proper Excel file format. You can then
remove the data rows and enter new data rows, following the format in
the Excel file. See the Entering Data section below.

Legend

To differentiate fields from one panel to another, a standard black
vertical column border separates the panels and/or grid levels.

Entering Data
You can further customize the spreadsheet by deleting some columns, as
long as it is not a key field.

You need to enter data in corresponding rows specified by the Row Data
value.
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If you leave a cell blank, the value of the field will not be updated.

Use curly brackets {} to update a field value with blank, this is only
needed for character fields with default value logic; create and update.

Importing Approval Routes
To import data, from the Approval Routes > More drop-down menu,
choose Import. The Import screen opens, where you can import the data.

Routes will be imported exactly as defined; any missing route conditions
or approvers data will be deleted.

Choose File

On the Choose File panel, choose a file or drag a file to the screen.

Data Preview

To help make sure you have selected the file you want, the Data
Preview panel shows the first ten lines of the file.

Import Results

When you click Import, the system will start to import the data into the
system, running in the background. You will receive a notification in
the Inbox when the import is completed, and you can then click the
link in the notification to open the background processing details of the
import. If the import failed, you can check the errors using Background
Processing on page 6890, or go to attachments and download the
results file.

The import may take some time when there is a large amount of data.
Please do not sign out when the import is running; instead, just close
the web browser page. If you do sign out, the import will fail and you
will not receive the results notification.

Excel Import Results File
The system provides the import results in an Excel file. The file includes
four sheets: Log, Error, Failed, and Properties.

You can identify fields with error or warning/information messages by the
following cell highlighting:

You can use the Excel import results file to import the failed records. To
do this, fix the errors in the Failed sheet, delete the Errors column, and
then move the sheet to first in the file.
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Log

The Log sheet provides the import status for each row (error or
success).

Error

For failed rows, the Error sheet provides further information about each
failed row.

Failed

The Failed sheet provides the row data so that you can correct it and
re-import.

If the row contains errors, the Errors column shows Error (#), where #
is the count of errors and warnings for the row. Hover over the cell to
view a comment listing the errors and warnings for the row. Information
messages are also displayed in a comment.

Properties

The Properties sheet includes summary information about the report,
including the user ID, time, and import file name.
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Approval Monitor
With Approval Monitor, administrators can do the following:

• View all open approvals, including the ones with errors.

• Stop an approval process by using the Stop Route button.

Note The Stop action in the Approval Monitor is not available for
requisitions.

• Resume an approval process with an error after fixing the error.

Navigate to Approvals > Approval Monitor to open the Approval Monitor
menu. Double-click a record to open the Approval Monitor Form to view
the details.

Approval Monitor Form
On the top of the Approval Monitor Form, the following information is
displayed:

• The date when the approval request is submitted

• The person who submits the approval request

• The status of the approval process

Note   
There are six types of status: Approved, Denied, Pending, Error,
Paused, and Stopped. Only processes in the Pending, Error, Paused,
and Stopped status are displayed in the Approval Monitor Form. The
approval processes in the Pending, Error, Paused, or Stopped status
are not completed and are called open approval processes.

• The status message

• The approval link

• The workspace
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The Approval Monitor Form includes the following panels:

• The Main panel: Displays the basic information of the approval
request. Besides the information displayed on the top of the Approval
Monitor Form, it also includes approval type and description.

• The Past Approvers panel: Displays the approvers that have taken
action on the approval request with their usernames, names,
completion dates, comments, and other details. If an approver is an
alternate approver, the system displays the main approver in the
Alternate For column. If an approver is a delegated approver, the
system displays in the Delegate For column the original approver who
delegated the approval task to this approver.

• The Next Approvers panel: Displays in sequence the approvers
to whom the approval request will route, with their usernames and
names. If an approver is an alternate approver, the system displays
the main approver in the Alternate For column. If an approver is
a delegated approver, the system displays in the Delegate For
column the original approver, who delegates the approval task to this
approver.

• The Audit Log panel: Displays the history of the audit, including time,
action, user ID, user name, and status message.

Stopping Approval Processes
The administrator can stop an approval process in the Pending or Error
status.

To stop an approval process:

1. Double-click the record to open its Approval Monitor Form.
2. Click the Stop Route button in the lower-right corner of the form.
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The Stop action in the Approval Monitor is not available for requisitions.

Resuming Approval Processes
You can only resume approval processes that are in the Error status.

To resume an approval process:

1. Resolve the error.
2. Click the Resume button in the lower-right corner of the form.

For example, if the error is Access is denied, the administrator can grant
privilege to the approver. Then click the Resume button in the lower-right
corner of the form.
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Approval Log
Approval Log is a browse that shows all approval processes, including
closed ones.

Navigate to Approval > Approval Log to open the Approval Log menu.

To view details of an approval process, choose the record and double-
click it to open the details screen. The details screen is for display only
and it shows all information about the approval process, including an audit
log. This function can be used for audit purpose.
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Background Processing
There are many configuration options for background processing, and the
configuration is based on the implementation of each background process
type.

Background Processing Views
There are three different browses to view background processing.

• Submitted Background Processing — This view is available to all
users from the user options drop-down. The Submitted Background
Processing view is filtered to show only the background processes
submitted by the logged in user. It is used by users to monitor and
manage processes that they submitted.

• Background Processing — This view is available to administrators
from the Activity folder. The Background Processing view shows all
background processing records created in the system. It is used by
administrators to monitor and manage background processes.

• Background Processing Details — This view is available to all users,
and it is used by users to monitor and manage processes that they
have access to. You can access this view from the drill-down link
on the business component or from the link in notifications. The
Background Processing Details view is filtered to show only the
background processes the user submitted or is granted access to
based on the Manage Background Processing security permission to
the business component.

Background Processing
With the Background Processing view, you can monitor all background
processing records created in the system and manage them.

The Main and Summary panels display the information for the most
recent submission. If there are multiple submissions for the background
processing record, review the Submissions panel to see the previous
submission information. Note that the only field you can modify here is
Description.

Main
Business Component

The business component related to the background processing record.

Type

The type of background process. This references the action the
background processing record is related to (for example, Confirm).
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Description

Every background processing has a description, usually specified by
system or user when the background processing is submitted. You can
modify and enter a description, which is more meaningful.

Link

Link to the source record, from which the background processing is
started.

Open

This opens the link to the source record.

Status

The status includes the following options:

Completed

The processing percent complete.

Submitted By

The user ID and user name of a person who made the most recent
background processing submission.

Submit Date

The date and time when the most recent background processing
submission entered the queue.

Processing Start Date

The date and time when the most recent background processing
submission started processing.

Processing End Date

The date and time when the most recent background processing
submission finished processing.
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Submissions
Submission

The submission data for the background processing record. One
background processing record can have multiple submissions. If there
are multiple submissions for a single background processing record,
you can view them by using a drop-down menu.

Details

This opens the Submission Details browse for viewing further details on
the selected record.

Failed

The count of failed records.

Successful

The count of successful records. Warnings are also counted as
Successful.

Warnings

The count of records with warning messages.

Processed

The count of total records at the end of processing. Processed = Failed
+ Successful.

Records with Messages
Only records with messages are listed in the "Records with messages"
grid. One record can have multiple messages, and the system only shows
the highest severity message in this grid. If you want to see all messages,
click the Details button.

The "Records with messages" grid only shows 999 records. If the grid
exceeds 999, click the Details button to open the Submission Details
browse to access and review the full set of records with messages.

Record

The record processed in background processing submission.

Open Record

This opens the related record in a pop-up window for error correction
and reprocessing.

Record Type

The type of record the record ID represents, for example, Supplier
Invoice or Sales Order.

Result

The processing result for the record includes the following options:
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◦ Successful — The record is processed successfully.

◦ Failed — The record processing failed.

Message Count

The number of messages returned after processing.

Message Type

The most critical message type returned for the record during
processing. The message type priority logic is:

1. Error

2. Warning

3. Information

Message

The first message returned of the highest priority message type for the
record.

Field

The field label of business component field the message is related to.

Field Value

The invalid record value that triggered the message.

Step

The background processing step the record is processed in.

Description

The description of the API called for the step.

System Error
There can be situations where a background process is executing but the
step execution callback is never returned to background processing. This
situation is rare but can be caused by time outs, Tomcat being restarted,
or the server going down. The end effect is that the processing results
of background processing step are never returned. With the System
Error panel, you can review the step request for background processes
that failed with system errors and continue processing by skipping or
rerunning the error step.

You can only view the System Error panel when a background processing
submission resulted in a status = "Failed - System Error" and that
submission is selected on the Submissions panel.

View Error

This opens the System Error pop-up window for viewing error details.
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Submission

The submission to which the system error is related.

Error Step

The step that was processing when the callback was not returned. The
step description is displayed after the field.

Skip Step

Initiate a new submission for the failed background process; the
process will become queued for processing. When the process
moves from Queued to Processing, the step with error is skipped and
processing continues for the remaining steps in the original background
processing execution. Submissions that continue a "Failed - System
Error" execution will start with a warning message in the "Records with
messages" grid: "Error step from previous submission was skipped".

Troubleshoot before taking the “Skip Step” action—unprocessed
records in the skipped step may need to be manually processed.

Note If the error step is the last step in the process, the Skip Step
button is not available; use the Rerun Step button.

Rerun Step

Initiate a new submission for the failed background process; the
process will become queued for processing. When the process moves
from Queued to Processing, the step with error is reprocessed and
processing continues for the remaining steps in the original background
processing execution. Submissions that continue a "Failed - System
Error" execution will start with a warning message in the "Records with
messages" grid: "Error step from previous submission was rerun".

Troubleshoot before taking the “Rerun Step” action—processed
records in the step may need to be manually reverted.

Step Processing Start Date

The date and time when the step started processing.

Resubmission

Informs of the resubmission action taken to attempt to process as much
of the original data for the process as possible. The following options
are available:

◦ Blank — The reprocessing has not occurred.

◦ Skip Step — The administrator chose to skip the error step and
continue processing.

◦ Rerun Step — The administrator chose to rerun the error step and
continue processing.
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Request

The API request which informs of the data included in the step.

Copy

Copy the request data to your clipboard.

Submission Details
Сlick the Details button on the Submissions panel to open the Submission
Details browse, where you can review the full set of records with
messages. One record can have multiple messages, and the system only
shows the highest severity message in the Submission Details browse. If
you want to see all messages, double-click the record.

Some background processing, like Supplier Payment Selections, may not
want to return records that are successfully processed; the application
only returns records with messages. If only records with messages are
available to review in the Submission Details browse, you will see a
message about this.

Note You cannot update or delete records in the Submission Details form.

If the record processing failed due to an error, you can open a detailed
record by clicking the Open button and view the errors. This way, you can
quickly and efficiently correct processing errors and resubmit the action.
If an error is still valid, it is displayed in the Errors grid. If an error may
not be valid, you will see a message about this. You can also view the
messages by clicking the messages icon on the right-hand side of the
view.

You can export the submission details data to Excel by using the More
menu. However, if more than one message is generated for the record,
only the first error of the highest priority error type is included in the Excel
export. To view all record messages, you can work in the Submission
Details form.

Concurrency Control
You can control the concurrency of background processing. Limited job
steps can be executed at the same time, and this capacity is defined in
the Tomcat Web UI property nifi-background-job.service.jobStepCapacity,
with a default number of 3. This means by default, only three steps of
different background jobs can be executed at a time. Background jobs
that cannot be executed stay in the Queued status until the system picks
up their steps. With this property, the system is not overloaded with
running background jobs.

To configure this setting, you will need to run the YAB command.

Managing Background Processing
As long as you monitor background processes, you can take the following
actions from the Actions menu: pause, resume, or cancel the background
process. You can only cancel or pause background processes as long as
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the background process is not executing the last step. If you try to cancel
or pause a background process when the last step is executing, you will
see a message about this.

The background processing status diagram below shows under what
conditions you can take what actions. If an action is not available, it
means you cannot take the action under current conditions.

Actions
Cancel

Terminates the background process and updates the status to
Canceled. This action is available when the status is Queued,
Paused, or Processing (not executing the last step). When you cancel
background processing, it will stop after the current step is completed.

If you cancel the background process, you cannot resume it. You will
need to resubmit the action.

Pause

Stops the background process and updates the status to Paused.
This action is available when the status is Queued or Processing (not
executing the last step). When you pause background processing, it
will pause after the current step is completed.

Resume

Updates the status to Queued and processing will begin at the point
the background processing is paused. This action is available when
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the status is Paused. Use this action when you want to restart the
background processing.

Background Processing Notifications
Background processing results are sent to the user who submitted the
background process when the background processing completes. For
the Skip/Rerun Step submission, the background processing results for
the resumed submission are sent to both the user who submitted the
background process with "Failed - System Error" and the background
processing administrators defined in Background Processing Control on
page 6899.

According to the user's notification preferences, the system automatically
sends notifications to the user's QAD Inbox or Email address.

The notifications include:

• Notification icon for the background processing result

• Subject: "Background Processing:" [Description]

• Submission summary:

◦ Failed - [Records Failed]

◦ Successful - [Records Successful]

◦ Warnings - [Records with Warnings]

◦ Processed - [Records Processed]

You can configure background processing notifications in your user
profile. There is Background Processing under Category Settings and
under Event Settings that you can configure to enable the QAD Inbox or
Email notifications for background processing.

Background processing notifications are always sent at the outcome of
each process, allowing you easy access to the background processing
record and providing the processing summary information in the extended
Inbox and Email notifications. You may want to configure your notification
preferences differently depending on the background processing
outcome. It is likely to be more important to be notified about failed or
canceled background processes than it is for the completed ones. To
help you better manage the notifications you receive, two background
processing notification event settings are available:

• Background Processing Completed/Paused

• Background Processing Failed/Canceled

Notification events for background processing can only be configured at
the event level, not at the background processing type level. The following
options are available for QAD Inbox and Email:

• All — The notification option for every process type = Yes.
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• Configured — It is equal to choosing None. Avoid using Configured
because for the background processing events you cannot configure
at a lower level.

• None — The notification option for every process type = No.

Most background processing notifications are based on a default
notification template, which you can see under Notification Templates on
page 6865. Some types of background processing may use their own
templates.
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Background Processing Control
With the Background Processing Control screen, you can define the
background processing configurations, including record retention days,
step time out, and background processing administrators (who will receive
a notification when there is a system error with background processing).

For the Skip/Rerun Step submission, the background processing results
for the resumed submission are sent to both the user who submitted the
background process with "Failed - System Error" and the background
processing administrators defined in the Background Processing
Control screen. Depending on the users' notification preferences for the
"Background Processing Failed/Canceled" event, they will receive a QAD
Inbox notification or an Email notification, or both.

As an administrator, you can open Background Processing Control from
the Activity folder > Background Processing Control.

Main
Failed Record Retention

Specify the number of days to maintain failed records.

Successful Record Retention

Specify the number of days to maintain successful records.

Step Time Out

Specify the number of hours for the step time out. For each background
processing step, if the system does not receive a callback (processing
results) after the time duration specified by Step Time Out, the system
will set the status of the background processing job to “Failed - System
Error”.

Administrators
Type

Select the User type. Please note that Role is not currently supported.

Role/User

Select the user. Only active users are available.

Description

Displays a user name.

Date Last Modified

The date the record was last edited.

Last Modified By

The user ID of a user who last created or updated the record.
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Themes, Workspace Indicators, Environment
Indicators
As an administrator, you can create and apply your own themes in
Adaptive UX (for branding), and apply visual distinctions for different
workspaces within an environment and for development/test/production
environments.

Environment Indicators
Important Changes to environment indicators require a QAD Support
ticket. Contact your system administrator.

It is possible to configure a globally visible indication to distinguish
between different environments, such as DEV, TEST, and PROD. This
also supports more than three environments. The top of the screen
can include an application message to visually distinguish between
environments. The styling and text are configured through a properties file
where the environments themselves are configured.

The following settings are configurable:

• Visible — Indicate whether an environment indicator is visible.

• Icon — Specify an environment icon to display on the indicator bar.

• Text — Specify the text to display on the indicator bar.

• Text Color — Specify the text color on the indicator bar.

• Background Color — Specify a background color of the indicator bar.

The production environment has no indicator by default.
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Workspace Indicators
You can configure a visual indication to distinguish specific workspaces
within a system instance. See Theme Setup below. A workspace indicator
can be one or both of the following:

• A color specified to differentiate a workspace.

• A custom theme (different than the active theme).

All domains inherit the active theme unless otherwise specified. All
entities inherit the domain workspace color and theme unless otherwise
specified.

Workspace themes cannot be shipped with the QAD product because
workspaces are not shipped with the product.

Theme Setup
With Theme Setup (More > Setup > Theme Setup), you can create and
edit themes, as well as set the active theme and workspace indicators.

You can set up themes to display company brand colors and logos
throughout the application instead of QAD brand colors. Examples of
elements that can be configured are: menu bar color, loading icon, vertical
menu button colors, button colors, drop down text colors, screen title
color, navigation bar colors, menu logo, favicon image, home page image.

When the menu logo is changed, the QAD logo is located on the left side
of the menu. It is not clickable and is only displayed to keep the QAD
brand visible.
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Main
Active Theme

Select from either the QAD Adaptive UX theme or a custom theme
defined on the Custom Themes panel. The active theme is the theme
that is applied to the environment. Workspaces use the active theme
unless they have specified a custom theme for the workspace.

Workspaces
On this panel, you can associate colors and themes with workspaces.

• Delete — Delete a selected row from the grid.

• +Select Domains — Opens a lookup to multi-select domains.

• +Select Entities — Opens a lookup to multi-select entities.

Type

Indicates the Domain or Entity selected from +Select Domains or
+Select Entities. This field is read-only.

Workspace

Indicates the Domain or Entity context. This field is read-only.

Color

Indicates a workspace color.

Custom Theme

Indicates whether to use a custom theme. If no, the active theme is
used. If yes, the Theme column becomes enabled.

Theme

Click a lookup to select from the existing custom themes.

Custom Themes
On this panel, you can create, delete, and edit custom themes as well as
copy and preview them. See Custom Theme Details below. You cannot
delete a theme that is in use.

• Copy — Copy the currently selected theme. Everything from the
original theme is copied into the new theme, except for the following:

◦ Theme

◦ Description

◦ App

◦ App URI

◦ Last Modified Date

◦ Last Modified By
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• Preview — Preview the current theme to make sure the colors
are as required. To exit the preview, close the browser tab or click
Exit Preview at the top of the screen. You can navigate around the
application and open any screen to preview the new theme.

Custom Theme Details
With Custom Themes, you can create and edit custom themes used
throughout the application.

Main
Theme

Enter a unique theme name.

Create from QAD Theme

Create a new theme based on the QAD Adaptive UX theme, including
the brand image and colors. You can still make changes to the theme if
needed. This option is available only when creating a new theme.

Description

Enter a short description for the theme.

Brand Image

This is typically a company's logo. Click Choose file to upload an image
that will be used to generate the color palette. This image is also used
on the Images panel below. You can upload a new image at any time,
any existing palette and color definitions are unchanged until you click
the Generate from Brand Image button. Formats allowed are .png
(recommended) or .jpeg. The maximum file size is 5120 KB.

Saved To

Choose to save your data to App Data or Configuration Data:

◦ App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

◦ Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

See Configuration Data Overview on page 7014 for detailed
information.

App

The theme's app (disabled).

App URI

The theme's app URI (disabled).
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Last Modified Date

The date the theme was last edited (disabled).

Last Modified By

The name of a person who last edited the theme (disabled).

Palette
Generate from Brand Image

Optionally, click this button to automatically generate a color palette
from the brand image and apply colors to the theme. This button
becomes enabled after you upload a brand image. Clicking this button
fills in the color palette grid and the Advanced panel below. You can
make manual changes after the first generation. If you want to reset
colors to default values, click this button again.

Sequence

Indicates the sequence of the colors: Primary, Secondary, and
Alternate. This impacts how they are applied throughout the
application. Use the Move Up and Move Down buttons to change the
sequence. Primary and secondary palette colors are required to save
the theme.

Color

Select a color or enter a hex value.

Light, Regular, Dark

Indicates color variants that may also be used.

Advanced
Indicates detailed color assignment for each application element. These
colors are assigned automatically when creating a color palette, but
can be tweaked individually as needed. The following elements can be
configured:

• Menu Text

• Menu Background

• Menu Text Hover & Active

• Menu Background: Hover & Active

• Vertical Menu Icon

• Vertical Menu Background

• Vertical Menu Icon: Hover

• Vertical Menu Background: Hover

• Vertical Menu Icon: Active

• Vertical Menu Background: Active
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• Loading Icon

• Custom Button Background

• Custom Button Text

• Link Text: Hover & Active

• Clear & Drop Down Button Text: Hover & Active

• Drop Down Text: Hover & Active

• Form Navigation & Inbox Tabs: Hover & Active

• Summary Panel Text

• Screen Title Text

• Panel Title Text

• Toolbar Graphic

• Search Underline

• Grid Row: Hover

• Grid Row: Selected

• Grid Row: Edit Mode

Images
Favicon Image

Indicates the image displayed on the browser tab (icon at the very
top of your browser). This is often a simplified version of the brand
image since it is so small, so there is an option to use the Brand Image
specified above, or use a custom image. You may also find it helpful
to use different favicon images in different environments to easily
distinguish different environments across browser tabs. Image must
use RGB colors to display favicon. The .png format is recommended.

Menu Logo

Indicates the image displayed on the menu bar used to navigate to
your home page. You can use the Brand Image specified above, or use
a custom image.

Home Page Image

Replaces the QAD logo displayed on the default home page. You can
use the Brand Image specified above, or use a custom image.

Type

Select Logo (replaces the QAD logo with the uploaded image) or Page
Background (removes the QAD logo and uses the image as a page
background). For the Page Background option, you can select the
following options:
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◦ Fill — The image is centered on the screen. The image fills the
screen horizontally and vertically, and maintains its original aspect
ratio. Parts of the image might overrun the left and right sides or
the top and bottom edges (but not both).

◦ Fit — The image is centered on the screen. The image fills the
screen horizontally or vertically, and maintains its original aspect
ratio. Parts of the image might not fill the left and right sides or the
top and bottom edges.

◦ Stretch — The image is centered on the screen. The image fills
the screen horizontally and vertically, but does not maintain its
original aspect ratio. No part of the image overruns the screen.

Theme Setup Best Practices
Refer to the following best practices while using Theme Setup to help you
build cohesive and beautiful themes.

Theme Setup Best Practices

Generating Palette Colors
For the quickest and most cohesive theme, it is recommended to
generate a palette from your company logo, which will automatically
assign all advanced colors. Alternatively, enter your company's brand
colors directly into the palette grid. Then use the Preview feature to
identify where tweaks may be needed to the advanced colors.

• When selecting a company logo image, it is recommended to use
a .png image or .jpeg image with RBG colors. Using a .jpeg image
that uses CMYK colors (meant for print, rather than web) will not
display correctly in the Favicon.

• If you are not building a palette from an existing brand, Coolors.co
can help generate cohesive palette colors.

When defining primary and secondary colors, a good rule of thumb is to
pick a color that will work well as the background for a colored button.

• As a reminder, the alternate color is generated simply as an
additional color option for use as the primary or secondary color. If
left as alternate, it will not be used anywhere.

Keep in mind the meaning of different colors when building a palette -
red/yellow/green are often used as a stoplight metaphor (stop, warn,
go). When assigning these colors to your palette or advance colors,
be sure to think about how the color might be perceived in the context.
For example, a red button used for a non-destructive action may cause
confusion for a user.

Color Contrast
Make sure your text and background colors have enough contrast. The
automatic color generation is designed to ensure the colors meet Web
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Theme Setup Best Practices
Content Accessibility Guidelines (WCAG) (learn more). When manually
setting text or background colors, make sure there is enough contrast
ratio between the text color and the background color. To check the
contrast ratio, use .

Home Page Image
If you plan to use a background image on the home page, it is
recommended to use a simple image or to apply a white overlay with
80% opacity over the image so the home page text is still legible.

Workspaces
Only one theme can be active at a time, but it is recommended to apply
workspace colors and workspace custom themes when it is important for
your users to differentiate between workspaces.

• Workspace Color: Adds a colored strip just below the menu bar when
the workspace is selected. Uses the active theme.

• Workspace Custom Theme: Changes the theme entirely when the
workspace is selected.

Workspace Colors
Consider how much you want the workspace color to contrast against
the menu. More contrast will draw more attention, while less contrast
will draw less attention. More attention may be helpful for users that
cross workspaces, but may be distracting for users that never switch
workspaces. The goal is to strike a balance based on the needs of your
users.
The Highlight colors display cohesively with QAD Adaptive UX theme.
Use these highlight colors as workspace colors or come up with your
own.
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Translations
Newly created strings and translations can be saved as App Data or
Configuration Data. However, translation overrides can only be saved as
Configuration Data so that you can manage string translation overrides in
test and production environments and move them from one environment
to another, without having to go through QAD Cloud.

As an administrator, you can open Translations from the Development
folder > Translations.

You can click Edit to open the translation for the string code. On the Main
panel, you can view the string code, and on the Translations panel, you
can view translations in different languages for this string code. For quick
access to all translation details for installed and uninstalled languages,
click the link icon to the right to access the Translation Detail screen.

Notice that the translation has a warning message at the top of the form
since you cannot delete or update translations belonging to a namespace
that is not your active namespace. Also, App Data can only be maintained
in development environments.

Main
Prefix

A four-character code followed by a colon (:) used to ensure that
the string is unique and conflicts will not arise when your apps are
installed in different environments. The prefix is part of the string code
everywhere it is displayed in the system.

The prefix can have the following values:

◦ Blank — The string code is a QAD string created in the string
repository. This ensures backward compatibility.

◦ 0000 — The string code is not a QAD string, and the app is not
registered.

◦ {App Registration Code} — The string code is not a QAD string,
and the app is registered.

◦ CNFG — The string code is saved as Configuration Data.

If an app is registered after a string is created, the system updates the
prefix, string code, and all string references owned by an app. For any
other app that references any of those strings, each reference must be
manually updated in that app's system data files.

String Code

Enter a translation string code.
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Text

Shows the string code translation for the current user's language/
locale. If no translation exists, the string code is displayed.

Context

Enter the description of what the string code is used for.

Max Character Length

Enter the maximum allowable length for the translation text. The default
value is 255.

Saved To

Choose to save your translation string code to App Data or
Configuration Data:

◦ App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

◦ Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

See Configuration Data Overview on page 7014 for detailed
information.

App

The translation string code's app (disabled).

App URI

The translation string code's app URI (disabled).

Namespace

The environment namespace the record is created in if saved to App
Data (disabled). This field is blank if the string is saved to Configuration
Data.

Last Modified By

The user ID and user name of the person who last edited the record
(disabled). This field is blank if the string is saved to App Data.

Last Modified Date

The date and time when the record was last edited (disabled). For App
Data, this is the date the translation was installed in the environment or
updated if the app has been upgraded and the translation is different
than in previous app versions.
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Translations
The columns in the Translations grid vary depending on whether the
string is saved to Configuration Data or App Data. The following columns
are visible for App Data only: Namespace, Override, Text Override, and
Override Saved To.

Note that the Translations panel is hidden until the first save.

Locale

Select the translation locale from the list of locales (for installed
languages only).

Language

The language code associated with the selected locale (disabled).

Text

Enter the translation text for the language/locale.

Saved To

Indicates whether a translation is saved as Configuration Data or App
Data. Translations can only be saved as Configuration Data when a
string code is Configuration Data.

App

Indicates the app the translation is saved to.

Namespace

Indicates the environment namespace the translation is created in.

Override

Select the checkbox to enable the translation override.

Text Override

Enter the translation text to override the existing translation for a
language/locale.

Override Saved To

Indicates that all overrides are saved as Configuration Data.

Last Modified By

The user ID of the person who last overrode or edited the record
(disabled). This field is blank if the string is saved to App Data.

Name

The user name of the person who last edited the record (disabled).
This field is blank if the string is saved to App Data.
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Last Modified Date

The date and time when the record was last overridden or edited
(disabled). For App Data, this is the date the translation was installed
in the environment or updated if the app has been upgraded and the
translation is different than in previous app versions.

Translation Detail
Сlick the Details button on the Translations panel to open the Translation
Detail browse, where you can review all translation details for installed
and uninstalled languages. The Language Installed option indicates
whether the translation language is installed and in use in the system or if
it is not installed and is inactive.

When the translation is saved to Configuration Data, the Overrides panel
is hidden.

You can export the translation detail data to Excel by using the More
menu.
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Creating and Overriding Translations
See Creating New String Codes with Translations on page 6912

See Overriding Existing Translations on page 6912

Creating New String Codes with Translations
To add new string codes and their translations:

1. Open the Translations view from the menu search.
2. Click New to add a new string code.
3. Enter the string code and context.
4. Select to save the new string code as Configuration Data or App Data.
5. Click Save.
6. On the Translations panel, click New to add a translation for the

created string code.
7. Select the locale. Note that only one translation record per locale is

allowed.
8. In the Text field, enter the translation text.
9. Click Done. To add more translations to this string code, repeat steps

6-9.

Overriding Existing Translations
To override existing translations for string codes:

1. Open the Translations view from the menu search.
2. Find the string code for which you want to override the translation.
3. Click Edit.
4. On the Translations panel, select the translation you want to override,

and then click Edit.

The next step depends on whether string codes are saved as App
Data or Configuration Data:

◦ App Data — Select the Override checkbox, and then enter the
new translation in the Text Override field.

◦ Configuration Data — Enter the new translation directly in the Text
field. In this case, there is no need for overrides because you can
edit the translation text directly.

5. Click Done.
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Platform Development
With the QAD Enterprise Platform, you can create apps, data stores,
and business components that extend the system. You can then build
the hybrid views that provide a user interface screens for the business
components.

For more detailed information, see the QAD Enterprise Platform
Developer Guide.
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OpenEdge 12 Requirement
Moving to OpenEdge12, there is a need for Extension apps to be
compatible with OpenEdge12. There was a change in OpenEdge12 that
requires each Extension app to be packaged with the new OpenEdge12
structure.

For details on how to ensure compatibility with OpenEdge12, see the
QAD Enterprise Platform Developer Guide.
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Apps
An app brings together a group of related business components,
providing the context for some related activities. For example, QAD
provides a Sales app for sales-related activities. The Sales app includes
business components for Sales Quotes, Sales Orders, and more. With
the Apps view, you can create your own apps for your business needs.
You can then create the business components for the app, and then
the hybrid views that provide a user interface to the app's business
components.

App Registration
Apps that will be shared with others and included in environments with
other shared apps must be registered with QAD so that they have a
unique app registration code.

This unique app registration code is important because it provides the
prefix for any of the app's business component physical table names.
Note that QAD-provided coded business components do not require
registration.

Deciding to Register an App
Registering your app is highly recommended. Your app must be
registered if you want to publish your app in the QAD store. Registering
your app also ensures that your app will never conflict with other apps you
install in the future. Apps built only for internal testing or training purposes
do not necessarily need to be registered.

If after creating an app and its business components, you then decide the
app needs to be registered, you will need to run a YAB command. If you
are a cloud customer, you cannot directly access YAB, and so you will
need to enter a ticket for QAD to run the YAB command.

Therefore, for cloud customers, it’s best to decide in advance whether to
register the app.

When to Register an App
QAD strongly recommends that you register your app before creating and
deploying any business components in your app. Although it’s possible
to register your app later, doing so will require deleting any existing
data in your database tables, and then running a YAB command. QAD
cloud customers will then need to enter a ticket for QAD to run the YAB
command.

The following settings cannot be changed in production or test
environments. They can only be changed in development environments.

Main
App

Enter the app name. This represents the logical name of the app.
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App URI

The app URI is based on the environment namespace and the app
name.

The format of the URI is: urn.app.environment_namespace.app_name.

For example, if the environment namespace is "extensions"
and the app name is "myapp", the app URI will be:
urn.app.com.extensions.myapp".

App Label

Enter the display label for the app.

Description

Enter a brief description of the app.

Released

Indicate whether an app is released. Releasing an app cannot be
undone. Once you select and save this checkbox, both the Released
checkbox and the App Registration Code field become disabled.

App Registration Code

Click Register App to register your app with QAD. Apps that will be
shared with others and included in environments with other shared
apps must be registered with QAD so that they have a unique app
registration code. This unique app registration code is important
because it provides the prefix for any of the app's business component
physical table names. After registering your app, enter a 4-character
code from the QAD App Registration page in the App Registration
Code field here.

For more information about registering your apps, see Registering an
App on page 6918.

System Default

Indicates whether this app is system default. The system can have only
one active app for each user at a time. New system data is stored in
your active app.

In the My Developer Settings view, you can view and change your
active app.

App Dependencies
An app can have implicit or explicit dependencies on other apps. Any
implicit dependencies are listed automatically.
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If you know that the new app will be dependent on another app, you can
add that app here as an explicit dependency. For example, if the new
app extends the capabilities of an existing app, then you can identify that
existing app as an explicit app dependency by clicking +New, adding the
app, and setting Implicit to No.

Recalculate Formulas
After installing an app in an environment, all formulas are recalculated
for that app. If, for some reason, you want to force formula recalculation,
click the Recalculate button. This will recalculate formulas for all business
components related to this app.

Regenerate Extensions Proxies
Proxies are automatically generated for the whole app during the
deployment of one business component. If you want to generate proxies
for an app that was created before the Java Extension Framework (JEF)
was introduced, click the Regenerate button. For more information
about the Java Extension Framework, see the QAD Enterprise Platform
Developer Guide.

Package Apps
You can package an app under Apps > Actions > Package. For more
information about packaging an app, see the QAD Enterprise Platform
Developer Guide.

Major Version

The app major version. The default value is based on the last known
version.

Minor Version

The app minor version. The default value is based on the last known
version.

Patch Version

The patch version. The default value is based on the last known
version.

Build

The build number. The default value is based on the last known
version.

Version

Version is generated from the major, minor, patch version, and build.

Package

The package file name. The default format is [namespace]-[app]-
[version].
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When you click Submit, the system creates the app package in the
background. The results are sent to your Inbox. Since the output includes
a file, the Mini Inbox and Extended Inbox include the Download option to
download the file directly from the Inbox.

Registering an App
See Registering an App Before Business Component Deployment on
page 6918

See Registering an App After Business Component Deployment on page
6918

Registering an App Before Business Component Deployment
To register an app before there are deployed business components in the
app:

1. Open the Apps view from the menu search, and then open your app.
2. Click the Register App button next to the App Registration Code field.
3. On the QAD Store > Platform App Registration page, click the green +

Register App button, located in the upper-right corner of the page.
4. Enter the App URI of your application (copy and paste it from the

Apps view), a unique registration code of your choosing (four
characters, case insensitive), an optional description, and then click
Save.

The app registration code must start with a letter and can only contain
letters and numbers. Try to use a short but meaningful name for your
app registration code. For example, if your company’s stock is traded
on the market, consider starting with the ticker symbol representing
your company.

Note Before an app is released, you can change the app registration
code. However, when changing the app registration code, all business
component physical tables in this app are renamed, and all data in
those physical tables are deleted.

5. Go back to the Apps view in the application, and in the App
Registration Code field, enter the registered app code, and then click
Save.

Now, you can proceed with the app development. All business component
physical tables are prepended with the app registration code.

Registering an App After Business Component Deployment
• Check is there are any app’s business components in the Suspended

status. Before saving the app registration code, suspended business
components must be reverted to the Initial status by running the
Obsolete Schema Start YAB command: yab stop database-extension-
obsolete-schema start. Cloud customers need to enter a ticket to run the
YAB command.
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• The app registration process will delete any existing data in the
business component tables. For any data that needs to be saved,
export the data from those tables before continuing. Cloud customers
need to enter a ticket for QAD to export the data.

To register an app after there are deployed business components in the
app:

1. Open the Apps view from the menu search, and then open your app.
2. Click the Register App button next to the App Registration Code field.
3. On the QAD Store > Platform App Registration page, click the green +

Register App button, located in the upper-right corner of the page.
4. Enter the App URI of your application (copy and paste it from the

Apps view), a unique registration code of your choosing (four
characters, case insensitive), an optional description, and then click
Save.

The app registration code must start with a letter and can only contain
letters and numbers. Try to use a short but meaningful name for your
app registration code. For example, if your company’s stock is traded
on the market, consider starting with the ticker symbol representing
your company.

Note Before an app is released, you can change the app registration
code. However, when changing the app registration code, all business
component physical tables in this app are renamed, and all data in
those physical tables are deleted.

5. Go back to the Apps view in the application, and in the App
Registration Code field, enter the registered app code, and then click
Save.

6. In the confirmation message, click Continue.

Adding an app registration code requires the physical tables to be
renamed for all business components in the app. This process will:

◦ Suspend all deployed business components in the app until the
necessary YAB command is run.

◦ Require the App Registration Code YAB command to be run to
apply the new app registration code.

◦ Delete any existing data in the business component tables. For
any data that needs to be saved, export the data from those tables
before continuing.

7. Business components within the app are suspended, but the app
registration code is not yet applied. Now, the YAB command is
required. Run the App Registration Code YAB command: yab stop
database-extension-obsolete-schema start platform-systemcheck.
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As part of this YAB command, the app’s business components are
reverted to the Initial status, physical table names are updated, and
the business components are re-deployed. Cloud customers need to
enter a ticket to run the YAB command.

8. Optionally, load the exported data. Cloud customers need to enter a
ticket to load data.

Now, you can proceed with the app development. All business component
physical tables are prepended with the app registration code.
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My Developer Settings
These settings cannot be changed in production or test environments.
They can only be changed in development environments.

Active App
The active app contains all the business components and business
component relationships that the developer creates using the Business
Components view. This also applies to any other platform function that is
used to store system data (such as the Form Builder, any stored views, or
form layout changes using the Design Layout option).

Active App

The name of the currently active app for your development. From
the drop-down, choose Use System Default or Use Custom. For Use
Custom, select the available apps from the lookup. The lookup only
shows the Apps that are defined within the environment namespace.
Apps are defined using Apps view. New system data will be stored in
your active app.

Save new artifacts to Configuration Data as default

Select to save all new artifacts to Configuration Data as default in a
development environment. When you select this option, the Saved To
drop-down menus in the Web UI default to Configuration Data rather
than the App Data. You can still change it to App Data if required. See
Configuration Data Overview on page 7014 for detailed information.

Environment Namespace

Displays the value of the environment namespace. This is always read-
only, as it can only be specified using a YAB configuration.

App URI

Displays the App URI of the currently active app.
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Data Store
These settings cannot be changed in production or test environments.
They can only be changed in development environments.

Main
Data Store

The name of the data store.

Data Store URI

The Data Store URI, a unique identifier of the data store, will
automatically be displayed based on the entry in the Data Store field.

Description

A description of the data store.

Data Store Type

Indicates whether the data is stored as a Database or a File.

Mode

The mode of the data store: DEVELOPMENT or PRODUCTION.
Business components can be deployed only to data stores in
DEVELOPMENT mode.

Database
Database Type

The type of database (currently only Progress is supported).

Host

The database host name.

User Name

The database user name.

Database Name

The database name.

Port

The database port number.

Password

The password to access the database.
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App Seed Data
You can create the app seed data only for a Standard Platform Business
Component from the same app. The app seed data should be created for
each workspace/scope separately.

The App Seed Data screen is accessible from the Development menu. It
is available to users with either the Developer or QAD Admin roles.

The following settings cannot be changed in production or test
environments. They can only be changed in development environments.

Note When you make changes to the deployed business component, be
aware that these changes may conflict with a data snapshot. For more
information about the changes that may conflict with a data snapshot, see
the QAD Enterprise Platform Developer Guide.

Main
On this panel, you only need to complete the Business Component field.
Other fields are completed automatically.

Business Component

Select the business component that you want to use for your app
seed data creation. You can select only a Standard Platform Business
Component that belongs to the active app. The business component
must have the Deployed status.

Business Component URI

The URI of the business component.

Scope

The scope of the app seed data.

Scope Value

The scope value of the app seed data. It is always empty for the
System scope.

App

The name of the app to which the seed data belongs.

App URI

The URI of the app to which the seed data belongs.

Created

The date and time when the app seed data is initially created.

Created By

The user who initially created the app seed data.
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Last Modified

The date and time when the app seed data was last edited.

Last Modified By

The name of a user who last edited the app seed data.

Seed Data
The grid lists all the app seed data of the selected business component.

For the Domain scope, the app seed data will only be applied if the
Domain is already configured in a target environment.

Buttons

New

Create the app seed data. This opens the BC browse where you
can select a record. After selecting the record, the grid is filled in
automatically.

Delete

Delete the selected app seed data.

Mark for Snapshot Refresh

Mark a record for which the snapshot of data should be updated. It
will clear the Snapshot Created column. After saving, the snapshot of
data will be recreated according to the actual data for this record in the
business component table.

Preview Snapshot

After the data snapshot is stored as app seed data, you can preview
this data. It can be different than the data stored in the business
component table.

Grid

Identifier

The identifier of the app seed data record.

Action

The action that should be applied to the app seed data record during
app installation.

◦ Create — The record will be created in the target environment if it
does not exist.

◦ Create or Update — The record will be created in the target
environment if it does not exist or updated if it exists.

◦ Delete — The record in the target environment will be removed if
the record exists.
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Snapshot Created

The date and time when the data snapshot for the app seed data
record is created.

Created

The date and time when the app seed data is initially created.

Created By

The user who initially created the app seed data.

Last Modified

The date and time when the app seed data was last edited.

Last Modified By

The name of a user who last edited the app seed data.
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Business Components
A business component brings together the business logic and data
necessary to represent a business activity within the application. Users
interact with business components through the user interface's menu
items. These menu items are hybrid views, which combine a browse
grid with a form where you create and interact with data based on
the business logic. Typically, a hybrid view is based on one business
component, but can use more than one business component. For
example, the Address Types hybrid view is based on one business
component, but the Sales Orders hybrid view is based on several related
business components.

Business components provided by QAD (in the "com.qad" environment
namespace) cannot be modified. With the Business Components view,
you can create new business components that you can then edit and use
as part of your system.

You cannot delete the standard, QAD-provided business components
from the system. You can delete the business components that you have
created. A business component can be deleted when it is in the Initial
status. To delete a business component that is already deployed, its
status must be moved to Suspended, and then to Initial. Before moving
a business component to the Suspended status, you need to remove
all relationships, lookup relationships, formula fields with related fields,
and all KPIs, where the business component's browse is used as a
data source for a KPI. For more information about business component
statuses and deleting/editing a deployed business component, see the
QAD Enterprise Platform Developer Guide.

Main
Business Component

Enter the identifier of the business component. This identifier is used to
construct the Business Component URI. This field becomes read-only
after you first save it. This value should be unique within the current,
active app.

Business Component Type

Indicates the business component type: Standard or Action.

◦ Standard. The Standard business component provides everything
that is needed to allow creation, modification, fetching, and
deletion of the data (traditionally called the CRUD methods).

◦ Action (Service). The Action business component provides
methods that cover functionality outside the normal CRUD
operations.

The Action business component is created similarly to the Standard
business component, so the descriptions below apply to both business
component types. However, some panels and fields are specific to a

6926



Administration

certain business component type. For the differences of the Action
business component, see Platform Action Business Component.

Business Component Label

Enter the label name for this business component.

Physical Table

Enter the database table name where the records for this business
component will be saved. The app registration code is included as a
prefix for the business component physical table name. If there is no
app registration code, the field is blank.

For more information about the app registration codes, see Apps on
page 6915 and Registering an App on page 6918.

Description

Enter a description of the business component for informational
purposes.

Scope

Select the scope of the entity: Domain, Entity, Shared Set, or System.
By selecting the scope, the system will automatically validate the
existence of the appropriate scope field (respectively "DomainCode",
"EntityCode", or "SharedSetCode") in the business component when it
is saved.

When the Shared Set scope is selected, a drop-down list appears
containing the types of shared sets. Make sure to select the shared set
type correctly.

Status

The status of the business component. There are the following
statuses: Initial, Suspended, Deployed, Re-deploy, Released. For more
information about business component statuses and deleting/editing
a deployed business component, see the QAD Enterprise Platform
Developer Guide.

Business Component URI

The business component URI is generated automatically based on the
App URI and Business Component identifier.

Secure URI

The unique identifier of the Secure Resource that can be found in the
Role Permissions resource tree.

App

The name of the currently active app for your development.
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App URI

The App URI is set to the default app in the system, or the active app if
one is set for the current user, as specified in My Developer Settings.

Options
Embedded

Indicates whether a business component is either standalone or can
only be used as an extension of some other business component,
either as a One-to-one relationship or a Many-to-one relationship.

Business Document

Indicates whether a business document is enabled for this business
component. A business document is a collection of related business
components, mainly used for integration with the application. When this
option is activated, the Business Document panel is displayed.

Not Extensible

Indicates whether a business component is extensible. In the text
box, you can view the reason why the business component is not
extensible. Business components can be marked as not extensible to
support backwards compatibility management or keep the integrity of
business components and their surrounding functionality.

When a business component is not extensible, you cannot create
certain types of extensions, unless the environment is in the owning
namespace of the business component. For such restrictions, you can
see an error message—for example, “Relationships to not extensible
business components are not allowed.” To resolve the error, you can
select another business component or browse when applicable.

To view the list of all extension types disallowed for non-extensible
business components when the environment is not in the owning
namespace of the business component, see the QAD Enterprise
Platform Developer Guide.

Approvals

Indicates whether this business component is enabled for approvals.
When this option is activated, the Approvals panel appears on the
Business Components page, and the business component can then
be used in an approval process (using generic approvals). You can
configure the business component approval settings by using the
Configure button on the Approvals panel.

Control File

Indicates whether a business component is used to develop a menu-
level control screen. Control screens are used to store additional
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information that is not available in the system. They are also used to
set up and configure various settings related to customizations.

The Control File checkbox is only available for Standard business
components in the Initial status, not embedded. It's not available for
coded business components. You can create only one record of the
Control File Business Component per scope.

The Control File Business Component can have only one Primary Key
field.

Fields
The Fields grid lists all the fields of the business component.

The Import option supports loading from a file or a database. You can
import fields from an Excel (.xls or .xlsx) or comma-separated value (.csv)
file. The maximum file size is 5 MB. The first row in the sheet specifies the
field names, while the cells in the subsequent rows specify the data type
and format.

The Formula option allows you to include a formula for the currently
selected field. On the Formula panel, you can specify an Excel-style
formula for calculating the value of the field based on other fields. Click
Include Field to select fields, and click Include Operator to select
the Excel-style mathematical operations to apply to the fields. The
field's Formula column must be selected to indicate the field's value is
calculated based on a formula. Fields with Formula set to Yes can be
edited by clicking the Details button, which opens the Fields pop-up
window. Scroll down to the Formula panel.

Primary Key

Primary key fields must be specified in the proper numerical order.

Field

Enter the field name.

Field Label

Enter a display label. This will be used in the browses and views for
this new business component.

Physical Field

The name of the column in the corresponding database table for
business components created by importing from the database. (This
field is read-only.)

Formula

Indicate whether this field's value is calculated based on a formula
during runtime.
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Lookup

Indicates whether a lookup based on the lookup relationship is set up
for the field. You can set up a lookup relationship for this field in the
Field Details screen. When set to Yes, the field will have the magnifying
glass icon to open a pop-up window and select different options for the
field value. (This field is read-only.)

You can define which browse of the related business component will be
shown at runtime for the lookup by selecting the Lookup checkbox, and
then selecting a specific browse in the Browse field.

To create a drop-down list based on a lookup, select the Visualize as
Drop-Down List checkbox, and then select the value from the Field
Used For Label lookup. The values of this field will be displayed in the
drop-down list. If you leave the Field Used For Label lookup blank, it is
set to the field from Field Mapping > Related.

You cannot remove the lookup relationship, which is used in one or
more formula fields. First, you need to delete the field references from
the formula, where these fields are used.

Data Type

Select the data type: Character, Currency Amount, Date, Datetime,
Datetime-tz, Decimal, Drop Down, Integer, Integer (64-bit), Logical,
Percent, URL.

Drop Down has four types: Character, Integer, Integer (64-bit), and
Logical.

You can change the data type when the business component is in the
Deployed/Re-deploy status. For more detailed information, see the
QAD Enterprise Platform Developer Guide.

Length

For character fields, specify the maximum character length.

You can change the length of character fields when the business
component is in the Deployed status. For more detailed information,
see the QAD Enterprise Platform Developer Guide.

Format

Indicate the data format based on the data type.

Currency

You can configure rounding of decimal values based on the currency
settings. A business component field can have a data type of "Currency
Amount", and instead of defining a format, a currency field is selected.
Click the lookup icon and select a currency field from the current
business component. For this, you should add a field in the business
component to represent the currency.
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Drop-Down List

The drop-down list that you can assign to the field. Then, the field will
have a drop-down list where you can select the possible values for the
field values. This field is disabled for the Drop Down (Logical) data type
because it has the Yes/No values.

Default Value

Enter the default value.

Field Group

Displays the name of the field group to which this field is assigned. You
can assign a field to a field group using the Field Groups grid.

Minimum Value

Specifies the minimum value allowed for the field. This setting can be
applied to fields of all data types except the Character and Logical data
types.

Maximum Value

Specifies the maximum value allowed for the field. This setting can be
applied to fields of all data types except the Character and Logical data
types.

Description Field

Identifies a field as a description field, meaning it has an Associated
Code field. The Description Field enables the Associated Code field
and is just a helper field for Associated Code. These fields are added to
ensure all annotations in the business component dataset definition are
supported by the Business Components screen.

Associated Code

Description Fields are linked to their Associated Code fields. Field
security then will hide the Description Field in the resource tree, but its
access permissions will be inherited from the Associated Code field.
The Associated Code field is enabled only when the Description Field
is selected. It contains a lookup to the Fields browse to select a field.
The Associated Code field is added to ensure all annotations in the
business component dataset definition are supported by the Business
Components screen.

Required

Indicate whether this field is required.

Primary key fields are required, but you can make character primary
key fields not required if needed.

Read Only

Specifies whether the field value is read-only or can be changed by the
user.

6931



QAD Online Help

Hidden from Activity Tracking

Indicates whether the field is enabled for activity tracking.

Hidden from UI

Indicates whether the field is hidden from the views, form, drill downs,
alerts, lookup definitions, runtime, activity tracking, design layout, and
so on.

User Defined

Indicates whether the field is user-defined.

This field is only used for the legacy implementations in which one
or more fields in the physical table can be configured to hold data
specifically for the customer's implementation. For these fields specific
code is required on the back-end business logic implementation
to fetch and update the fields properly. For platform data driven
components this indication should always be "false", as the guideline
is to use the embedded business components together with a 1-1
business component relationship to bind it to the business component it
extends.

Deployed

Indicates whether this field is currently deployed. This is always read-
only.

Discriminator

Indicates whether the field will be used as a discriminator field. A
discriminator field is used only for embedded business components to
allow for extending several parent base business components in 1-1
relationships. This field must be primary key and will not be visible on a
form.

Dynamic Format

Indicates whether the field's format is dynamic. Dynamic formatting
means that one field's format is dynamically updated based on the
format setup for another field.

To set up dynamic formatting for a field, select the Dynamic Format
checkbox, and then select the dynamic source field from the lookup.

Dynamic Source Field

Select the source field that drives the dynamic behavior. You can use
one source field to format more than one target field. The dynamic
formatting has the following limitations:

◦ Primary key fields cannot be dynamically formatted.

◦ The field cannot be formatted by itself.
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◦ Dynamic formatting is not supported for fields with the following
data types: Date, Datetime, Datetime-tz, Logical, Currency
Amount, and Drop Down.

◦ The dynamic source field must be a field from the current business
component.

◦ The dynamic source field must have a Character data type.

◦ The dynamic source field cannot have a dynamic format.

Overrides

Indicates whether overrides exist for the business component field. For
more information about overrides, see Field Overrides on page 6946.

Recalculate Formulas
Adding a new formula field to already deployed business component
will un-deploy this business component and you will need to deploy
it manually again. If there are any existing records for this business
component when a new formula field is added, they are recalculated.
This is done automatically when you re-deploy that business component.
If you add this newly introduced formula field to the browse, the values
for this field may not appear there for some time (until the calculations
are finished). If, for some reason, you want to force formula fields
recalculation, click the Recalculate button.

Field Groups
Field Groups are a selection of fields that can be associated with access
rights of a role or roles.

New

Create a new field group.

Delete

Delete a field group.

Assign Fields

Assign fields to the current field group.

Field Group Code

Enter the name for the field group.

Display Label

Enter a label for the field group.

Drop-Down Lists
You can define a business component field as a Drop Down and set up
drill-down lists for the business component, which you can then assign to
a field.
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New

Enter a name for a new drop-down list. You can then assign this drop-
down list to the field.

Add Child

Add a child to a drop-down list and enter a value (database value) and
label (name that will be displayed in drop-down options) for it. To add
additional value and label to a drop-down list, click +New.

Delete

Delete a drop-down list.

More

Show Group By — Select a column header and group by that column.

Show Group By — Select a column header and group by that column.

Drop-Down Lists

Shows a list of drop-down lists available, which you can sort ascending,
descending, or filter as needed.

Indexes
You can set up extra indexes for platform business components (not
coded business components). A secondary index enables rapid sorting
and grouping by additional columns.

New

Define a new index.

Edit

Edit an existing index.

Delete

Delete a selected index.

Details

Enter further details about the index.

Index

Enter a name for the index. A primary index (called idx_PK) is
automatically generated when a business component is saved. When
a primary index is automatically generated, a description of "Primary
Index" is included (but is still editable).

Before the business component is deployed, the index status is "Not
Active - Deploy Required", and you can change the index Description,
Unique, and Order. After the deployment, you cannot edit the primary
key index.
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Description

Add a description for the index.

Unique

Specify whether this index is unique.

Status

This field is generated automatically. You can create a new index
before and after the deployment. After the deployment, you cannot
edit the existing indexes. All existing indexes related to a particular
business component table are activated during the first deployment.
If you create the index after the first deployment, it is created as
inactive. To activate such indexes, you will receive a notification and
will need to run the YAB command.

The following index statuses are available:

◦ Not Active - Deploy Required — The business component is not
yet deployed. The index can be deleted in this status.

◦ Not Active - YAB Command Required — The business component
is already deployed. After the business component deployment,
the index is created on the UI and saved. This is the stage where
you need to run the YAB command to activate the index in the
database.

◦ Active — The index is active. The business component is
deployed, and the index is created in the database and is
activated (through the business component deployment or by
running the YAB command).

Fields

Select fields for the index from the lookup.

Relationships
Use this grid to view and maintain the relationships of the business
component. You can add new relationships only after the first save of the
business component.

You cannot delete the relationship, which is used in one or more formula
fields. First, you need to delete the field references from the formula,
where these fields are used.

New

Define a new business component relationship.

Edit

Edit a business component relationship.
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Delete

Delete a business component relationship.

Details

Enter further details about the relationship.

Relationship

The relationship of this business component to the other business
component.

Relationship Label

The label for the business component relationship.

Source Business Component

Specifies the business component on which a relationship was created.

Related Business Component

The name of the business component to which the current business
component is related.

Relationship Type

It is always set to Child and cannot be changed.

Cardinality

Specifies the cardinality of the relationship: 1-1 or N-1.

This field is automatically populated based on the selection from the
Related Business Component lookup, which is based on comparing
primary keys of the Source and Related Business Components, which
take part in this relationship. For example, if the amount and datatypes
of primary key fields coincide, a system will propose 1-1 cardinality and
fill in the Field Mapping grid with corresponding primary keys. Still, the
developer can then modify the cardinality. If the developer modifies the
cardinality, the Field Mapping grid is filled in automatically only on the
1-side of relationships.

Composition Relation

Indicates whether this relationship is included in a business document.
The business document structure is defined by its composition
relations. When you clear the Composition Relation checkbox to
exclude a relationship, the relationship disappears from the Business
Document panel, not the Relationships panel. Be sure to carefully
review the relationships before excluding them from a business
document.

When you select the Cascade Delete checkbox, it means that if you
delete a parent component, its child components will also be deleted.
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Include Grid on Parent Form

Specifies whether a child business component grid (external) is added
to a parent business component form. When you select the Include
Grid on Parent Form checkbox under Relationships details, the grid
is automatically generated on a parent form, and the Edit Grid button
appears under Form, where you can edit this grid.

This functionality applies only to the Many-to-one (child-parent)
relationships (not embedded) and is available for both platform and
coded business components. If the grid is based on a coded business
component, additionally, you need to provide the grid's Data URI. To
enter the Data URI, close Relationships, navigate to the Form panel,
click Edit Grid, and then open the Grid Definition. Note that the parent
screen will not work until you add the Data URI.

When you select the Cascade Delete checkbox, it means that if you
delete a parent component, its child components will also be deleted.

Source App

Specifies the application to which the source business component
belongs.

Source App URI

Specifies the unique identifier of the app where the source business
component resides.

Related App

Specifies the app of the related business component.

Related App URI

Specifies the unique identifier of the related app.

Business Services
The Business Services panel lists all the business services associated
with the business component. Click New to define a new business
service or click Details to view and edit the details of an existing business
service. When you click New or Details, the Business Components -
Business Services pop-up window opens. Note that for coded business
components, the New, Edit, and Delete buttons are disabled.

Business Service Method

The name of the business service method.

REST API

Indicates whether the business service is exposed as a REST API.

REST URL Path

Indicates the REST API path to the business service.
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HTTP Method Type

Indicates the HTTP method: GET or POST.

Parameter Type

Indicates the parameter type for the request: QUERY or BODY.

Open API Documentation

Click to open the API documentation for the related business service
method.

Business Document
The Business Document panel appears only if it is activated on the
Main > Options panel. The business document structure is automatically
generated based on the existing relationships for the current business
component, and it can be viewed using a hierarchical grid. To have a
clear business document structure, you can associate only the relevant
relationships with your business document by using the Composition
Relation checkbox.

To create a business document:

• Create a relationship under Relationships. Note that you need to
create a business component relationship from a child if you want to
have a business document with parent and child.

• Make sure that the Composition Relation checkbox under
Relationships is selected.

• Enable a business document in Main > Options.

Excel integration (import and export) is available for most business
components (including embedded business components) and business
documents.

Business Document

Enter the name for this business document. By default, this field
displays the value from the Business Component field. The field is
enabled until the business document is released as part of an app
package.

Business Document Label

Enter the label for this business document. By default, this field
displays the value from the Business Component Label field.

Business Document Description

Enter a description of the business document.
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Business Document URI

The URI of the business document associated with this business
component. It reflects changes to the Business Document field when
created.

Browse URI

The default browse URI that is used when executing the query. The
default browse URI is initially set to the browse defined in the view for
the business component.

API URL

An address that allows you to access an API and its various features.

To view the API documentation, click the link icon located on the right
side of the view. Then, click the Business Document API Documentation
drill-down link to open the API documentation for the related business
document.

Business Document Variants
A business document variant represents a subset of a business
document, allowing users to customize or remove certain fields and
relations from the parent business document. The business document
variant is primarily used as a content type for business events.

For more information about business events and business document
variants, see the QAD Business Events User Guide in the QAD
Document Library.

Form
Existing Form

Indicates whether a form already exists for this view.

Build Form (or Edit Form)

Click to start building a new form or to edit an existing form. Click Build
Form or Edit Form to open the Build Form pop-up window.

The Build Form button is disabled until the business component is
saved for the first time.

Existing Grid

Indicates whether a grid already exists for a parent form. This option is
available when you select the Include Grid on Parent Form checkbox
under Relationships details.

Edit Grid

Click to open the Build Grid pop-up window and configure the grid that
will be added to the parent form.
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Event Handlers

Edit event handlers for the form. You can specify whether the event
handlers are active and the timing as Pre (run before any other
application TS handlers) or Post (run after any other application TS
handlers).

Browses
The Browses grid lists all the BC browses of the selected business
component. You can expand each browse record to view its extensions.
Click New to define a new browse or click Details to view and edit the
details of an existing browse. When you click New or Details, the Browses
pop-up window opens.

New

Define a new BC browse. This opens the detail form view for entering
further details.

Add Child

Select a BC browse in the grid, and then click Add Child to create a
new extension for this browse.

Edit

Modify an existing BC browse. This opens the detail form view for
entering further details.

Delete

Delete an existing BC browse.

Details

This opens the detail form view for entering further details.

Preview

This opens the preview of the currently selected browse. Select the
browse, and then click Preview. To preview the browse, you need to
deploy the business component first.

Name

The label for the BC browse.

Browse URI

The URI of the BC browse.

App

The app to which this BC browse belongs.

App URI

The URI of the app to which this BC browse belongs.
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Views

A comma-separated list of views where the BC browse is used. A
particular browse can be used by multiple views.

Views
The Views panel lists all the views created for the business component.
Click New to define a new view or click Details to view and edit the details
of an existing view. When you click New or Details, the Views pop-up
window opens.

Note that a form or a browse must be built before creating a view. If no
form or browse is created for a business component, the New button on
the Views panel is disabled.

View Label

The display label for the view.

Description

A short description for the view.

Type

Indicates the view type:

◦ Hybrid Browse — Includes a browse and a form. This option
is available if both a form and a browse exist in the business
component.

◦ Browse Only — Only includes a browse without a form. This
option is available if a browse exists in the business component.

◦ Form Only — Only includes a form without a browse. This option
is available if a form exists in the business component.

Eligible for Menu

Indicates whether this view will be available on the menu (and menu
search).

App

The name of the app associated with the view.

App URI

The URI of the app associated with the view.

View URI

The URI of the view.

Browse URI

The browse URI associated with the browse added to the view (either
Hybrid Browse or Browse Only). The Browse URI column is empty for
the Form Only view type.
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Secure URI

The URI for security and menu linking.

Default

Indicates the default view for the browse.

Java Extensions
The Java Extensions panel lists all the Java extensions of the selected
business component. It provides a read-only view of Java extension
details, such as methods, apps, and related metadata. For more
information about the Java Extension Framework, see the QAD
Enterprise Platform Developer Guide.

The panel is updated automatically based on the selected business
component.

Method

The name of the extended method.

App

The app to which this Java extension belongs.

App URI

The URI of the app to which this Java extension belongs.

Version

The version of the app with this Java extension.

Deployment
Deployment of a business component is a process of verifying if
everything is available and correctly defined for the business component,
this includes having available view and view resources.

Data Store URI

The URI of the data store that stores the schema and the data of the
business component.

After the business component is deployed for the first time, this field
becomes read-only: the Data Store URI cannot be changed.

Import Data

Deprecated.

Deploy

Click Deploy to deploy the business component.

Generate Missing Records

In development environments only, after clicking the Deploy button
for the 1-1 embedded business component, the system generates a
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maximum of 1000 records for the 1-1 embedded business component
based on a parent table. If the number of records exceeds 1000, you
need to generate the rest of the records by clicking the Generate
Missing Records button. If you do not generate missing records, you
can run into issues with formula fields and other functionality that
include the extension fields. When you click the Generate Missing
Records button, the missing extension records are generated in the
background. After all missing extension records are generated, refresh
the screen. You can see that the Generate Missing Records button
disappears and the Deploy button is visible but disabled.

You might need to cancel the missing record generation if the record
generation takes too long, is blocked, or if you decide to revert to initial
and delete the embedded business component relationship. To cancel
the record generation, click the Cancel Missing Record Generation
button.

For Test and Production environments, all extension records are
generated automatically.

6943



QAD Online Help

Business Components - Action
You can start defining a business service using Platform. A platform
business service is a method definition with REST API and the ability
to write Java Extensions for it. For more information about the Java
Extension Framework, see the QAD Enterprise Platform Developer
Guide.

First, you need to create your own Platform Action Business Component
and Platform Business Service, and then develop Java low-code
customizations for them.

You can also create and configure your own Platform Individual Actions
for the Views:

• To create and configure actions for your custom view, use the Views >
Actions panel.

• To create and configure actions for a standard view (such as
Customers or Purchase Orders), use the Views > Extension Actions
panel.

For examples of using Individual Actions and Java Extensions
opportunities, see the QAD Enterprise Platform Developer Guide.

Introduction
You can create a business component of type "Action" to use it for browse
actions and/or REST APIs.

The Action business component is created similarly to the Standard
business component. You can find the panel and field descriptions under
Business Components on page 6926 and its subsections. However, some
panels and fields are specific to a certain business component type. For
the differences of the Action business component, see descriptions below.

The following items do not apply to the Action business component in
comparison with the Standard business component.

Main
The Action business component does not have a database table,
and business component fields do not have a physical name and
corresponding database columns.

• No physical table

• No business documents

• No approvals

• The Embedded checkbox is disabled

Fields
It is possible to add new fields to the Action business component, which
will change the status of the business component to Re-deploy.
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• No Physical Field column

• No formulas (and no Recalculate Formulas panel)

• No lookup relationships (disabled)

• The Hidden from Activity Tracking checkbox is selected and disabled

• No fields import from a database (Data Source Type is always "File")

• No indexes

Views
It is not required to have a form and a view for the Action business
component. If needed, you can create a form in the same way as for the
Standard business component. A view is always of type "Form Only",
is not "Eligible for Menu", and has limited configuration options. It is not
a standalone view and is used for individual actions as a part of other
views.

• The view type is always "Form Only"

• The Eligible for Menu checkbox is clear and disabled

• No "Allow New" and "Allow Delete" options

• No Form panel

• No Vertical Menu panel

Deployment
The Action business component can be deployed (logical deployment, no
database table is created). If the Action business component is reverted
to the Initial status, the Suspended status is not applicable.

• No Data Store URI

• No Import Data

Other
• No BC relationships

• No BC browses

• No activity tracking
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Business Components - Field Overrides
There are system-wide and domain property overrides.

Field Override Logic:

• The original business component settings are applied.

• If business component system overrides exist, then system overrides
are applied.

• If business component domain overrides exist, then domain overrides
are applied.

• If TypeScript for the field default value or required setting logic exists,
then the TypeScript logic is applied.

Overrides
Changes to these properties affect all layouts for this business
component.

Parent Business Component

For embedded business components only, shows the parent business
component to which the field overrides are applied.

Embedded business components can have multiple parent business
components. You can create and manage field overrides for each
parent business component related to the embedded business
component. When there are multiple parent business components,
select the required business component from the drop-down list.

For embedded business components, you can view the Overrides
panel only after creating relationships.

System Property Overrides
Field property overrides are created individually. First, enable the override
by selecting the related checkbox, and then you can set your override
value.

Field Label Override

Select the checkbox to enable the override and specify the system-
wide Field Label override.

Required Override

Select the checkbox to enable the override and select the system-wide
Required setting override. When you mark a field as required as an
override, you also need to provide the Default Value Override.

If a field is marked as required on the Business Component, the field
will be required and cannot be overridden.
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Default Value Override

Select the checkbox to enable the override and specify the system-
wide Default Value setting override. When creating new records, the
default value entered here will be used.

If the field type is Date/Datetime/Datetime-tz, the toggle icon appears.
Click the toggle icon to switch between a literal value and a variable
value (Today, Tomorrow, Yesterday).

Length Override

Select the checkbox to enable the override and specify the system-
wide Length override. This override can only be created for UDFs of
certain field types.

Format Override

Select the checkbox to enable the override and specify the system-
wide Format override. This override can only be created for UDFs of
certain field types.

Saved To

System overrides are always saved as configuration data.

Remarks

Provide the information about why the system overrides are created.

Last Modified By

The ID and name of the user who last edited the system overrides.

Last Modified Date

The date the system overrides were last edited.

Domain Property Overrides
Business components with the Domain scope provide domain field
overrides for the Default Value and Required settings. This allows you
to define different field property behaviors for specific domains. Like
system overrides, domain override records are created individually for
each domain property (Required/Default Value). Domain overrides take
precedence over system overrides.

On the Domain Property Overrides panel, click New to add a new domain
override.

Domain

The domain the overrides apply to.

Description

The selected domain description.
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Override

Select the checkbox to enable the domain Required setting override.

Required

The Required setting override for the domain. When you mark a field
as required as an override, you also need to provide the Default Value
override.

Override

Select the checkbox to enable the domain Default Value setting
override.

Default Value

The Default Value setting override for the domain. When creating new
records in the specified domain, the default value entered here will be
used. The entered default value is treated as a literal value.

Toggle

Date fields (Date, Datetime, Datetime-tz) support both literal default
values and variable default values. If the field type is Date/Datetime/
Datetime-tz, you can click the toggle icon to switch between a literal
value and a variable value (Today, Tomorrow, Yesterday).

Saved To

Domain overrides are always saved as configuration data.

Remarks

Provide the information about why the domain overrides are created.

Last Modified By

The ID of the user who last edited the domain overrides.

Name

The name of the user who last edited the domain overrides.

Last Modified Date

The date the domain overrides were last edited.

Creating Overrides from Business Component
See Creating System Field Overrides from Business Component on page
6948

See Creating Domain Field Overrides from Business Component on page
6949

Creating System Field Overrides from Business Component
To create system field overrides from a business component:

1. Open Business Components from the menu search.
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2. Find the business component for which you want to create overrides.
3. Open the Fields panel, and then select the field for which you want to

create overrides.
4. Click Details and navigate to the Overrides panel > System Property

Overrides.
5. Select the Field Label Override checkbox and set a new label.
6. Select the Required Override checkbox and make the field required.
7. Select the Default Value Override checkbox and put any default value.
8. Select the Length Override checkbox and set the number of

characters this field can contain.
9. Select the Format Override checkbox and set the required value. This

property defines the length of the UI element. A field with format x(3)
will be shorter, and a field with format x(20) will be longer on the UI.

10. Add remarks.
11. Click OK to save your data.
12. Check your system field overrides at runtime: at runtime, open your

business component with created overrides, add a new record, and
see the field with created overrides.

Creating Domain Field Overrides from Business Component
You can create domain overrides if your business component has the
Domain scope.

To create domain field overrides from a business component:

1. Open Business Components from the menu search.
2. Find the business component for which you want to create overrides.
3. Open the Fields panel, and then select the field for which you want to

create overrides.
4. Click Details and navigate to the Overrides panel > Domain

Property Overrides.
5. Click +New.
6. Select the 11CAN domain, for example.
7. Select the first Override checkbox to make the field required.
8. Select the second Override checkbox and set a default value.
9. Add remarks.
10. Click OK to save all changes.
11. Check your domain field overrides at runtime: change the domain

to 11CAN, at runtime, open your business component with created
overrides, add a new record, and see the field with created overrides.
In our case, it should be required and contain the appropriate default
value.
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Creating Overrides from Design Layout
See Creating System Field Overrides from Design Layout on page 6950

See Creating Domain Field Overrides from Design Layout on page 6950

Creating System Field Overrides from Design Layout
Create a custom design layout with the System Wide layout context.
Ensure the design layout is active.

To create system field overrides from a design layout:

1. Open the design layout.
2. Select the UDF for which you want to create overrides, and then click

Manage Overrides on the right.
3. Navigate to the Overrides panel > System Property Overrides.
4. Select the Field Label Override checkbox and set a new label.
5. Select the Required Override checkbox and make the field required.
6. Select the Default Value Override checkbox and put any default value.
7. Select the Length Override checkbox and set the number of

characters this field can contain.
8. Select the Format Override checkbox and set the required value. This

property defines the length of the UI element. A field with format x(3)
will be shorter, and a field with format x(20) will be longer on the UI.

9. Add remarks.
10. Click Save. Pay attention that a UDF is displayed with overridden

properties in the Design Layout form and in the Business Component
Properties section to the right.

11. Close the design layout.
12. Check your system field overrides at runtime: open your view from

the menu search, add a new record, and see the field with created
overrides.

Creating Domain Field Overrides from Design Layout
Create a custom design layout with the Domain layout context. Ensure
the design layout is active.

To create domain field overrides from a design layout:

1. Open the design layout.
2. Select the field for which you want to create overrides, and then click

Manage Overrides on the right.
3. Navigate to the Overrides panel > Domain Property Overrides.
4. Click +New.
5. Select the 11CAN domain, for example.
6. Select the first Override checkbox to make the field required.
7. Select the second Override checkbox and set a default value.

6950



Administration

8. Add remarks.
9. Click Save.
10. Close the design layout.
11. Check your domain field overrides at runtime: change the domain to

11CAN, open your view from the menu search, add a new record, and
see the field with created overrides. In our case, it should be required
and contain the appropriate default value. You will not see the domain
overrides if the domain workspace differs from the domain for which
overrides are created.
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Business Components - Business Services
Business services are non-CRUD methods that are exposed as REST
APIs.

From Business Components > Business Services, you can define
platform business services associated with the business component. A
platform business service is always created in the business component's
app.

The settings below cannot be changed in production or test environments.
They can only be changed in development environments.

Main
Business Service Method

Enter the name of the business service method. This value should be
unique within the business component.

Business Service Label

Enter the label name for this business service.

Description

Enter a description of the business service for informational purposes.

REST API

Indicates whether the business service is exposed as a REST API.

Service URI

The business service URI is generated automatically.

Secure URI

The URI for security and menu linking.

App

The name of the app associated with the business service.

App URI

The URI of the app associated with the business service.

Parameters
Sequence

Specify the sequence of the parameters in a method signature.
The number increments automatically as you add parameters. The
parameter order must be sequential starting from 1. You can also edit
the parameter sequence manually.

Parameter Mode

Select parameter mode: INPUT or OUTPUT.
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Parameter Data Type

Select the data type of the parameter: Character, Dataset, Date,
Datetime, Datetime-tz, Decimal, Integer, Integer (64-bit), and Logical.

Business Component URI

The URI of the business component. It is applicable only if the
Parameter Data Type is Dataset.

Parameter Name

Enter the name of the parameter.

Description

Enter a description of the parameter.

REST API
The REST API panel appears only if it is activated on the Main panel of a
business service.

REST URL Path

Indicates the REST API path to the business service.

HTTP Method Type

Select the HTTP method: GET or POST.

Parameter Type

Indicates the parameter type for the request: Query or Body.

Note If you use a Platform Action Business Component from your app as
a schema for a Business Service Parameter, it may affect the business
service. For more information about changes that may affect a business
service, see the QAD Enterprise Platform Developer Guide.
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Business Components - Build Form
Set Layout Properties
App

Specifies the app for this view.

Business Component

Specifies the business component for this view.

Linked View

Click Select Linked View to open the Business Component Views
dialog and select the view to which to link the form. The selected linked
view will provide Drill Downs, Activity, and Attachments for the form.

Allow Drill Downs on Form

Indicates whether contextual drill downs are enabled for the form
(Hybrids, Standalone Forms, and Individual Actions). When enabled,
linked view drill downs appear on the Drill-Down Links panel on the
right when you click in the form.

Allow Activity on Form

Indicates whether contextual activity is enabled for the form (Hybrids,
Standalone Forms, and Individual Actions). When enabled, linked view
activity appears on the Activity panel on the right when you click in the
form. This option is activated only when you select the Activity Panel
checkbox on the Main panel under Views.

Allow Attachments on Form

Indicates whether contextual attachments are enabled for the form
(Hybrids, Standalone Forms, and Individual Actions). When enabled,
linked view attachments appear on the Attachments panel on the
right when you click in the form. This option is activated only when
you select the Attachments Panel checkbox on the Main panel under
Views.

Include Summary Panel

Specifies whether to include the Summary Panel in the layout.

Select drop-down
From the drop-down (initially named <select>), you can select an element
currently on the form and view its details, which are displayed in a box
below the drop-down option.

Panels
Element Name

Specifies the identifier for the panel.
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Panel Label

Specifies the label for the panel's name. Use the lookup to open the
Labels pop-up window and select an existing label.

Columns

Indicates the number of field columns in the panel (set to 2).

Buttons
Element Name

Specifies the identifier for the button.

Button Label

Specifies the display label for the button. Use the lookup to select an
existing label from the Labels pop-up window.

Width

Specifies the width of the button in pixels; currently, the width adjusts
automatically and the setting is "auto".

Alignment

Specifies the alignment for a button within a cell. The following options
are available:

◦ Left — Left aligns a button in a cell.

◦ Right — Right aligns a button in a cell.

◦ Center — Center aligns a button in a cell.

Margin Left

Specifies the margin area on the left side of a button. The default value
is "auto".

Margin Right

Specifies the margin area on the right side of a button. The default
value is "auto".

State

Specifies whether the button is enabled or disabled.

Column Span

Specifies the number of columns that contain the button (set to 1).

Row Span

Specifies the number of rows that contain the button (set to 1).

Labels
Element Name

Specifies the identifier for the label.
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Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Width

Specifies the width of the label in pixels; currently, the width adjusts
automatically and the setting is "auto".

Alignment

Specifies the alignment for a label within a cell. The following options
are available:

◦ Left — Left aligns a label in a cell.

◦ Right — Right aligns a label in a cell.

◦ Center — Center aligns a label in a cell.

Margin Left

Specifies the margin area on the left side of a label. The default value
is "auto".

Margin Right

Specifies the margin area on the right side of a label. The default value
is "auto".

Column Span

Specifies the number of columns that contain the label (set to 1).

Row Span

Specifies the number of rows that contain the label. Select from 1 to 50.

Grids
Detail Table

Specifies the detail (data) table for the grid.

Element Name

Specifies the identifier for the grid.

Width

Indicates the width of the grid. This is set to auto: the grid automatically
uses the area provided by the panel in which the grid is located.

Max Display Lines

Specifies the maximum number of grid lines to display.

Allow New

Specifies whether the New button is displayed for the grid, which allows
users to add new lines.
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Allow Select (Internal grids only)

Specifies whether the user can select lines in the grid.

Allow Edit

Specifies whether the Edit button is displayed for the grid, which allows
users to edit lines.

Allow Delete

Specifies whether the Delete button is displayed for the grid, which
allows users to delete lines.

Add Child Grid

Click to open the Grid Definition pop-up window, where you can specify
a child grid.

Grid Columns
In Build Form, when you click a grid column header, the column's
properties are listed on the right-hand panel.

Similar to the properties for fields, the column properties are organized
into the Business Component Properties and the Form Layout Properties.
The Business Component Properties for a given column are the same
as the properties for fields because the columns consist of business
component fields, but displayed in columns. The Form Layout Properties
are also similar to the properties for fields, but include settings for
behavior such as column sort order and a way to configure column styling
for the use of color and icons.

Business Component Properties

Business component properties apply everywhere the field is used.

Field

Indicates the identifier for the field.

Display Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Business Component

Indicates the field's business component.

Detail Table

Indicates the detail table for the field.

Physical Field

Indicates the physical field identifier, based on the detail table and
identifier for the field. This is useful for distinguishing between fields
that might have similar identifiers and labels.
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Max Characters

Indicates the maximum number of characters allowed for the field's
data.

Format

Indicates the data format for the field. For example, a checkbox has the
Yes/No format, while a field of up to 80 characters has the x(80) format.

Default Value

Specifies the default value for the field.

Required

Specifies whether the field is required.

Form Layout Properties

Element Name

Indicates the element identifier for the field.

Control Type

Specifies the control the field uses for accepting and displaying data.
For example, a checkbox field has the CheckBox control type, and a
text string field has the TextEditor control type.

Field Label

Specifies the display label for the column field. The field label override
logic is as follows:

◦ The original Business Component Label is applied.

◦ If Form Builder Display Property overrides exist for the label, then
Form Builder Display Property overrides are applied.

◦ If Business Component Field Overrides exist for the label, then
Business Component Field Overrides are applied.

◦ If Design Layout Display Property overrides exist for the label,
then Design Layout Display Property overrides are applied.

Width

Indicates the width available for the column's data.

State

Specifies whether the field is Enabled, Disabled, or Read Only.

Sort

Specifies the default sorting for the column as None, Ascending,
Descending, or Disabled.
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Sort Order

Specifies the column's order for sorting, relative to other columns.
Select 1, 2, 3, or 4.

Conditional Styling

Specifies whether conditional styling is applied to the column's display
of data. Click the gear icon to open Grid Conditional Styling and
configure the conditional styling.

Column Highlighting

Provides the ability to highlight grid columns. You can select from the
following highlight options: None, Yellow, Teal, Purple, or Gray.

Treelist Grids
A treelist grid allows you to display form grid data as a tree, a grid, or a
combination of both and update the tree.

Detail Table

Specifies the detail (data) table for the treelist grid.

Element Name

Specifies the identifier for the treelist grid.

Width

Indicates the width of the treelist grid. This is set to auto: the treelist
grid automatically uses the area provided by the panel in which the
treelist grid is located.

Max Display Lines

Specifies the maximum number of treelist grid lines to display.

Allow New

Specifies whether the New button is displayed for the treelist grid,
which allows users to add new lines.

Allow Select (Internal grids only)

Specifies whether the user can select lines in the treelist grid.

Allow Edit

Specifies whether the Edit button is displayed for the treelist grid, which
allows users to edit lines.

Allow Delete

Specifies whether the Delete button is displayed for the treelist grid,
which allows users to delete lines.

Allow Drag & Drop

Specifies whether the Drag & Drop button is displayed for the treelist
grid, which allows users to change the node order and hierarchy. It

6959



QAD Online Help

always reflects the setting from the Grid Definition pop-up window and
is disabled here.

Allow Excel Export

Specifies whether the Export option is included in the treelist grid's
More button, which allows users to export the treelist grid content to
Excel. The export adheres to any user filters on the treelist grid and will
export across pages.

+Child

Allows users to add a child row to the row, where +Child is clicked.

Groups
Note that these settings pertain to a group of fields organized in a grid-
like display within a panel. The term "grid" can sometimes be used in
this context, but here it refers to the grid-like layout of the group of fields,
rather than form data grids, which offer a browse-like display of data.

Element Name

Specifies the identifier for the field grid.

Columns

Specifies the number of columns in the group. From the drop-down,
choose from 1 to 9.

Click the gear icon to configure the columns. In the Configure Columns
pop-up window, specify the number of columns from the Columns drop-
down (from 1 to 9), and then the Column Width Type and Value for
each column. The Column Width Type can be one of the following:
Auto size, Percentage, or Pixel; the Value is then set accordingly for
the selected type.

Note Pixel column widths can be overridden by fields that require
more width to display content.

Rows

Specifies the number of rows in the group.

Column Span

Specifies the number of columns spanned by the group. (Set to 1.)

Row Span

Specifies the number of rows spanned by the field grid (group). Select
from 1 to 50.

Custom
Element Name

Specifies the identifier for the custom element.
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Display Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Column Span

Specifies the number of columns spanned by the custom element. (Set
to 1.)

Row Span

Specifies the number of rows spanned by the custom element. Select
from 1 to 50.

Fields
Business Component Properties

Business component properties apply everywhere the field is used.

Field

Indicates the identifier for the field

Display Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Business Component

Indicates the field's business component.

Detail Table

Indicates the detail table for the field.

Physical Field

Indicates the physical field identifier, based on the detail table and
identifier for the field. This is useful for distinguishing between fields
that might have similar identifiers and labels.

Max Characters

Indicates the maximum number of characters allowed for the field's
data.

Format

Indicates the data format for the field. For example, a checkbox has the
Yes/No format, while a field of up to 80 characters has the x(80) format.

Default Value

Specifies the default value for the field.

Required

Specifies whether the field is required. On the form, required fields
include the gold bar along the left side of the field value box.
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Form Layout Properties

Element Name

Indicates the element identifier for the field.

Control Type

Specifies the control the field uses for accepting and displaying data.
For example, a checkbox field has the CheckBox control type.

Field Label

Specifies the display label for the field. This label will be used on the
user interface, such as on form fields and browse columns. The field
label override logic is as follows:

◦ The original Business Component Label is applied.

◦ If Form Builder Display Property overrides exist for the label, then
Form Builder Display Property overrides are applied.

◦ If Business Component Field Overrides exist for the label, then
Business Component Field Overrides are applied.

◦ If Design Layout Display Property overrides exist for the label,
then Design Layout Display Property overrides are applied.

Input Width

Indicates the width available for the field's data input.

Input Height

Indicates the height available for the field's data input.

Label Visibility

Indicates whether the label is Visible, Hidden, or None.

◦ Visible — When selected, the label displays as usual (default).

◦ Hidden — When selected, the label is hidden but the label width is
still accounted for.

◦ None — When selected, the label is removed and the label width
is no longer accounted for. The Label Width field is hidden when
this option is selected.

Label Width

Indicates the width available for the field's display label. This field is
hidden when the None option under Label Visibility is selected.

State

Specifies whether the field is Enabled, Disabled, or Read Only.
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Lookup Visibility

Specifies whether the field lookup is Visible or Hidden. This property
does not impact the browse search. For the new key fields, the lookup
visibility is set to Hidden.

Column Span

Specifies how many columns the field occupies (1 or 2).

Row Span

Specifies the number of rows the field occupies (from 1 to 50).

Add to Layout
From the Add to Layout panel, you can choose user interface elements to
add to the form you are building.

Select Show Unused Only to have the Add to Layout panel only show
elements that are not currently used on the form. While you are building
a form, this option can help to make the panel easier to navigate and can
prevent you from inadvertently adding the same element (such as a field)
more than once on the same form.

Select from UI Elements or Fields to add elements to the form.

UI Elements include:

• Panel

• Button

• Label

• Grid

• Group

• Custom

Under UI Elements, you can click an element, and then drag it to the form
area, placing it where you would like the element on the form.

Fields include:

• Default — These fields are business component fields or field groups
and you cannot edit or delete them after deployment. These fields are
located on the Business Component page.

Suggestions — You can add fields from related business components
to a form. These fields are disabled by default. If fields from the
business component are used in any view metadata, they display
under the Suggestions section.
+More — The button displays to add additional fields from the
business component that do not display in the Suggestions section.
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• UI-Only Field — You can drag and drop this field when building a form
if you need a new field or when you cannot edit some of the Default
fields.

The listed fields are organized by field groups, including User Defined
Fields, which are listed last.

Field Properties
Field properties include Business Component Properties and Form
Layout Properties.

Form Builder - Grid Definition
Main
Detail Table

Indicates the business component data table for the grid. Click Select
to open the Detail Grids pop-up window for selecting a data table. Note
that the Select button is not available when you access this window
from Business Components - Edit Grid.

JSON Path

For an internal grid, the JSON path to the top level of the data to bind
to the grid. Note: If you are converting a Java View Controller, this
value can be taken directly from setRecordListFieldName(). In the view
resource metadata, this is the value of <RecordListFieldName>.

For an external grid, specifies parameters for grids that display
data that is external to the form's business component (single-
row edit grids). In the view resource metadata, this is the value of
<ExternalGridParameters>.

Data URI

Indicates the URI for data based on the business component detail
table.

Linked View

For an internal grid, select the view that will provide Drill Downs,
Insights, Activity, and Attachments for the grid.

For an external grid, select the view that will open from the Details
button and provide Drill Downs, Insights, Activity, and Attachments for
the grid.

Unique ID (Only for a Treelist Grid)

Indicates the name of the field, which is a singular unique ID per row.
Treelist Grid requires a singular unique ID to link a child row to a
parent.
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Parent ID (Only for a Treelist Grid)

Indicates the name of the field, which data value is a unique ID of its
parent. To link parents to children, one singular unique ID and parent ID
are used.

Options
Data Selection

Provides the ability to select a single cell or a row in a grid.

For an internal grid, creating and deleting records is not supported with
cell selection.

For an external grid, editing, creating, and deleting records is not
supported with cell selection.

Allow Activity on Grid

Indicates whether contextual activity is enabled for the grid. When
enabled, linked view activity appears on the Activity panel on the right
when you click in the grid. This option is activated only when you select
the Activity Panel checkbox on the Vertical Menu panel under Views.

Allow Drill Downs on Grid

Indicates whether contextual drill downs are enabled for the grid. When
enabled, linked view drill downs appear on the Drill-Down Links panel
on the right when you click in the grid.

Allow Attachments on Grid

Indicates whether contextual attachments are enabled for the grid.
When enabled, linked view attachments appear on the Attachments
panel on the right when you click in the grid. This option is activated
only when you select the Attachments Panel checkbox on the Vertical
Menu panel under Views.

Allow Insights on Grid

Indicates whether contextual insights are enabled for the grid. When
enabled, linked view insights appear on the Insights panel on the right
when you click in the grid.

Allow Drag & Drop (Only for a Treelist Grid)

Indicates whether the Drag & Drop button is displayed for the treelist
grid, which allows users to change the node order and hierarchy. When
enabled, you can select from the following options:

◦ Hierarchy Only — Drag & Drop allows you to change the level
hierarchy. You cannot reorder rows within the same level.
Changes will be saved automatically for users.

◦ Hierarchy & Sibling Order (Internal grids only) — Drag & Drop
allows you to change the level hierarchy and reorder rows within
the same level. Users will need to click the Save button to save
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the changes. When this option is selected, a Sequence ID Field is
required.

Sequence ID Field (Internal grids only)

If Hierarchy & Sibling Order is selected, a Sequence ID Field is
required. This is the name of the field in the dataset that holds an
integer to store the sequence of sibling rows.

Field Mapping
Child Key Field

Indicates the child key field for a given column.

Parent Key Field

Indicates the parent key field for a given column.

Columns
+Select

Brings up a lookup with all related business component fields. This
allows you to select fields from up to two levels of relationships.

Select

Indicates whether the column is displayed in the grid.

Field

The field identifier.

Label

The field display label for the field, displayed in the grid column header.

Required

Indicates whether data is required.

Form Builder - Conditional Styling
Styles
Style Type

Choose the type of styling as Background Color or Icon.

The grid displays any currently specified styles. Click New to add a new
style, Edit to modify an existing style, or Delete to remove a style.

Condition

The condition being applied.

Preview

Shows a preview of the applied condition.

6966



Administration

Background Color Styles
When you click New with Background Color selected (or Edit an existing
style for background color), the Conditional Styles - Styles pop-up window
opens, where you can specify conditions for styling the background color
for the field's column.

Conditions
In Conditions, for the current field's column, you can specify conditions
using any of the fields on the grid. You can specify multiple conditions for
the current field's column by clicking the + icon (and remove a condition
by clicking the x icon), in the same way that you specify browse search
conditions.

Field

From the drop-down listing the available fields for the grid, select a field
that you want to use to create a condition.

Operator

From the drop-down, choose:

◦ equals

◦ greater than

◦ greater or equal to

◦ is not null, is null

◦ less than

◦ less or equal to

◦ contains

◦ starts with

◦ ends with

◦ does not equal

◦ range

In the adjacent two fields, enter the value(s) for the conditions.

Use the + and x icons to add or remove conditions.

Style
Style Type

Set to Background Color.

Color

Select from the following colors: Blue, Green, Magenta, Orange,
Purple, Red, Turquoise, or Yellow.
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Icon Styles
When you click New with Icon selected (or Edit an existing style for an
icon), the Conditional Styles - Styles pop-up window opens, where you
can specify conditions for styling the icon for the field's column.

Conditions
In Conditions, for the current field's column, you can specify conditions
using any of the fields on the grid. You can specify multiple conditions for
the current field's column by clicking the + icon (and remove a condition
by clicking the x icon), in the same way that you specify browse search
conditions.

Field

From the drop-down listing the available fields for the grid, select a field
that you want to use to create a condition.

Operator

From the drop-down, choose:

◦ equals

◦ greater than

◦ greater or equal to

◦ is not null, is null

◦ less than

◦ less or equal to

◦ contains

◦ starts with

◦ ends with

◦ does not equal

◦ range

In the adjacent two fields, enter the value(s) for the conditions.

Use the + and x icons to add or remove conditions.

Style
Style Type

Set to Icon.

Icon

Click Select to open the Select Icon pop-up window that offers many
icons to use.
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Icon Color

Select from the following colors: Blue, Green, Grey, Magenta, Orange,
Purple, Red, Turquoise, or Yellow.

Form Builder - Event Handlers
Main
Active

Indicates whether the event handler is active and will be executed at
runtime.

Timing

Select the event handler type. There are three types of event handlers:

◦ Primary — primary event handler for the corresponding business
component. DB value: PRIMARY.

◦ Pre — runs before the existing application code (TS handler). DB
value: BEFORE.

◦ Post — runs after the existing application code (TS handler). DB
value: AFTER.

Applies To

Indicates whether the TS code applies to Web or Mobile App. The
default value is Web.

App

Indicates the app name and URI in which the event handler will be
created (that is, the current, active app) or is already created.

TypeScript

The code that will be compiled into JavaScript and executed at runtime.
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Business Components - Edit Grid
Set Layout Properties
App

Specifies the app for this grid.

Business Component

Specifies the business component for this grid.

Select drop-down
From the drop-down (initially named <select>), you can select an element
and view its details, which are displayed in a box below the drop-down
option.

Panels
Element Name

Specifies the identifier for the panel.

Panel Label

Specifies the label for the panel's name. Use the lookup to open the
Labels pop-up window and select an existing label.

Columns

Indicates the number of field columns in the panel (set to 1).

Grids
Detail Table

Specifies the detail (data) table for the grid.

Element Name

Specifies the identifier for the grid.

Width

Indicates the width of the grid. This is set to auto: the grid automatically
uses the area provided by the panel in which the grid is located.

Max Display Lines

Specifies the maximum number of grid lines to display.

Allow New

Specifies whether the New button is displayed for the grid, which allows
users to add new lines.

Allow Edit

Specifies whether the Edit button is displayed for the grid, which allows
users to edit lines.
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Allow Delete

Specifies whether the Delete button is displayed for the grid, which
allows users to delete lines.

Grid Columns
In Build Grid, when you click a grid column header, the column properties
are listed on the right-hand panel. The column properties are organized
into the Business Component Properties and the Form Layout Properties.

Business Component Properties

Business component properties apply everywhere the field is used.

Field

Indicates the identifier for the field.

Display Label

Specifies the display label.

Business Component

Indicates the field's business component.

Detail Table

Indicates the detail table for the field.

Physical Field

Indicates the physical field identifier, based on the detail table and
identifier for the field. This is useful for distinguishing between fields
that might have similar identifiers and labels.

Max Characters

Indicates the maximum number of characters allowed for the field's
data.

Format

Indicates the data format for the field. For example, a checkbox has the
Yes/No format, while a field of up to 80 characters has the x(80) format.

Default Value

Specifies the default value for the field.

Required

Specifies whether the field is required.

Form Layout Properties

Element Name

Indicates the element identifier for the field.
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Control Type

Specifies the control the field uses for accepting and displaying data.
For example, a checkbox field has the CheckBox control type, and a
text string field has the TextEditor control type.

Width

Indicates the width available for the column's data.

State

Specifies whether the field is Enabled, Disabled, or Read-only.

Sort

Specifies the default sorting for the column as None, Ascending,
Descending, or Disabled.

Sort Order

Specifies the column's order for sorting, relative to other columns.

Conditional Styling

Specifies whether conditional styling is applied to the column's display
of data. Click the gear icon to open Grid Conditional Styling and
configure the conditional styling.

Column Highlighting

Provides the ability to highlight grid columns. You can select from the
following highlight options: None, Yellow, Teal, Purple, or Gray.

Labels
Element Name

Specifies the identifier for the label.

Label

Specifies the display label. Use the lookup to select an existing label
from the Labels pop-up window.

Width

Specifies the width of the label in pixels; currently, the width adjusts
automatically and the setting is "auto".

Alignment

Specifies the alignment for a label within a cell. The following options
are available:

◦ Left — Left aligns a label in a cell.

◦ Right — Right aligns a label in a cell.

◦ Center — Center aligns a label in a cell.
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Margin Left

Specifies the margin area on the left side of a label. The default value
is "auto".

Margin Right

Specifies the margin area on the right side of a label. The default value
is "auto".

Column Span

Specifies the number of columns that contain the label (set to 1).

Row Span

Specifies the number of rows that contain the label. Select from 1 to 50.

Add to Layout
From the Add to Layout panel, you can add labels to the grid you are
editing.

Under UI Elements, you can click an element, and then drag it to the grid
area, placing it where you would like the element on the grid.
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Business Components - Browses
Use the Browses panel to configure a business component browse. A
browse must be built before creating a Hybrid Browse or Browse Only
view.

A particular browse can be used by multiple views.

Main
Browse Label

The label to display for the BC browse.

Type

Select the browse type:

◦ Browse — A browse with fields from the existing business
components.

◦ Custom Browse — A browse with fields from a custom (external)
data source.

The descriptions below are for the Browse type. For details on the
Custom Browse type, see Browses - Custom Browses on page 6982.

Browse URI

The URI of the BC browse.

Description

A short description for the browse.

View Browse Query

Provides visibility into the SQL query used to execute the business
component browse so that you can better understand how the
browse is defined and work with end users to explain the browse
data displayed and clarify the end users' data expectations. This field
is displayed only if the Business Component Browse checkbox is
selected. When you click the View Browse Query button, the Browse
Query pop-up window opens with the SQL statement. Only the fields
that are selected in the browse's Columns grid are included in the
query statement. JOIN appears if you create a business component
browse with related fields.

◦ Inner Join — Only includes records where the joined fields from
tables are equal.
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◦ Left Outer Join — Includes all records from the left table and only
those records from the right table where the fields are equal.

Browse query is in read-only mode. It is provided only for the
visualization of the SQL and is not intended for entering the SQL
manually.

You can copy the SQL query and run it from other applications to see
the result table.

App

Indicates the app to which this BC browse belongs.

App URI

Indicates the URI of the app to which this BC browse belongs.

Fields
The grid lists the browse columns, initially including all the business
component fields, which are added to the Form. If there is no Form,
initially only the primary keys are displayed. For optimal performance,
select 50 or fewer columns. When the browse is run, only the first 20
columns appear by default. Additional columns will be hidden.

You can remove columns by clearing the checkbox for each
corresponding field. New additional fields can be added by using the
+Select button.

+Select

Add browse columns from the current or related business components.
You can also add browse columns from the coded extensions (EBE).
When you click the +Select button, the Select Relationship pop-
up window opens. When you expand the relationship, it shows the
relationships up to four levels. You can select the relationship you
need, click Continue, and then in the Select Fields pop-up window, add
columns/fields from this relationship.

You can add the [Exists] column to a business component browse
indicating whether or not one or more records from a related table
exist. For example, while on the customer browse, indicate whether
sales orders exist for that customer. The field name is "Exists for
(relationship name)", but you can edit it. It is a logical field.

New Conditional Field

Add a new conditional column to the BC browse. Conditional columns
display data based on conditions. Click New Conditional Field, and
then set the values on the Main panel if needed. Leave the fields blank
to default from the first condition.

On the Conditions panel, click New to open the Select Relationship
pop-up window to first select a relationship, and then select a field from
that relationship. After you add the first field to the Conditions grid, the
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Fields lookup to select additional fields is filtered by the data type of the
first field. All conditions must use the same data type. Also, you cannot
use the same relationship for multiple conditions.

In the Order column, the number increments automatically as you add
conditions. The condition order must be sequential starting from 1. You
can also edit the condition order manually.

Edit Conditional Field

Opens the Edit Conditional Field pop-up window where you can modify
an existing conditional field of the BC browse.

Configure Joins

When adding fields to a BC browse from a related business
component, you can change the join type: Left Outer or Inner. The
default value is Left Outer. Clicking the Configure Joins button opens a
pop-up window with a Browse Relationships grid to configure the join
types for each unique relationship path from the browse. The joins are
based on the BC relationships (relationships between two business
components).

◦ An inner join only shows rows if there is a matching record on the
other (right) side of the join.

◦ A left outer join shows rows for each record on the left-hand side,
even if there are no matching rows on the other (right) side of the
join. If there is no matching row, the columns for the other (right)
side show NULLs.

You can view the configured joins in the Browse > View Browse Query
pop-up window.

The Configure Joins button is disabled if there are no fields from
relationships included in the browse.

Select

If the checkbox is clear, the field is completely removed from the
browse—from the columns and from the search, and it is not returned
in JSON result.

Field

The code that identifies the browse field.

Field Label

The label name for this field. The label defaults from the business
component field label, but you can edit it to create a browse-specific
field label. It is useful when there are fields with the same label (from
different relationships). To revert a field's label back to its business
component field label, blank out the label. If the label is edited in the
design layout, you cannot change it here. The label provided in the
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design layout takes precedence over the browse-specific property or
business component properties.

Display Label

The display label for this field.

Physical Field

The name of the column in the corresponding database table.

Sortable

Specifies whether the browse column is sortable. Each field marked as
sortable in a browse definition has a sort indicator. For a high-volume
browse (based on a high-volume table), all fields are not sortable,
except for the primary key fields. Otherwise, all fields are sortable.
The Sortable column is always disabled and is visible for informational
purposes only.

Some tables have lots of records, and performance on these browses
can be slow. For such high-volume tables, the following search and
sort restrictions are applied to the browse to avoid potentially bad sort
performance:

◦ Sorting is restricted to a single column at a time. Multi-column
sorting is not available.

◦ Fields are only sortable if the field is the first or second field in a
DB index.

◦ The quick search is only allowed on sortable fields, except
when the quick search is set by a stored view. The quick search
normally applies to the first searchable column in the browse. If
the first column is not sortable, then the quick search is switched
to the first sortable column. If there are no sortable fields in the
browse, then the quick search will remain with the first column.

Conditional

Specifies whether the browse column is conditional.

Hidden from Columns

If the checkbox is selected, the field is available on the search panel
and hidden from the UI (browse columns and configure columns gear).
The field is still available in JSON, which is important when the field is
required from technical reasons.

Hidden from Search

If the checkbox is selected, the field is removed from the search
criteria, but it is available in the browse columns. The field is still

6977



QAD Online Help

available in JSON, which is important when the field is required from
technical reasons.

If Hidden from UI is selected under Business Component > Fields,
the Hidden from Columns and Hidden from Search checkboxes are
selected and disabled.

Business Component

Specifies the business component the field belongs to.

Detail Table

Specifies the detail table the field belongs to.

Relationship Path

Specifies the relationship path for a field.

Column Order
By default, the browse column order is based on the order of appearance
of the fields on the form. However, depending on your requirements, the
first field that displays on the form might not be the best choice for the first
column in the browse (and so on).

Click Configure to preview and configure the browse column order. In the
Configure Column Order pop-up window, you can drag and drop columns
to configure the column order.

Initial Sort
It provides the ability to set the initial (default) sorting for a business
component browse as well as the order and direction of that sorting.

Note The Hidden from Columns fields are not available for default sorting.

If a stored view is applied, the sorting of the stored view takes precedence
over the default sorting.

Field

Opens a lookup to a Sortable Fields browse with all sortable BC
browse fields and their index information, if any. In the Sortable Fields
browse, fields are grouped by indexes. Only index fields from active
indexes are available here.

Display Label

Specifies the business component field's display label. (This field is
read-only.)

Order

Specifies the field sorting order in the browse. The field sorting order is
unique and must be consecutive.

Direction

Specifies whether the field sorting is ascending or descending.
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Warning

Provides a warning when you select a field that may cause
performance degradation. For example, fields that are not indexed can
lead to performance degradation.

Business Component

Specifies the business component the field belongs to. (This field is
read-only.)

Physical Table

Specifies the physical table the field belongs to. (This field is read-only.)

Relationship Path

Specifies the relationship path for a field. (This field is read-only.)

Predefined Search Criteria
It provides the ability to define complex filter logic for views by using AND
and OR operators, as well as hide browse filters so that they are not
exposed to the users.

You must first save the browse before updating the predefined search
criteria. The predefined search criteria are disabled until you save the
browse. Note that you cannot remove the browse columns that are used
in the predefined search criteria.

For example, you can add the following predefined search criteria:
"Opportunity.Owner equals Current User". Click Include Field to select
fields, click Include Operator to select an operator to apply to the field,
and click Include Variable to select a date variable, and so on. Note
that Fiscal Date Variables are available if Fiscal Calendar is installed in
the system. Click Check Syntax to validate the syntax of your search
criteria. The added search filter is visible in the advanced search under
the Predefined Criteria menu if enabled.

Show in Advanced Search

Specifies whether the predefined search criteria are visible to the users
in the advanced search.

Extensions
It provides the ability to extend existing BC browses shipped by QAD with
additional fields as well as change some properties of the browse fields.

The grid lists the extensions for a business component browse. You can
add, modify, or delete browse extensions using the Browse Extensions
pop-up window; see Browses - Browse Extensions.

You can also make a browse extension active or inactive (for example,
for your organization's purposes or in case of performance impact); see
Browse Extension Scope Context.
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Name

The name for this browse extension.

Browse Extension URI

The browse extension's URI.

App

The app where the browse extension is stored.

App URI

The browse extension's app URI.

Event Handlers
It provides the ability to create and manage your own event handlers for
a BC browse. An event handler is a TypeScript code that is compiled
into JavaScript and executed at runtime. You can use event handlers to
change/extend the UI of a BC browse.

The grid lists the event handlers for a business component browse.
You can add, modify, or delete browse event handlers using the Event
Handlers pop-up window. You can also specify whether the event
handlers are active and the timing. For the TypeScript code examples,
see the QAD Enterprise Platform Developer Guide.

This functionality follows the same pattern used for the Business
Component Form.

Timing

The event handler type. There are three types of event handlers:

◦ Primary — A primary event handler for the corresponding BC
browse. It is stored in the app to which this BC browse belongs.

◦ Pre — Runs before primary event handlers. It is stored in the app
other than the app of this BC browse.

◦ Post — Runs after primary event handlers. It is stored in the app
other than the app of this BC browse.

Active

Indicates whether the event handler is active and will be executed at
runtime.

Applies To

Indicates whether the TS code applies to Web or Mobile App. The
default value is Web.

App

The app name in which the event handler is created (that is, the
current, active app).
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App URI

The app URI in which the event handler is created (that is, the current,
active app).

SQL Views
It provides the ability to generate SQL views that map the logical data
model to the physical database schema. This approach allows you to
access data efficiently using standard JDBC queries and SQL views with
logical field names, eliminating complex querying in the APIs.

All SQL views have the same query as the parent BC browse.

You can see all SQL views in the system from a separate page, called
SQL Views, which you can access from the menu search.

For more information about limitations and creating SQL views, see the
QAD Enterprise Platform Developer Guide.

Buttons

New

Define a new SQL view. This opens the detail form view for
entering further details. You can only edit the SQL View Name field.
The maximum length is 27 symbols. Other fields are completed
automatically.

The app registration code is included as a prefix for the SQL view
name. This field is disabled and shows the app registration code of
the app to which this SQL view belongs. If there is no app registration
code, the field is blank. For more information about the app registration
codes, see App Registration.

If an app has a registration code, the SQL view name is  <app
registration code>_<sql view name>.

Delete

Delete the selected SQL view.

Recreate SQL View

Click this button to recreate the SQL view for the selected row after
making changes.

Grid

Name

The label for the SQL view.

SQL View URI

The URI of the SQL view metadata.
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App

The app name in which the SQL view is created (that is, the current,
active app).

App URI

The app URI in which the SQL view is created (that is, the current,
active app).

Exists

Indicates whether the SQL view is created in the database.

Browses - Custom Browses
On the Browses panel, you can configure a custom browse. A custom
browse supports external data sources such as REST APIs and others.
You can create a custom browse, from Business Components > Browses
> New, and then select the Type = Custom Browse. When the Custom
Browse option is selected, the browse function will not use the business
component data. Instead, the data must be supplied via a backend
implementation using a Java Extension. Note that you need to deploy the
custom browse implementation.

A custom browse is created similarly to a BC browse. It also has a parent
BC to which it belongs. However, the following items do not apply to a
custom browse in comparison with the BC browse:

• No View Browse Query

• No Predefined Search Criteria

• No Conditional Fields

• No [Exists] fields

• No Blob type fields

• No Configure Joins on the Fields panel

• No Browse Extensions

• No SQL Views

For more information about creating a custom browse with Java
Extension Framework, see the QAD Enterprise Platform Developer
Guide.

Main
Browse Label

The label to display for the custom browse.

Type

Select the Custom Browse type.
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Browse URI

The URI of the custom browse.

Description

A short description for the custom browse.

App

Indicates the app to which this custom browse belongs.

App URI

Indicates the URI of the app to which this custom browse belongs.

Code File

Indicates the deployment status of the implementation code:
Undeployed or Deployed. This field appears after saving the custom
browse.

Fields
The grid lists the browse columns, initially including all the business
component fields, which are added to the Form. If there is no Form,
initially only the primary keys are displayed. For optimal performance,
select 50 or fewer columns. When the browse is run, only the first 20
columns appear by default. Additional columns will be hidden.

You can remove columns by clearing the checkbox for each
corresponding field. New additional fields can be added by using the
+Select button and the New Custom Field button.

+Select

Add browse columns from the current or related business components.
You can also add browse columns from the coded extensions (EBE).
When you click the +Select button, the Select Relationship pop-
up window opens. When you expand the relationship, it shows the
relationships up to four levels. You can select the relationship you
need, click Continue, and then in the Select Fields pop-up window, add
columns/fields from this relationship.

You can select all fields from the business component (not only
physical fields).

New Custom Field

Add a new custom column to the BC browse. Click New Custom Field,
and then set the values on the Main panel. The Field should have a
unique name within the parent browse. The following Data Types are
available: Character, Date, Datetime, Datetime-tz, Integer, Integer (64-
bit), Decimal, and Logical.
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Edit Custom Field

Opens the Edit Custom Field pop-up window where you can modify an
existing custom field of the custom browse.

Select

If the checkbox is clear, the field is completely removed from the
browse—from the columns and from the search, and it is not returned
in JSON result.

Field

The code that identifies the browse field.

Field Label

The label name for this field.

Display Label

The display label for this field.

Sortable

Specifies whether the browse column is sortable. Each field marked as
sortable in a browse definition has a sort indicator.

Custom

Specifies whether the browse column is custom.

Hidden from Columns

If the checkbox is selected, the field is available on the search panel
and hidden from the UI (browse columns and configure columns gear).
The field is still available in JSON, which is important when the field is
required from technical reasons.

Hidden from Search

If the checkbox is selected, the field is removed from the search
criteria, but it is available in the browse columns. The field is still
available in JSON, which is important when the field is required from
technical reasons.

If Hidden from UI is selected under Business Component > Fields,
the Hidden from Columns and Hidden from Search checkboxes are
selected and disabled.

Business Component

Specifies the business component the field belongs to.

Detail Table

Specifies the detail table the field belongs to.

Relationship Path

Specifies the relationship path for a field.
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Column Order
By default, the browse column order is based on the order of appearance
of the fields on the form. However, depending on your requirements, the
first field that displays on the form might not be the best choice for the first
column in the browse (and so on).

Click Configure to preview and configure the browse column order. In the
Configure Column Order pop-up window, you can drag and drop columns
to configure the column order.

Initial Sort
It provides the ability to set the initial (default) sorting for a business
component browse as well as the order and direction of that sorting.

Note The Hidden from Columns fields are not available for default sorting.

If a stored view is applied, the sorting of the stored view takes precedence
over the default sorting.

Field

Opens a lookup to a Sortable Fields browse with all sortable BC
browse fields and their index information, if any. In the Sortable Fields
browse, fields are grouped by indexes. Only index fields from active
indexes are available here.

Display Label

Specifies the business component field's display label. (This field is
read-only.)

Order

Specifies the field sorting order in the browse. The field sorting order is
unique and must be consecutive.

Direction

Specifies whether the field sorting is ascending or descending.

Warning

Provides a warning when you select a field that may cause
performance degradation. For example, fields that are not indexed can
lead to performance degradation.

Business Component

Specifies the business component the field belongs to. (This field is
read-only.)

Physical Table

Specifies the physical table the field belongs to. (This field is read-only.)

Relationship Path

Specifies the relationship path for a field. (This field is read-only.)
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Event Handlers
It provides the ability to create and manage your own event handlers for
a custom browse. An event handler is a TypeScript code that is compiled
into JavaScript and executed at runtime. You can use event handlers to
change/extend the UI of a custom browse.

The grid lists the event handlers for a custom browse. You can add,
modify, or delete browse event handlers using the Event Handlers pop-up
window. You can also specify whether the event handlers are active and
the timing. For the TypeScript code examples, see the QAD Enterprise
Platform Developer Guide.

This functionality follows the same pattern used for the Business
Component Form.

Timing

The event handler type. There are three types of event handlers:

◦ Primary — A primary event handler for the corresponding custom
browse. It is stored in the app to which this custom browse
belongs.

◦ Pre — Runs before primary event handlers. It is stored in the app
other than the app of this custom browse.

◦ Post — Runs after primary event handlers. It is stored in the app
other than the app of this custom browse.

Active

Indicates whether the event handler is active and will be executed at
runtime.

Applies To

Indicates whether the TS code applies to Web or Mobile App. The
default value is Web.

App

The app name in which the event handler is created (that is, the
current, active app).

App URI

The app URI in which the event handler is created (that is, the current,
active app).

Browses - Browse Extensions
You can extend existing BC browses provided by QAD with additional
fields, without copying a browse. For example, if you want to add a
column to a browse, you do not need to create a new browse, you can
just extend the existing browse.
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You can also make a browse extension active or inactive by using the
Scope Context.

The browse extension is applied to the parent BC browse at runtime.
When you open the BC browse, you can view the original fields as
defined in the browse and the browse extension fields as defined in the
extension configuration.

Main
Name

Enter the name for this browse extension.

Browse Extension URI

The browse extension's URI. The system generates the extension URI,
and it is unique within the browse.

Description

Enter a description of the browse extension.

App

The app where the browse extension is stored.

App URI

The browse extension's app URI.

Fields
The grid lists the fields to extend the BC browse. For optimal
performance, select up to 50 fields in total (meaning both the browse and
its extension fields). When the browse is run, only the first 20 columns
appear by default. Additional columns will be hidden.

You can remove columns by clearing the checkbox for each
corresponding field. New additional fields can be added by using the
+Select button.

After adding a field to the Fields grid, you can change its properties, in
particular: Field Label, Hidden from Columns, and Hidden from Search.

+Select

Add browse columns from the current or related business components.
You can also add browse columns from the coded extensions (EBE).
When you click the +Select button, the Select Relationship pop-
up window opens. When you expand the relationship, it shows the
relationships up to four levels. You can select the relationship you
need, click Continue, and then in the Select Fields pop-up window, add
columns/fields from this relationship.

You can add the [Exists] column to a business component browse
indicating whether or not one or more records from a related table
exist. For example, while on the customer browse, indicate whether
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sales orders exist for that customer. The field name is "Exists for
(relationship name)", but you can edit it. It is a logical field.

New Conditional Field

Add a new conditional column to the BC browse. Conditional columns
display data based on conditions. Click New Conditional Field, and
then set the values on the Main panel if needed. Leave the fields blank
to default from the first condition.

On the Conditions panel, click New to open the Select Relationship
pop-up window to first select a relationship, and then select a field from
that relationship. After you add the first field to the Conditions grid, the
Fields lookup to select additional fields is filtered by the data type of the
first field. All conditions must use the same data type. Also, you cannot
use the same relationship for multiple conditions.

In the Order column, the number increments automatically as you add
conditions. The condition order must be sequential starting from 1. You
can also edit the condition order manually.

Edit Conditional Field

Opens the Edit Conditional Field pop-up window where you can modify
an existing conditional field of the BC browse.

Select

If the checkbox is clear, the field is completely removed from the
browse—from the columns and from the search, and it is not returned
in JSON result.

Field

The code that identifies the browse field.

Field Label

The label name for this field. The label defaults from the business
component field label, but you can edit it to create a browse-specific
field label. It is useful when there are fields with the same label (from
different relationships). To revert a field's label back to its business
component field label, blank out the label. If the label is edited in the
design layout, you cannot change it here. The label provided in the
design layout takes precedence over the browse-specific property or
business component properties.

Display Label

The display label for this field.

Physical Field

The name of the column in the corresponding database table.
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Sortable

Specifies whether the browse column is sortable. Each field marked as
sortable in a browse definition has a sort indicator. For a high-volume
browse (based on a high-volume table), all fields are not sortable,
except for the primary key fields. Otherwise, all fields are sortable.
The Sortable column is always disabled and is visible for informational
purposes only.

Some tables have lots of records, and performance on these browses
can be slow. For such high-volume tables, the following search and
sort restrictions are applied to the browse to avoid potentially bad sort
performance:

◦ Sorting is restricted to a single column at a time. Multi-column
sorting is not available.

◦ Fields are only sortable if the field is the first or second field in a
DB index.

◦ The quick search is only allowed on sortable fields, except
when the quick search is set by a stored view. The quick search
normally applies to the first searchable column in the browse. If
the first column is not sortable, then the quick search is switched
to the first sortable column. If there are no sortable fields in the
browse, then the quick search will remain with the first column.

Conditional

Specifies whether the browse column is conditional.

Hidden from Columns

If the checkbox is selected, the field is available on the search panel
and hidden from the UI (browse columns and configure columns gear).
The field is still available in JSON, which is important when the field is
required from technical reasons.

Hidden from Search

If the checkbox is selected, the field is removed from the search
criteria, but it is available in the browse columns. The field is still
available in JSON, which is important when the field is required from
technical reasons.

If Hidden from UI is selected under Business Component > Fields,
the Hidden from Columns and Hidden from Search checkboxes are
selected and disabled.

Business Component

Specifies the business component the field belongs to.

Detail Table

Specifies the detail table the field belongs to.
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Relationship Path

Specifies the relationship path for a field.

Scope Context
It provides the ability to configure the scope for the browse extension.
This means that you can configure when the browse extension is applied
to the browse. At first, the Scope Context grid is blank, and the extension
is inactive to avoid potential conflicts. Click Manage to define the desired
scope for activating the browse extension. Note that you need to save the
browse extension to be able to add the scope context.

The Scope Context grid is read-only. To add, delete, or edit the scope
configuration, click Manage to open the Browse Extension Scope Context
pop-up window; see Browse Extension Scope Context.

Active

Indicates whether a browse extension is enabled for the specified
scope.

Scope Type

The type of scope for the browse extension.

Scope Value

The list of domains or entities for the corresponding scope type.

Browse Extension Scope Context
Use Browse Extension Scope Context to configure the scope for the
browse extension. This means that you can configure when the browse
extension is applied to the browse.

As a developer, you can access this screen from Business Components
> Browses > Extensions > Scope Context > Manage. As an administrator,
you have a separate page to manage the scope context (called Browse
Extension Scope Context), and you can access it from the menu search.

In the Browse Extension Scope Context screen, you can add, delete, and
edit the scope configuration, as well as activate the browse extension.

The following scope types are available:

• System — An extension is applied across all domains (system-wide).
The System scope type has the highest priority.

• Domain — An extension is applied to the domains, which are
specified in the Scope Value column.

• Entity — An extension is applied to the entities, which are specified in
the Scope Value column.
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Activating the Browse Extension
The System scope type has the highest priority and is used to enable or
disable a browse extension for the whole app.

• An extension is activated across all domains if the System scope is
set as Active.

• An extension is deactivated across all domains if the System scope is
set as Not Active.

• Otherwise, the Domain and Entity scope records are applied as
described in the diagram below.

Scope context validation:

• Only one record with a System type (active or not) is allowed.

• Only one element for the specified domain or entity is allowed.

Resolving Conflicts
When you configure the scope context for the browse extension, conflicts
may occur. Сonflicts occur between different extensions (1) as well as
between extensions and the original browse (2). Information about the
conflicting extensions is recorded in log files, and you can see a warning
message about the conflict. At runtime, all conflicting extensions are
ignored.

If conflicts occur, you need to resolve them manually in this Browse
Extension Scope Context screen (also accessed from the Artifact
Conflicts screen).

Note that conflicts occur only for extensions with the same scope
context or when the contexts cross each other: an entity inside a domain
(for example, a context for the 10USA Domain and a context for the
10USACO Entity will cause a conflict).

For more information about conflicts, see the QAD Enterprise Platform
Developer Guide.

Main
The fields are read-only. If you access the Browse Extension Scope
Context page from the menu search (as an administrator), you need to
complete the Browse Extension URI field when creating a record. Select
the browse extension from the lookup.

Name

The name for this browse extension.

Browse Extension URI

The browse extension's URI. The system generates the extension URI,
and it is unique within the browse.
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Browse Extension App

The app where the browse extension is stored.

Browse Extension App URI

The browse extension's app URI.

Browse Name

The name of this extension's BC browse.

Browse URI

The URI of this extension's BC browse.

Browse App

The app to which this extension's BC browse belongs.

Browse App URI

The URI for the app to which this extension's BC browse belongs.

Scope Context
Click New to add a new scope context for your browse extension.

Active

Indicates whether a browse extension is enabled for the specified
scope.

Scope Type

Choose the type of scope for the browse extension. The following types
are available: System, Domain, and Entity. This field becomes read-
only after you first save it.

Scope Value

Click the lookup icon and select the domains or entities for the
corresponding scope type.
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Business Components - Views
Depending on the view type you want to create, a form, a browse, or a
form and a browse must be built before creating a View:

• Hybrid Browse — Create a form and a browse.

• Browse Only — Create only a browse.

• Form Only — Create only a form.

For embedded business components with Many-to-one relationships, the
Views screen is limited to configuring drill downs only.

For Action business components, the Views screen has limited
configuration options and is always "Form Only". For the differences of
the view for the Action business component, see Business Components -
Action.

Main
View Label

The label to display for the view.

Type

Select the view type: Hybrid Browse (includes a browse and a form),
Browse Only (only includes a browse), or Form Only (only includes a
form). Note that the Type field becomes disabled after you first save it.

The business component's Hybrid Browse view includes the following
panels:

◦ Main

◦ Browse

◦ Form

◦ Vertical Menu

The business component's Browse Only view includes the following
panels:

◦ Main

◦ Browse

◦ Vertical Menu

The business component's Form Only view includes the following
panels:

◦ Main

◦ Form

◦ Vertical Menu
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Default

Specifies whether this view is the default view for the browse. When
you have many views and all these views use the same browse, one
view should be selected as default. Only one view for the same browse
can be selected as default. You can change the default view, but the
previous default view is automatically unselected.

The Default checkbox appears for the Hybrid Browse and Browse Only
view types only. This checkbox is always selected when you add the
first view to the business component.

Eligible for Menu

Specifies whether this view is available on the menu (and menu
search).

Description

A short description for the view. This field is optional.

App

Indicates the app to which this view belongs.

App URI

Indicates the URI of the app to which this view belongs.

View URI

Indicates the URI of the view.

Secure URI

Indicates the URI for security and menu linking.

Options
The Allow options are only available for the Hybrid Browse and Form Only
views.

Allow New

When selected, the New button is displayed at runtime with drill downs
and the + icon.

Allow Edit

When selected, the Save and Cancel buttons are displayed at runtime
and you can edit the records. If you clear the checkbox, the Save and
Cancel buttons are removed, and the Edit button changes to Open.

Allow Delete

When selected, the Delete button is displayed at runtime, which allows
users to delete records.
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Mobile App Compatibility

Specifies whether mobile support is enabled for this business
component. This functionality includes the following options:

◦ None — Completely turns off a business component view on a
mobile device. This option is only recommended if the business
component view is completely unusable on mobile devices. For
example, Kanban Loop Status Display in QAD Demand and
Delivery has one column with many icons (cards) displayed side-
by-side; it is unreadable on mobile devices because the card icons
are not supported and display as text.

◦ Browse Only — Displays only the browse on a mobile device. Use
it for Customer/Supplier Activity Dashboards, for example.

◦ Browse & Read-only Form — Displays both the browse and form
of a hybrid browse on a mobile device. Note that the form is in
View mode (no Create, Edit, or Delete options).

◦ Full — Allows full access on a mobile device, including all CRUD
functionality and actions. (Only actions, for which the TS is mobile-
enabled, will display.) This option is only recommended for hybrid
views, where the TS is fully supported on a mobile device or there
is no TS required.

Note that Form Only Views, Reports, and Action Centers are not
accessible on mobile devices.

Browse
This panel includes settings for the Hybrid Browse and Browse Only
views.

Business Component Browse

Specifies whether the browse is based on a business component or
is a standard browse. For the business component browse, select this
checkbox. For the standard browse, this checkbox must be clear.

You can configure the business component browse on the Browses
panel of the business component.

Browse

For the standard browse, click Select to choose a standard browse.

For the business component browse, select the BC browse from the
drop-down menu. The list is populated by the browses defined on the
Browses panel of the business component.

Browse URI

The browse URI associated with the browse added to the view (either
Hybrid Browse or Browse Only).
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View Customizer

Specifies a Java resource that applies view metadata
changes before the browse is rendered (example:
com.qad.acme.mvc.CustomerBrowseViewCustomizer).

Field Mapping
This panel is displayed if you are working with a standard browse.

Mapping grid for mapping form key fields with browse key fields, with
following columns:

Form Key Field

Specifies the key field of the form.

Browse Column

Specifies the corresponding key field on the browse.

TS Handlers
Specifies TypeScript (TS) handlers located on the server.

This panel is for adding coded Browse TS handlers. These TS handlers
should exist on the server in .js files.

Actions
Specifies bulk or individual actions that can be included as part of your
custom view. The actions then become available from the view's Actions
drop-down.

Bulk actions can only be written in standard code. Individual actions can
be written using QAD's low-code/no-code technology.

The Actions panel is only available for the Hybrid Browse and Browse
Only views.

Click New to define a new action or click Details to view and edit the
details of an existing action. When you click New or Details, the Views -
Actions pop-up window opens.

Type

The type of action: Bulk or Individual.

ID

The unique identifier for the action.

Action Label

The display label for the action. The value for this label is displayed in
the Actions drop-down.

Secure URI

The URI for the action's resource, typically, starting with the format
urn:view:maint:com.qad.com.*
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Required Permission

The access permission required for the action (example: Read).

Extension Actions
Specifies bulk or individual actions that can be included as part of a
standard view. This means that you can add actions to the view, which
does not belong to your app. So you can extend standard views, such as
Customers or Purchase Orders. The Extension Actions grid is disabled if
the app that contains the view is the current, active app.

Bulk actions can only be written in standard code. Individual actions can
be written using QAD's low-code/no-code technology. The actions then
become available from the view's Actions drop-down.

The Extension Actions panel is only available for the Hybrid Browse and
Browse Only views.

Click New to define a new action or click Details to view and edit the
details of an existing action. When you click New or Details, the Views -
Extension Actions pop-up window opens.

Type

The type of action: Bulk or Individual.

ID

The unique identifier for the action.

Action Label

The display label for the action. The value for this label is displayed in
the Actions drop-down.

Secure URI

The URI for the action's resource, typically, starting with the format
urn:view:maint:com.qad.com.*

Required Permission

The access permission required for the action (example: Read).

App

Indicates the app to which this action belongs.

App URI

Indicates the URI for the app to which this action belongs.

Form
This panel includes settings for the Hybrid Browse and Form Only views.

View Customizer

Specifies a Java resource that applies view metadata
changes before the form is rendered (example:
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com.qad.erp.base.mvc.ViewCustomizer). This applies only to coded
business components.

Uses Domain

Specifies whether to use the current domain.

Resource URL Prefix

Specifies resource URL prefix, such as "erp".

Data Resource

Specifies data resource. Typically, this is in camel-case format
(example: salesOrders).

Table

Specifies a database table.

TS Handlers
Specifies coded form TypeScript (TS) handlers located on the server.

These TS handlers should exist on the server in .js files.

Vertical Menu
Activity Panel

Specifies whether this view includes an Activity panel. With the Activity
panel, you can see a history of transactions and follow the things you
care about most.

Attachments Panel

Specifies whether this view includes an Attachments panel. With the
Attachments panel, you can attach files to views to keep relevant
documents together for a particular transaction.

Drill Downs
The grid displays a list of the drill downs for this view. You can add,
modify, or delete drill downs using the Drill Downs panel.

Note It is not yet possible to specify drill downs for Browse Only views
using this Drill Downs panel on the Views screen.

When a drill down is dependent on a resource that does not exist in the
current environment and cannot be found, you can see a warning icon
in the Drill Downs grid. To resolve this warning, delete the drill down or
import a missing resource. Not found drill downs are hidden at runtime.

Insights
The grid displays a list of the insights for this view. You can add, modify,
delete, or move insights using the Insights panel.

Note It is not yet possible to specify insights for Browse Only views using
this Insights panel on the Views screen.
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When an insight is dependent on a resource that does not exist in the
current environment and cannot be found, you can see a warning icon
in the Insights grid. To resolve this warning, delete the insight or import a
missing KPI visual. Not found insights are hidden at runtime.

Views - Actions
From Business Components > Views > Actions, you can create and
configure actions for your custom view.

Platform individual actions can be written using QAD's low-code/no-code
technology. Bulk actions can only be written in standard code.

Note When you configure an individual action and use artifacts from
your app or namespace, be aware that it may affect the individual action.
So it is important to carefully review all dependencies you create when
configuring an action. For more information about changes that may affect
an action, see the QAD Enterprise Platform Developer Guide.

Main
ID

Enter the unique identifier for the action.

Action Label

Enter the display label for the action. The value for this label is
displayed in the Actions drop-down.

Type

Select the type of action: Bulk or Individual.

Behavior Type

Select the behavior type: Modal Window or Request. The Behavior
Type option is only available for platform individual actions.

Behavior Type

Select the behavior type: Modal Window or Request. The Behavior
Type option is only available for platform individual actions.

Confirmation (Only for a Request)

Indicates whether a confirmation message is shown before sending a
request to the server.

Confirmation Message (Only for a Request)

Enter the confirmation message that will be shown before sending a
request to the server. The Confirmation Message field is enabled only if
the Confirmation checkbox is selected.

Secure URI

The URI for the action's resource, typically, starting with the format
urn:view:maint:*
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Modal Window Settings
This panel is only displayed for platform individual actions, Behavior Type
= Modal Window.

View

Click Select to choose a view for the action modal window. For better
permission management, it is recommended to use one view per
action.

Size

Select the size of the modal window: Extra Large, Large, or Medium.

Data Source

Select the data source type from which the data for the modal window
is taken: API Call or Source View.

◦ API Call — The data is taken from the response of the platform
business service.

◦ Source View — The data is taken from the source browse or form.

API

Click Select to choose the (Business Service) REST API to load data.
This option is only available for an API Call data source.

Field Mapping
This panel is displayed if you are working with a Source View data
source.

Mapping grid for mapping fields from the source browse or form to the
target form.

Source primary keys are automatically populated.

Target Field

Select the field (Action BC) from a target form.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the business component field of the Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.
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Parameters Mapping
This panel is displayed if you are working with an API Call data source.

Mapping grid for mapping fields from the source browse or form to the
input parameters of chosen REST API.

Input parameters of the REST API are automatically populated based on
the chosen REST API.

Sequence

Specifies the sequence of the parameter in the method signature.

Parameter Mode

Specifies the mode of the parameter.

Parameter Data Type

Specifies the data type of the parameter.

Parameter Name

Specifies the name of the parameter.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the business component field of the Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.

Submit Settings
Button Name

Enter the name of the submit button.

API

Click Select to choose the (Business Service) REST API to send form
data to the server when a user clicks the submit button.

Process in Background

Indicates whether this process is run in the background. The
background processing results will be sent to the Inbox.

Request Settings
This panel is only displayed for platform individual actions, Behavior Type
= Request.
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API

Click Select to choose the (Business Service) REST API to send form
data to the server when a user clicks the submit button.

Process in Background

Indicates whether this process is run in the background. The
background processing results will be sent to the Inbox.

Parameters Mapping
This panel is displayed if you are working with a Request behavior type.

Mapping grid for mapping fields from the source browse to the input
parameters of chosen REST API.

Input parameters of the REST API are automatically populated based on
the chosen REST API.

The Parameters Mapping grid has two levels. The first level shows the
parameter itself. The second level is only applicable if the Parameter Data
Type is Dataset/Dataset-Handle. It allows mapping a Browse Column and
Maintenance Field to the Business Component fields (according to the
Business Component URI of the parameter).

Buttons

Add Child

Select a parameter in the grid, and then click Add Child to create a new
mapping for this parameter.

Delete

Delete an existing mapping.

Grid - The first level

Sequence

Specifies the sequence of the parameter in the method signature.

Parameter Mode

Specifies the mode of the parameter.

Parameter Data Type

Specifies the data type of the parameter.

Business Component URI

Specifies the business component URI and is applicable only if the
Parameter Data Type is Dataset/Dataset-Handle.

Parameter Name

Specifies the name of the parameter.
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Source Browse Column

Select the browse column from the Source View Browse. This field is
enabled for all parameter data types, except for the Dataset/Dataset-
Handle.

Source Field

Specifies a business component field from the Source Maintenance
View. This field is enabled for all parameter data types, except for the
Dataset/Dataset-Handle, and is automatically populated based on the
Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.

Grid - The second level

Source primary keys are automatically populated. You need to provide the
mapping for at least one primary or required dataset field.

Field

Select the parameter business component field.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the business component field from the Source Maintenance
View. This field is applicable only if the Parameter Data Type is
Dataset/Dataset-Handle and is automatically populated based on the
Source Browse Column.

Source Business Component

Specifies the business component of the Source Field.

Source Detail Table

Specifies the detail table of the Source Field.

Views - Extension Actions
From Business Components > Views > Extension Actions, you can create
and configure actions for a standard view. So you can extend standard
views, such as Customers or Purchase Orders.

Platform individual actions can be written using QAD's low-code/no-code
technology. Bulk actions can only be written in standard code.

Note When you configure an individual action and use artifacts from
your app or namespace, be aware that it may affect the individual action.
So it is important to carefully review all dependencies you create when
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configuring an action. For more information about changes that may affect
an action, see the QAD Enterprise Platform Developer Guide.

Main
ID

Enter the unique identifier for the action.

The app registration code is included as a prefix for the action ID.
This field is disabled and shows the app registration code of the app
to which this extension action belongs. If there is no app registration
code, the field is blank. For more information about the app registration
codes, see App Registration.

If an app has a registration code, the unique action ID is  <app
registration code>_<action id>. If an app does not have a registration
code, the unique action ID equals the action ID. It is read-only.

Action Label

Enter the display label for the action. The value for this label is
displayed in the Actions drop-down.

Type

Select the type of action: Bulk or Individual.

Behavior Type

Select the behavior type: Modal Window or Request. The Behavior
Type option is only available for platform individual actions.

Confirmation (Only for a Request)

Indicates whether a confirmation message is shown before sending a
request to the server.

Confirmation Message (Only for a Request)

Enter the confirmation message that will be shown before sending a
request to the server. The Confirmation Message field is enabled only if
the Confirmation checkbox is selected.

Required Permission

Select the access permission required for the action (example: Read).

Secure URI

The URI for the action's resource, typically, starting with the format
urn:view:maint:*

App

Indicates the app to which this action belongs.

App URI

Indicates the URI for the app to which this action belongs.
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Modal Window Settings
This panel is only displayed for platform individual actions, Behavior Type
= Modal Window

View

Click Select to choose a view for the action modal window. For better
permission management, it is recommended to use one view per
action.

Size

Select the size of the modal window: Extra Large, Large, or Medium.

Data Source

Select the data source type from which the data for the modal window
is taken: API Call or Source View.

◦ API Call — The data is taken from the response of the platform
business service.

◦ Source View — The data is taken from the source browse or form.

API

Click Select to choose the (Business Service) REST API to load data.
This option is only available for an API Call data source.

Field Mapping
This panel is displayed if you are working with a Source View data
source.

Mapping grid for mapping fields from the source browse or form to the
target form.

Source primary keys are automatically populated.

Target Field

Select the field (Action BC) from a target form.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the BC field of the Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.

7005



QAD Online Help

Parameters Mapping
This panel is displayed if you are working with an API Call data source.

Mapping grid for mapping fields from the source browse or form to the
input parameters of chosen REST API.

Input parameters of the REST API are automatically populated based on
the chosen REST API.

Sequence

Specifies the sequence of the parameter in the method signature.

Parameter Mode

Specifies the mode of the parameter.

Parameter Data Type

Specifies the data type of the parameter.

Parameter Name

Specifies the name of the parameter.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the business component field of the Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.

Submit Settings
Button Name

Enter the name of the submit button.

API

Click Select to choose the (Business Service) REST API to send form
data to the server when a user clicks the submit button.

Process in Background

Indicates whether this process is run in the background. The
background processing results will be sent to the Inbox.

Request Settings
This panel is only displayed for platform individual actions, Behavior Type
= Request.
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API

Click Select to choose the (Business Service) REST API to send form
data to the server when a user clicks the submit button.

Process in Background

Indicates whether this process is run in the background. The
background processing results will be sent to the Inbox.

Parameters Mapping
This panel is displayed if you are working with a Request behavior type.

Mapping grid for mapping fields from the source browse to the input
parameters of chosen REST API.

Input parameters of the REST API are automatically populated based on
the chosen REST API.

The Parameters Mapping grid has two levels. The first level shows the
parameter itself. The second level is only applicable if the Parameter Data
Type is Dataset/Dataset-Handle. It allows mapping a Browse Column and
Maintenance Field to the Business Component fields (according to the
Business Component URI of the parameter).

Buttons

Add Child

Select a parameter in the grid, and then click Add Child to create a new
mapping for this parameter.

Delete

Delete an existing mapping.

Grid - The first level

Sequence

Specifies the sequence of the parameter in the method signature.

Parameter Mode

Specifies the mode of the parameter.

Parameter Data Type

Specifies the data type of the parameter.

Business Component URI

Specifies the business component URI and is applicable only if the
Parameter Data Type is Dataset/Dataset-Handle.

Parameter Name

Specifies the name of the parameter.
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Source Browse Column

Select the browse column from the Source View Browse. This field is
enabled for all parameter data types, except for the Dataset/Dataset-
Handle.

Source Field

Specifies a business component field from the Source Maintenance
View. This field is enabled for all parameter data types, except for the
Dataset/Dataset-Handle, and is automatically populated based on the
Source Browse Column.

Source Detail Table

Specifies the detail table of the Source Field.

Source Business Component

Specifies the business component of the Source Field.

Grid - The second level

Source primary keys are automatically populated. You need to provide the
mapping for at least one primary or required dataset field.

Field

Select the parameter business component field.

Source Browse Column

Select the browse column from the Source View Browse.

Source Field

Specifies the business component field from the Source Maintenance
View. This field is applicable only if the Parameter Data Type is
Dataset/Dataset-Handle and is automatically populated based on the
Source Browse Column.

Source Business Component

Specifies the business component of the Source Field.

Source Detail Table

Specifies the detail table of the Source Field.

Views - Drill Downs
From the Drill Downs pop-up window, you can add, modify, or delete drill
downs. The following drill down types are available:

• Business Component Relationship — The drill downs that are
generated automatically when Business Component relationships are
defined, including lookups. This applies to both coded and platform
business components.
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• .NET UI - Browse Based — The legacy .NET UI drill downs that exist
in the .NET UI today and will only be present for coded business
components.

• User Added - Business Component Based — The drill downs that are
added using the entity metadata for the drill down definition, mapping,
and conditions. These are the drill downs that are manually added
starting with the March 2020 release.

• User Added - Browse Based — The drill downs that are added using
the browse metadata for the drill down definition, mapping, and
conditions. These are the drill downs that are manually added prior to
the March 2020 release.

You can view the drill down type in the Views > Drill Downs panel >
Generated From column and in the Drill Downs detail pop-up window.

Main
Drill Down From

Select whether to drill down from the browse & form, the form, or the
grid of the business component. When you select a different Drill Down
From element, the existing field mappings and additional conditions are
deleted.

Some grids have a Linked View defined as part of the grid definition
(external grids—always, internal grids—sometimes). For these grids,
open the Linked View to configure drill downs.

Drill Down To

You can have the drill down go to a Hybrid Browse, Browse Only,
Report, or External Link.

The Report type drill downs do not require field mappings.

Note If you choose the External Link type, you will need to enter a link
template to the external site on the URL panel. If you select the Modal
Window option from the Open In drop-down menu, then the same-
origin mechanism will be applied. In case the external resource does
not allow to be opened in iframe, at runtime you will see an empty
modal window.

Drill Down Browse

(Displayed if Drill Down To is set to Hybrid Browse or Browse Only.)

◦ Hybrid Browse — Specifies the hybrid browse for the drill down.
Click Select to open the Resource pop-up window, from which you
can select a hybrid browse. Note that the URI for hybrid browses
uses the format urn:view:hybridbrowse:*.

◦ Browse Only — Specifies the browse only for the drill down. Click
Select to open the Resource pop-up window, from which you
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can select a browse. Note that the URI for browses only uses the
format urn:browse:*.

Drill Down Report

(Displayed if Drill Down To is set to Report.) Specifies the report for
the drill down. Click Select to open the Resource pop-up window, from
which you can select a report. Note that the URI for report uses the
format urn:report:*.

Use Existing Label

Select whether to use the existing display label for the hybrid browse,
browse only, or report. Clear the checkbox to choose a different label.

Drill Down Label

(Displayed if Use Existing Label is not selected.) Use the lookup to
open the Labels pop-up window and select a different label.

Visible

Select this checkbox to make the drill down visible at runtime.

Field Mapping
This panel includes the grid to map drill down browse fields with source
business component fields.

Drill Down Field

Specifies the field to which you want to map the drill down.

Operator

Shows a drop-down menu with available operators based on the
selected Drill Down Field.

Source Field

Specifies the field from which you want to map the drill down.

Source Field 2

Specifies the second source field for range operators when the first
Source Field is a range type. This source field is disabled for all other
operator selections.

Primary

The primary field drives the drill down order. Select one field as the
primary field for the drill down.

Additional Conditions
This panel is optional and includes the additional conditions for the
hardcoded values and search variables of drill down fields.

Drill Down Field

Specifies the field to which you want to map the drill down.
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Operator

Shows a drop-down menu with available operators based on the
selected Drill Down Field.

Value

Specifies the hardcoded value or the search variable.

Search variables are the values such as Today or Current User.

Toggle

Click the toggle icon to switch between a hardcoded value and a
search variable.

Search variables are available for the Integer/Integer (64-bit),
Character, and Date (date, datetime, datetime-tz) fields.

Value 2

Specifies the second value for range operators when the first Value is a
range type. This value is disabled for all other operator selections.

Views - Insights
From Views > Insights, you can set up the Insights panel, including KPI
links. Here, you can add, modify, delete insights, as well as move them up
or down.

Insights provide key visuals about a record (for example, a sales order or
a customer) to make quick and informed decisions. The Insights panel,
you configure here, contains visuals created through the action center/
analytics functionality. Instead of going to a particular action center, users
will be able to access visuals directly from the Insights panel.

Main
KPI Visual

Open a lookup to the existing KPI visuals in the KPI Visual Gallery,
where you can search for the required visual. The visual URN is
displayed to the right of the Select button.

Use Existing Label

Select whether to use the existing display label for the visual. Clear the
checkbox to choose a different label.

Label

(Displayed if Use Existing Label is not selected.) Use the lookup to
open the Labels pop-up window and select a different label.

Field Mapping
This panel includes the grid to map KPI browse fields with source
business component fields.
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KPI Field

Specifies the field from the KPI visual definition.

Operator

Shows a drop-down menu with available operators based on the
selected KPI Field.

Source Field

Specifies the field from the source business component.

Source Field 2

Specifies the second source field for range operators when the first
Source Field is a range type. This source field is disabled for all other
operator selections.
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Logging Options
Logging Options includes the ability to set up a Correlation ID marker,
which will then be present in the Java and Progress logs so that we can
correlate Java and Progress logs related to the current user session.
When users sign off from the Web UI, those settings are then gone; if
they log in again, they will get the default logging settings.

Logging
Correlation ID

A marker that you can set and then search for this marker in the logs to
identify the logs from the current session.

Java Log Level

Specify the log level (info, warning, and so on) for Java logging.

QRA Application Log Level

Specify the log level for QRA application logging.

Progress Log Level

Specify the Progress log level. For more information, see Progress
OpenEdge Logging Level.

Progress Stack Trace

Turn the Progress stack trace on or off.

Progress Log Entry Types
Set additional log entry types of Progress logs, which can be switched on
or off by selecting each checkbox. Typically, 4GLTrace is selected.

For more information, see Progress OpenEdge Log Entry Types.
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Configuration Data Overview
The Configuration Data functionality, also called Platform Environment
Configuration (PEC), allows users to store environment-dependent
artifacts and active settings into a format that can be easily maintained,
exported, and imported across environments, without needing to go
through the Cloud. Previously, all artifacts could only be saved to an app
and were forced to go through the Software Development Life Cycle
(SDLC) process. In the September 2021 release, you can also save
artifacts as part of Configuration Data.

There are two types of Configuration Data: Artifacts and Active Settings.

The Artifact is the specification of a physical piece of information that is
used or produced by a software development process, or by deployment
and operation of a system. In the QAD Enterprise Platform, examples of
artifacts include: Design Layout, Activity Tracking, Alert, Action Center,
Stored View, Theme.

Active Settings determine which artifacts are active at runtime in the
specific environment. Examples of active settings include: Active Design
Layout, Active Stored View, Default Stored View, Active Theme, Theme
Context.

The Configuration Data functionality applies to the following users:

• Administrators migrating Configuration Data from environment to
environment.

• Platform developers creating Configuration Data in conjunction with
apps they are developing.

• QAD partners and implementation consultants, configuring artifact
templates that can be installed and used as part of Adaptive UX
conversions and initial implementations.

App Data vs. Configuration Data
The goal of Configuration Data is to allow customers, administrators,
QAD, and partners to easily import and export their Adaptive UX artifacts
and active settings from one environment to another. Configuration Data
also makes a distinction between a development environment and a test
or production environment. Many of the artifacts can be both app artifacts
and Configuration Data. App artifacts can only be created and maintained
in a development environment and are forced to go through the SDLC
process. Configuration Data is more flexible and can be created and
maintained in any type of environment. That way the SDLC process for
development is followed and only Configuration Data is modified in Test
and Prod.
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App Data Configuration Data

BUILD: building extensions and
app store solutions

CONFIGURE: configuration for
business needs

Needs to go through the SDLC Does not need to go through the
SDLC

Users: QAD and partners, some
customer developers

Users: customers, BAs

Used to create and expand the
Adaptive UX

Used to configure or personalize
the Adaptive UX according to
customer's unique business needs

In a development environment, artifacts contain the Saved To drop-
down menu, where you can choose to save your data to App Data or
Configuration Data. Some artifacts can only be saved to Configuration
Data. See the table below.

• App Data. The data is saved to the user's Active App set in My
Developer Settings and displays the active app name and the
corresponding App URI.

• Configuration Data. The data is saved to Configuration Data and
displays Configuration Data as the app and the corresponding
Configuration Data URI.

A) Saved To App Data
Only

B) Saved To
Configuration Data
Only

C) Saved To App Data
or Configuration Data

Artifacts that can only
be saved in an app.

Activity Tracking, Alert Design Layout
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A) Saved To App Data
Only

B) Saved To
Configuration Data
Only

C) Saved To App Data
or Configuration Data

System/User Import
Template

User, Role, and
System Stored View

System/Domain Field
Property Overrides

Theme, Theme
Workspace

Role, Menu, &
Permissions

Notification Template,
Notification Template
Message

Action Center (*), KPI Translation String &
Details

Translation Detail/
Override

Application Menu

Security Rule, Security
Group, and Record
Level Security

E-Signature Setup

Examples: business
components, lookup
definitions.

Active Settings (Active
Design Layout, Active
Stored View, Default
Stored View, Active
Theme, Theme
Context, Active
Notification Template
Message, Browse
Extension Scope
Context)

Business Document
Variant

(*) In development environments, you can still associate an action center
with an app so that it is part of the package and load procedure for
moving App Data between environments. The Origin App URI field in the
Action Centers view allows you to do this.

My Developer Settings
Under My Developer Settings, you can choose to save all new artifacts
to Configuration Data as default in a development environment. When
you select this option, the Saved To drop-down menus in the Web UI
will default to Configuration Data rather than the App Data. You can still
change it to App Data if required.

Many users who are creating business components will be simultaneously
creating Configuration Data (for example, going back and forth
between the new business component and a design layout for the
created business component). By selecting the Save new artifacts to
Configuration Data as default checkbox, you do not have to constantly
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set your active app settings. The Configuration Data will not be the active
app, but new artifacts will be saved to Configuration Data rather than the
App Data by default.

Changes to Dev/Test/Prod Environments
In a development environment, you can save artifacts as App Data or
Configuration Data (if applicable). And in Test or Prod, you can only save
artifacts as Configuration Data.

Artifacts saved as App Data can only be maintained in a development
environment whereas artifacts saved as Configuration Data are more
flexible and can be maintained in any type of environment. Design
Layouts and other artifacts are editable in Test/Prod if they are in
Configuration Data. There may be Design Layouts, Stored Views,
Themes, KPIs, and Action Centers that come from an app in a Test/Prod
environment (QAD-owned data or third-party apps, for example). Those
will not be editable but most have the ability to Save As or Copy.

Note You can view the environment type in the environment.xml file.

Dev environment
Everything is enabled on the UI. You can save artifacts mentioned in
Column C from the table above as App Data or Configuration Data.

Test and Prod environments
Everything from Column A and everything mentioned in Column C that is
saved as App Data is disabled in Test and Prod. In addition, the following
screens are meant for development only, and they are disabled in Test
and Prod:

• Apps

• Data Stores

• My Developer Settings

You can edit everything from Column B and everything mentioned in
Column C that is saved as Configuration Data.

Most of the non-editable artifacts have the ability to Save As or Copy.
You can use these options to create a copy of the artifact and edit it in
Configuration Data.

Configuration Data
With the Configuration Data view, you can import, export, and maintain
artifacts and active settings.

When users have access to the Configuration Data screen and import/
export actions, they implicitly have rights to view the list of all artifacts.

Main
All fields on this panel are disabled and are for viewing only.
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Type

The type of configuration data: Artifact or Active Setting.

Artifact

The category of Artifact or Active Setting, such as Design Layout, KPI,
Theme, Alert, Active Design Layout, and Default Stored View.

Label

The label that is defined for the configuration data.

Business Component

The label of the business component associated with the configuration
data. For example, it is helpful when you have two design layouts with
the same name. You can identify the design layout you need.

View

The view label associated with the configuration data. For example, it
is helpful when you have two design layouts with the same name. You
can identify the design layout you need.

Status

The status of configuration data: Active or Inactive.

Date Created

The date the configuration data is created.

Created By

The ID of the user who created the configuration data.

Last Modified

The date the configuration data was last edited.

Last Modified By

The ID of the user who last edited the configuration data.

Configuration Data Export and Import
With the Configuration Data view, you can import, export, and maintain
artifacts and active settings. Artifacts and active settings that are stored
in Configuration Data can be exported from a source environment and
imported into a target environment.

Exporting Configuration Data
You can export configuration data under Configuration Data > Actions >
Export Configuration Data.

Records can be pre-searched before export to limit the export to only
certain records.
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Main
Export File Name

Specify the ZIP file name that will be downloaded in your web browser
when you click Submit. The automatically generated name of the ZIP
file is based on the date and time that the ZIP file is generated; for
example, Export_Config_Data_2021_7_20.zip.

Criteria
Criteria

Shows any browse search criteria that you have applied (disabled).

Artifacts Returned

Shows the number of records returned according to the search criteria
(disabled).

Export Artifacts
The grid shows all records for export according to the search criteria. You
can remove records by clearing the checkbox for each corresponding
artifact.

When you click Submit, the system starts to export data to the file,
running in the background. You will receive a notification in the Inbox
when the export is completed, and you can then click the Download link
in the notification to download the file. You can also check for any export
issues under Background Processing. The export process may take some
time when there is a large amount of data.

Importing Configuration Data
You can import configuration data under Configuration Data > Actions >
Import Configuration Data.

Main
Choose File

Click Choose File to navigate to the ZIP file containing the configuration
data that you previously exported. Alternatively, drag the ZIP file
directly into the area that is surrounded by a broken line.

The ZIP file is validated for correct formatting and missing, corrupted,
or incompatible artifacts. If the import file is incorrectly formatted or
contains broken artifacts, you can see the Invalid Artifacts dialog. The
Invalid Artifacts dialog shows the number of invalid artifacts and all
error messages received after the validation process. You can copy
all error messages by using the Copy button. Invalid artifacts cannot
be imported, but you can still proceed with valid artifacts. Click OK to
continue with the upload process without invalid artifacts. You can also
view the error messages by clicking the messages icon on the right
side of the view.
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File

Shows the ZIP file name that is uploaded for import (disabled).

Import Artifacts
This panel is shown after choosing the import file. The file is now
uploaded, but not yet imported into the database. The grid shows all
records for import according to the selected file. You can preview the
records here and remove them if needed by clearing the checkbox for
each corresponding artifact.

When you click Submit, the system starts to import the data into the
system, running in the background. You will receive a notification in the
Inbox when the import is completed, and you can then click the link to
check for any import issues under Background Processing on page 6890.
You can also view conflicts and missing dependencies and resolve them
by using Artifact Conflicts on page 7022. The import process may take
some time when there is a large amount of data.

After import, the corresponding configuration data is updated. In case of
importing Menus & Role Permissions, the system replaces the data rather
than updates it so you do not have to worry about existing permissions
or menus being merged in unexpected ways that will require cleanup or
review.

Processing Options
Process in Background

Indicates that the import task is run as a background process, and the
process is submitted after you click the Submit button.

Under Background Processing on page 6890, you can view a list of
imported artifacts, their import status, and warning messages if any. It
also includes the importing user, date, and time.

Export and Import Tips
• You can export and import an active setting if you want the same

active setting configuration in the target environment. For example,
create a new design layout and make it active in Test → export and
import both a design layout artifact and active setting to Prod → after
import, a new design layout is available and set as the active layout.

• Currently, import rollback is not yet supported. Any existing artifacts
will be overwritten with the imported version of the artifact. Take your
own backup before the import if you are concerned.

• Exporting action centers/KPIs from an environment with Logi Platform
Services to import them into a Logi Composer environment does not
work (nor the other way around).

• Exporting a design layout with Entity or Site scope to import it into the
March 2023 environment or earlier does not work.
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• For security groups, the child group cannot be imported without the
parent group in the target environment or in the import file.

Exporting and Importing Configuration Data
To export configuration data from a source environment and import it into
a target environment, do the following:

Before you import or export configuration data on the Configuration
Data screen, disable segregation of duties. When the import or export is
complete, you can re-enable SOD.

1. Sign in to the environment that you want to export configuration data
from.

2. Open the Configuration Data screen from the menu search.
3. Apply the search criteria if you want to export only certain records.
4. From the Actions menu, click Export Configuration Data.
5. In the File field, change the export file name if needed. The Criteria

panel shows any browse search criteria that you have applied, along
with the number of records returned.

6. On the Export Artifacts panel, review the records you want to
export. You can remove records by clearing the checkbox for each
corresponding artifact.

7. Click Submit. Results will be sent to your Inbox.
8. Open the Inbox and look for the export notification.
9. In the notification, click the Download link to download the file. The

ZIP file is saved in the default folder for your browser downloads.
10. Check for any export issues under Background Processing on page

6890.
11. Sign in to the environment that you want to import configuration data

to.
12. Open the Configuration Data screen from the menu search.
13. From the Actions menu, click Import Configuration Data.
14. Click Choose File to navigate to the ZIP file containing the

configuration data that you previously exported from another
environment. Alternatively, drag the ZIP file directly into the area that
is surrounded by a broken line.

15. Review the invalid artifacts if any, and then click OK to continue
without invalid artifacts.

16. On the Import Artifacts panel, review the records you want to
import. You can remove records by clearing the checkbox for each
corresponding artifact.

17. Click Submit. Note that after import, any duplicate artifacts are
replaced by their imported version.

18. Click Continue. Results will be sent to your Inbox.
19. Open the Inbox and look for the import notification.
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20. In the notification, click the link to check for any import issues under
Background Processing on page 6890.

21. Open Artifact Conflicts on page 7022 to view conflicts and missing
dependencies if any and resolve them.

Artifact Conflicts
With the Artifact Conflicts screen, you can search for, review, and resolve
artifact conflicts. This screen is available for the following artifacts and
active settings:

• Design layouts

• Alerts

• KPIs

• System/Domain field property overrides

• Notification templates and notification template messages

• System/User import templates

• Translation String & Details

• Translation Detail/Override

• Browse Extension Scope Context

Main
Search for Conflicts

Click to search for existing conflicts. The found conflicts appear in the
Conflicts grid. Note that the Conflicts grid is only filled after you click the
Search for Conflicts button.

Conflicts
After you click the Search for Conflicts button, the Conflicts grid is filled
with a list of any current conflicts.

Artifact

The category of artifact, such as Design Layout or Alert.

Conflict

The type of conflict: a missing dependency or a conflicting artifact.

Label

The label that is defined for the artifact.
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Resolve Conflicts
Select an artifact, and then click the Resolve Conflicts button above
the Conflicts grid. The Resolve Conflicts pop-up window appears with
conflict details. The artifact can have conflicts or missing dependencies.
As a solution, you can delete artifacts from the environment or address
dependencies.

You can delete the artifact by using the Delete Artifact button or address
the dependency by importing the missing item (for example, importing an
app with a missing business component, installing the missing languages/
locales in the environment, or creating a user record if a user does not
exist).

For some artifacts, you can view the Resolve Manually button to resolve
conflicts directly from the conflict resolution screen. For example, for the
browse extension scope context, click the Resolve Manually button to
open the Browse Extension Scope Context pop-up window, where you
can change the scope context right away. For more information about
conflict reasons for the browse extension scope context, see Resolving
Conflicts in the Browse Extension Scope Context section.

After resolving the conflict, the orange warning icon is replaced with a
green checkmark icon, and you can view the Resolved status in the
Conflict column. You might need to click the Search for Conflicts button
again so that the resolved artifact conflicts are removed from the Conflicts
grid.
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No OS Access Developer Model
The No OS Access Developer Model functionality allows creating scripts,
creating and packaging developer projects, and packaging apps from
the Adaptive UX to eliminate direct OS access, server downtime, and
support non-platform supported activities, such as writing OOABL code
and editing XML files. Previously, the platform developer model required
access to the server OS in order to run YAB commands to support typical
developer activities that impact the ability of Cloud to support platform
development on existing DEV/TEST/PROD environments.

OS Scripts
The OS Scripts view (Development folder > OS Scripts) allows for a script
created by the developer to be uploaded to the server and made available
to development projects. Initially, only QAD can create scripts, and only
Python scripts are supported.

You can only update OS Scripts in development environments. In Test
and Production environments, you can still use the Execute Script option.
If the API Only checkbox is not selected, you can execute the selected
script from the browse or the form. It is possible to execute Server OS
scripts only, and you need to have Execute permissions for the script.
Under Actions, select Execute Script. When clicked, complete the script
arguments if there are any. After filling in arguments and continuing,
the script is executed. This creates an execution request, which goes
into a queue to execute. After it is executed, you will receive an Inbox
notification with the results of the script and a link to the script details on
the OS Script Processing screen.

The following OS scripts are available:

OS Script Description Type

activity_feed_update Update activity feed Server

compile_app_source_codeCompile app source
code

Server

compile_app_source_code_clientCompile app source
code

Client

create_app_metadata_packageCreate archive with
app metadata

Server

create_app_package Create yab package for
platform app

Server

deploy_app_source_codeCompile and register
app code

Server

deploy_app_source_code_clientDeploy app source
code

Client
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OS Script Description Type

install_python_packagesInstall python
packages

Client

undeploy_app_source_codeUnregister app code Server

undeploy_app_source_code_clientUndeploy app code Client

update_app_all Update app workspace Client

update_app_metadata Update app metadata
in app workspace

Client

update_app_properties Update app properties
in development project

Client

update_development_project_workspaceUpdate development
project workspace

Client

After running a server script (including the Package App action), the
results are sent to your Inbox. If the script output includes a file, the Mini
Inbox and Extended Inbox include the Download option to download the
script output directly from the Inbox.

Main
OS Script

Enter a unique name for the script. The name can only contain
lowercase alphanumeric characters, underscores, and dashes.

OS Script Label

Enter a label for the script.

Description

Enter a description of the script.

Type

Indicate whether the script is Client or Server.

File

Select the Python file with a script. The file name can only contain
lowercase alphanumeric characters, underscores, and dashes.

Category

Select a category of the script: Administration, Development, or
Support.

API Only (Server Type Only)

If not selected, you can execute the selected script from the browse or
the form by using Actions > Execute Script.
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OS Script URI

The unique identifier for the script. By default, this field is based on the
namespace, app, and OS Script name.

Secure URI

The unique secure identifier for the script. By default, this field is based
on the OS Script URI.

App

The script's app name. By default, it is user's active app set in My
Developer Settings.

App URI

The script's app URI. By default, this field is based on the namespace
and app.

Namespace

The value of the environment namespace.

Arguments
This panel indicates any arguments to be passed into the script when it is
executed.

Argument Name

Enter the name of the argument. The name can only contain lowercase
alphanumeric characters, underscores, and dashes.

Argument Label

Enter a label for the argument.

Required

Indicates whether the argument must be entered to execute the script.

Visible

Indicates whether the argument displays when the script is executed.

Read Only

Indicates whether the argument is editable or read-only when the script
is executed.

Default Value

Enter a default value for the argument when the script is executed.

OS Script Processing
With the OS Script Processing screen (Development folder > OS Script
Processing), you can monitor OS script execution requests as well as use
this screen for troubleshooting.
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Execution logs are attached to a record. With each completed script
request, you can view log files in the attachments panel. If the script
output includes a file, it is also included in the attachments panel. For
example, the package files for the Package App and Package Project
actions are included in the attachments panel. If the OS script processing
fails, you can also view the error log files in the attachments panel.

Main
OS Script

The name of the OS script that was executed.

OS Script URI

The OS script URI that was executed.

Description

The script description.

Status

The status of the script execution. The status includes the following
options:

Submitted By

The view label associated with the configuration data. For example, it
is helpful when you have two design layouts with the same name. You
can identify the design layout you need.

Submitted Date

The date and time when the script execution request was submitted.

Processing Start Date

The date and time when the script execution request started
processing.

Processing End Date

The date and time when the script execution request finished
processing.

Arguments
Argument Name

The argument name from the script definition.
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Argument Label

The argument label from the script definition.

Value

The argument value submitted with the script execution request.

Development Projects
With the Development Projects screen (Development folder >
Development Projects), you can define a development project and
package it. A development project is a directory on the file system of a
developer's PC that has a subdirectory with all the scripts that can be run
on the client and with a subfolder for every app that is being developed in
that project. The project is linked to one Adaptive UX environment, but an
Adaptive UX environment can have multiple projects.

You can only update Development Projects and App Workspaces in
development environments. They are not editable in Test and Production
environments.

For more information about setting up a development project workspace,
see the QAD Enterprise Platform Developer Guide. Note that Progress
OOABL code is not the preferred mechanism for extension code. If
possible, please rewrite your code using the Java Extension Framework.

Main
Development Project

Enter a unique name for the development project.

Description

Enter a project description.

Adaptive UX URL

The development project URL. By default, it is a current Adaptive UX
environment.

App Workspaces
Define the apps available for development in a project.

App

Select the app name from the lookup.

App URI

The app URI, which is based on the selected app.

Namespace

The app's namespace, which is based on the selected app.
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Client Scripts
Define all the scripts that can be run on the client.

OS Script

Select the OS script from the lookup. For the required scripts this field
is disabled.

OS Script URI

The URI of the OS script (from the OS Scripts screen).

Description

The description of the OS script (from the OS Scripts screen).

Required

Indicates whether the client script is required by the system. If required,
it cannot be deleted.

Category

The script's category (from the OS Scripts screen).

App

The script's app (from the OS Scripts screen).

App URI

The script's app URI (from the OS Scripts screen).

Namespace

The script's namespace (from the OS Scripts screen).

App Workspaces Details
Click the Details button on the App Workspaces panel to view the app
workspaces details.

Main
App

The app name.

App URI

The app URI, which is based on the selected app.

Namespace

The app's namespace, which is based on the selected app.

Ignore Files
.localmetadata

Enter .localmetadata files, separated by a return character. These are
the files that should not be updated when updating the metadata from
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the server. This is to avoid overwriting the locally modified metadata
files by metadata from the server.

Package Projects
You can package a development project under Development Projects >
Actions > Package.

File Name

Edit the development project file name if needed. The
automatically generated name of the file has the format
[projectname_yearmonthdayhhmmss], for example,
test_20220304050012.

When you click Submit, the system creates the developer package in the
background, but it does not use OS Script Processing. The results are
sent to your Inbox. Since the output includes a file, the Mini Inbox and
Extended Inbox include the Download option to download the file directly
from the Inbox.
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Business Document API Documentation
With the Business Document API Documentation screen, you can view
API documentation for business documents in the application.

Details about calling a business document can be found in the QAD
Enterprise Platform Developer Guide.

The Business Document API Documentation screen is accessible from
the Development menu. This menu is available to users with either the
Developer or QAD Admin roles.

Main
Business Document

The label of the business document.

Business Document URI

The URI of the business document associated with the business
component.

Browse URI

The default browse URI that is used when executing the query. The
default browse URI is initially set to the browse defined in the view for
the business component.

App

Indicates the app for the business document.

App URI

Indicates the uniform resource identifier (URI) for the app.

Open API Documentation

Click to open a new window with the API documentation for the related
business document.

Testing the API
You can use the Try it out button to test the API. For this, enter
parameters and click the Execute button to show your results.

Browse Query
Query REST APIs are available for business documents. The business
document REST API supports querying multiple records with the
capabilities of filtering, sorting, paging, and returning partial data.

To test the API, click the Try it out button, enter parameters, execute the
query, and then view the results. You can view the available queries in the
QAD Enterprise Platform Developer Guide.
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Business Service API Documentation
With the Business Service API Documentation screen, you can view API
documentation for business services in the application.

Business services are non-CRUD methods that are exposed as REST
APIs for the purpose of integration.

The Business Service API Documentation screen is accessible from
the Development menu. This menu is available to users with either the
Developer or QAD Admin roles.

Main
Business Service Method

The name of the business service method.

Business Component

The business component the service is related to.

Service URI

The service URI for the business service method.

App

Indicates the app for the business service.

App URI

Indicates the uniform resource identifier (URI) for the app.

Open API Documentation

Click to open a new window with the API documentation for the related
business service method.

Testing the API
You can use the Try it out button to test the API. For this, enter
parameters and click the Execute button to show your results.

Role Permissions
Each business service is a separate resource in the Role Permissions
view. The services are located in the All Resources > Not In Menu >
Integration > External Business Services branch of the resource tree. The
Execute permission is required to work with business services. You can
specify the Execute permission on the business service component and
the individual business service methods—so permissions can be set at
two levels. Also, ensure that the necessary permissions are granted to the
underlying business components.
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Troubleshooting
This section provides common troubleshooting recommendations.

• Tabbing on Safari Browser on page 7034

• Auto Scaling on Windows on page 7035

• Pop-up and Redirect Web Browser Behavior on page 7036

• Security Configuration for EAM Reports on page 7037

• HTTP/HTTPS Status Codes on page 7038

For further assistance, contact QAD Support.
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Tabbing on Safari Browser
On the Safari browser, for the tabbing behavior to navigate actionable
fields on forms, you need to make the following change:

1. With Safari running, choose Safari > Preferences.
2. Choose the Advanced tab.
3. On the Advanced tab, under Accessibility, select "Press Tab to

highlight each item on a webpage."

Once this option is selected, additional text is displayed: "Option-Tab
highlights only text fields and pop-up menus."

7034



Administration

Auto Scaling on Windows
Windows 10 can automatically scale displays by 150% for high-resolution
screens, but this automatic scaling can sometimes cause unexpected
effects.

For best results, reduce the Windows automatic scaling factor to 125% or
100%.

7035



QAD Online Help

Pop-up and Redirect Web Browser Behavior
In the QAD Web UI, some actions can open pop-ups or redirect you to
a new browser tab, but your browser settings might block this behavior
by default. Check that your browser will allow pop-ups and redirects for
the domain where you are running the QAD Web UI. For example, for
Chrome where the QAD Web UI is in the qad.com domain, go to chrome://
settings/content/popups (Settings > Advanced > Content settings >
Popups and redirects); for Allow, add [*.]qad.com as an allowed site.
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Security Configuration for EAM Reports
Without proper configuration in QAD .NET UI, users see the following
error when they try to run a report in the Web UI:

Follow these steps to enable EAM reports.

1. Identify the user ID assigned to the QRF Report Server. In the
QadReportingFrameworkServiceConfig.xml file, find the following
entry, where xxx is the required user ID. If your system is cloud-based,
contact QAD Support for help with this step.

<!– .NET UI user ID to connect with -->

<User>xxx</User>

2. In QAD .NET UI, open Users (EAM) > Sites.
3. Assign the user ID identified in Step 1 to all valid customer sites.
4. Ensure the user ID has at least one role per site with access to

Enterprise Asset Management > Analysis.

After the site settings are updated, reports will complete as expected in
the Web UI.
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HTTP/HTTPS Status Codes
In the event of HTTP/HTTPS status code errors, consult the following.

Status Code Message Explanation Resolution

400 Bad Request The request
you sent to the
web server was
incorrect or
corrupted and
the server could
not understand
it. An internal
error should
occur only
if someone
modified
the request
parameters.

Try your
request again.
If unsuccessful,
contact
your system
administrator or
QAD Support.

401 Unauthorized The user
has not been
authenticated.
This error is
most likely to
occur when
calling REST
APIs directly.

Contact
your system
administrator or
QAD Support to
request system
access.

403 Access Denied The user is
authenticated
but does not
have access to
the requested
component.

Contact
your system
administrator or
QAD Support to
request updated
permissions
or appropriate
licensing for the
inaccessible
screens.

404 Not Found The requested
resource could
not be found.
This error occurs
if something
is removed
after a URL is
generated. For
example, you

Contact
your system
administrator or
QAD Support
with the URL you
were trying to
reach.
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Status Code Message Explanation Resolution
might see an
error for Inbox
notifications
if the item
referenced was
removed after
the notification
was sent.

500 Internal Server
Error

The system
encountered
an unexpected
condition on
the server. The
software did
not properly
handle an error
condition.

Contact
your system
administrator or
QAD Support
with the steps
required to
reproduce the
error and the
time stamp
of the error's
occurrence.
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